Preface

Copyright and Trademark Notice

Copyright 2009 Telestream, Inc. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, altered, or translated into any languages without written permission of Telestream, Inc. Information and specifications in this document are subject to change without notice and do not represent a commitment on the part of Telestream.

Telestream, FlipFactory, Flip4Mac, GraphicsFactory, Episode, Telestream MAP and MotionResolve are registered trademarks of Telestream, Inc. Pipeline, MAPreview, Launch, HyperLaunch, FlipScan and MetaFlip are trademarks of Telestream, Inc.

QuickTime, Mac OS X, Final Cut Pro, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

All other brand, product, and company names are property of their respective owners, and are used only for identification purposes.

MPEG-2 License Requirements

Telestream has obtained a license from MPEG LA, to produce MPEG-2 video, to meet the following requirement on behalf of its FlipFactory and Pipeline licensees: The use of this product in any manner that complies with the MPEG-2 standard is expressly prohibited without a license under applicable patents in the MPEG-2 patent portfolio, which license is available from MPEG LA, L.L.C., 250 Steele Street, Suite 300, Denver, Colorado 80206.

Obtaining Pipeline Support | Information | Assistance

Web Site. http://www.telestream.net/telestream-support/pipeline/support.htm

Terms and times of support services vary, per the terms of your current service contract with Telestream.

Pipeline Web Site – FAQs, Forums & Upgrades

Web Site. http://www.telestream.net/telestream-support/pipeline/support.htm
Returning Inoperative Pipelines (RMA)

If your Pipeline is inoperative, contact Telestream at the Pipeline support email address provided below, or contact your authorized reseller. Provide your company and contact information, the serial number of the inoperative unit, and request instructions for Return Material Authorization.

Company and Product Information

For information about Telestream or its products, please contact us via:

Web Site. www.telestream.net
Sales and Marketing Email. info@telestream.net

Mail

Telestream, Inc.
848 Gold Flat Road, Suite 1
Nevada City, CA. USA 95959

International Telestream Distributors

See the Telestream Web site at www.telestream.net for your regional authorized Telestream distributor.

FCC Emission Information

Ethernet connections to Pipeline devices must be made using a shielded Category 5 or Category 6 cable to ensure emissions are within standards. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference with other electronic equipment in which case the user will be required to correct the interference at his/her own expense. Changes or modifications not expressly approved by Telestream can affect emission compliance and could void the user's authority to operate this equipment.
Canadian EMC Notice of Compliance

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications.

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numeriques de la classe A prescrites dans le Reglement sur le brouillage radioelecctrique edicte par le Ministere des Communications du Canada.

Important Safety Instructions

Before using Pipeline devices, read the following safety instructions to ensure it is used safely:

• Unplug the device before cleaning.
• Use only a lightly-dampened cloth to clean the unit; never pour liquids onto the device.
• Do not place the device on an unstable surface or near extreme heat.
• Do not stack Pipelines more than two units high to avoid over-heating.
• Use only the power source supplied, and recommended in this manual.
• Connect all electronic equipment to properly grounded power outlets.
• Telestream recommends using surge protection equipment (may be feature of a UPS).

Caution

Pipelines contain no user serviceable parts. Never open the chassis enclosure. Doing so without express permission from Telestream may void your warranty.

EN55022 Class A Warning

In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

Regulatory Approved Standards for Electrical Safety

This equipment complies with the minimum requirements of these standards:

IEC950 (or EN60950/BS7002/VDE0805 May 1990)
UL1950
CSA C22.2-950-M89

Radiation Emission Susceptibility Regulatory Approved Standards

This equipment complies with the minimum requirements of these standards:

FCC155, Class A
EN55022, Class A
EC DIR 89/336/EEC
EN50082-1
Limited Warranty and Disclaimers

Telestream, Inc. (the Company) warrants to the original registered end user that the product will perform as stated below for a period of one (1) year from the date of shipment from factory:

Hardware and Media. The Product hardware components, including equipment supplied but not manufactured by the Company but NOT including any third party equipment that has been substituted by the Distributor for such equipment (the “Hardware”), will be free from defects in materials and workmanship under normal operating conditions and use.

Software. If software is supplied as part of the product, the software will operate in substantial conformance with specifications set forth in its product user's guide. The Company does not warrant that the software will operate uninterrupted or error-free, will meet your requirements, or that software errors will be corrected.

Warranty Remedies

Your sole remedies under this limited warranty are as follows:

Hardware and Media. The Company will either repair or replace (at its option) any defective Hardware component or part, or Software Media, with new or like new Hardware components or Software Media. Components may not be necessarily the same, but will be of equivalent operation and quality.

Software. If software is supplied as part of the product and it fails to substantially confirm to its specifications as stated in the product user's guide, the Company shall, at its own expense, use its best efforts to correct (with due allowance made for the nature and complexity of the problem) such defect, error or nonconformity.

Software Updates

If software is supplied as part of the product, the Company will supply the registered purchaser/licensee with maintenance releases of the Company’s proprietary Software Version Release in manufacture at the time of license for a period of one year from the date of license or until such time as the Company issues a new Version Release of the Software, whichever first occurs. To clarify the difference between a Software Version Release and a maintenance release, a maintenance release generally corrects minor operational deficiencies (previously non-implemented features and software errors) contained in the Software, whereas a Software Version Release adds new features and functionality. The Company shall have no obligation to supply you with any new Software Version Release of Telestream software or third party software during the warranty period, other than maintenance releases.

Restrictions and Conditions of Limited Warranty

This Limited Warranty will be void and of no force and effect if (i) Product Hardware or Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, neglect, or shipping, or as a result of service or modification by a party other than the Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties

THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral or written information or advice given by the Company, its distributors, dealers or agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty. This limited warranty is valid only within the country in which the Product is purchased/licensed.

Limitations on Remedies. YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF TELESTREAM, INC. WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any Limited Warranty by the Company shall be the recovery of reasonable damages which, in the aggregate, shall not exceed the total amount of the combined license fee and purchase price paid by you for the Product.

Damages. TELESTREAM, INC. SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:

Telestream, Inc.
848 Gold Flat Road, Suite 1
Nevada City, CA 95959

You can call Telestream, Inc. via telephone at (530) 470-1300.
# Contents

## Preface

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copyright and Trademark Notice</td>
<td>i</td>
</tr>
<tr>
<td>MPEG-2 License Requirements</td>
<td>i</td>
</tr>
<tr>
<td>Obtaining Pipeline Support</td>
<td>Information</td>
</tr>
<tr>
<td>Company and Product Information</td>
<td>ii</td>
</tr>
<tr>
<td>FCC Emission Information</td>
<td>ii</td>
</tr>
<tr>
<td>Canadian EMC Notice of Compliance</td>
<td>iii</td>
</tr>
<tr>
<td>Important Safety Instructions</td>
<td>iii</td>
</tr>
<tr>
<td>Limited Warranty and Disclaimers</td>
<td>iv</td>
</tr>
</tbody>
</table>

## Chapter 1 Introduction

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipeline Automates Real-time Media Workflows</td>
<td>1</td>
</tr>
<tr>
<td>Telestream's Pipeline Family of Products</td>
<td>2</td>
</tr>
<tr>
<td>Pipeline SC</td>
<td>2</td>
</tr>
<tr>
<td>Pipeline Quad</td>
<td>2</td>
</tr>
<tr>
<td>Pipeline HD Dual</td>
<td>3</td>
</tr>
<tr>
<td>Pipeline Benefits</td>
<td>3</td>
</tr>
<tr>
<td>Extend FlipFactory Workflows with Pipeline</td>
<td>4</td>
</tr>
</tbody>
</table>

## Chapter 2 Pipeline Hardware, Installation & Setup

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environmental Operating Requirements</td>
<td>6</td>
</tr>
<tr>
<td>Power Requirements</td>
<td>6</td>
</tr>
<tr>
<td>Unpack the Pipeline</td>
<td>6</td>
</tr>
<tr>
<td>Locate the Pipeline SC</td>
<td>7</td>
</tr>
<tr>
<td>Locate the Pipeline Quad</td>
<td>Pipeline HD Dual</td>
</tr>
<tr>
<td>Pipeline SC Hardware</td>
<td>8</td>
</tr>
</tbody>
</table>
## Contents

- Front Panel Indicators ................................................................. 8
- Rear Panel Ports and Connectors ................................................. 9
- Pipeline Quad Hardware ............................................................... 9
  - Front Panel Indicators ............................................................. 10
  - Rear Panel Ports and Connectors ............................................. 11
- Pipeline HD Dual Hardware .......................................................... 12
  - Front Panel Indicators ............................................................. 13
  - Front Panel Reset Switches ..................................................... 14
  - Rear Panel Ports and Connectors ............................................. 14
- Connecting Pipeline Directly to Mac OS X or Windows Computers ........................................... 16
- Adding Pipeline to a Network ...................................................... 17
  - Powering up the Pipeline ......................................................... 17
- Configuring & Connecting to Pipelines ........................................ 18
  - Configuring Pipeline Network Settings ................................. 18
  - Installing Bonjour for Windows .............................................. 18
  - Connecting to Pipeline via Bonjour ......................................... 19
  - Connecting via IP Address ......................................................... 19
  - Register Your Pipeline ............................................................. 20

## Chapter 3 Implementing Pipeline & Installing Software

- Pipeline Application Feature Comparison ................................... 22
- Workflow Application Requirements .......................................... 22
- Typical Pipeline Systems and Considerations ............................. 23
- Disk Requirements For Media Files ............................................ 26
- Disk Buffering Details ................................................................. 27
- Platform and System Requirements ........................................... 29
  - General Pipeline Host System Requirements ....................... 29
  - System Requirements for FlipFactory Pipeline Workflows ........ 29
- Network and Hard Disk Performance Requirements ................. 29
  - Suggested Hardware Configurations for SD Ingest Processing .................. 30
  - Suggested Hardware Configurations for HD Ingest Processing ........... 30
- Installing Pipeline Software on Mac OS X .................................. 31
- Upgrading Pipeline Software on Mac OS X ............................... 31
- Removing Pipeline Software from Mac OS X ............................ 31
- Installing Pipeline Software on Windows .................................. 32
- Upgrading Pipeline Software on Windows ............................... 32
- Removing Pipeline Software on Windows ............................... 33
Chapter 4 Using Pipeline Direct

Supported Web Browsers ....................................................................................................................36
  Browser Settings for Pipeline Direct ..........................................................................................36
Launching Pipeline Direct .................................................................................................................36
  Pipeline Direct Panels .................................................................................................................38
Using the About Panel .......................................................................................................................39
Using the Configure Panel ...............................................................................................................40
Using the Quad Panel .........................................................................................................................44
Using the Counters Panel .................................................................................................................47
Using the Live Panel ..........................................................................................................................49
  Live Panel Components .................................................................................................................50
Capturing SD Media to a TIFO File .................................................................................................53
Using the Upgrade Panel ....................................................................................................................55

Chapter 5 Using Pipeline with FlipFactory

FlipFactory Platform Requirements ....................................................................................................58
Obtaining a Pipeline License .............................................................................................................58
Telestream Intermediary Format (TIFO) ............................................................................................58
Pipeline Media Processing in FlipFactory ..........................................................................................59
Pipeline | FlipFactory Workflows .......................................................................................................60
Submitting Pipeline Media to FlipFactory ..........................................................................................60
Submitting Jobs Via an EDL Monitor .................................................................................................61
Submitting Streaming Media from Pipeline .......................................................................................62
  Using the Submit Job Window to Stream Pipeline Media ...............................................................63
Pipeline Capture Editor ....................................................................................................................65
Submitting TIFO File Jobs ..................................................................................................................69
Checking Pipeline Job Status ............................................................................................................69
Creating a Factory to Submit Jobs via EDL Monitors .........................................................................71
Sample Workflows ............................................................................................................................72

Chapter 6 Using Pipeline in Final Cut Pro & Episode Desktop

Setting Preferences ............................................................................................................................76
Importing Media Into Final Cut Pro | Episode Desktop ......................................................................80
  Importing Streaming Media Clips from Pipeline ..........................................................................81
Crash Recording Media with Pipeline Import Dialog .........................................................................86
Loading and Saving Clip List Files ..................................................................................................87
Exporting Media to Pipeline From Final Cut Pro ...............................................................................90
Chapter 7 Using Pipeline Control

Opening Pipeline Control .....................................................................................................................96
Pipeline Control Overview ...................................................................................................................97
Pipeline Control Menus ......................................................................................................................99
The Pipeline Settings Toolbar ..........................................................................................................102
Configuring Publishers ....................................................................................................................107
The Preview Panel ...............................................................................................................................116
  The Timecode, Status/Scrubber and Preview Controls Panel ........................................................117
  Audio Volume Meters ......................................................................................................................118
Preferences – Mac OS X ...................................................................................................................119
Preferences – Windows ......................................................................................................................122
Using the Diagnostics Panel ..............................................................................................................124

Chapter 8 Using Scheduled Playout & Capture

About Schedules ...................................................................................................................................126
Creating Capture Schedules ..............................................................................................................127
Creating Playout Schedules ..............................................................................................................128
Using Schedule Windows ..................................................................................................................129
  The Schedule Panel .........................................................................................................................129

Chapter 9 Using Log and Capture

About Logging and Capturing Media .................................................................................................138
Creating Clip Lists for Log and Capture ............................................................................................138
  Using the Log and Capture Window ...............................................................................................139
Using the Preview Panel ..................................................................................................................140
Using the Clip List Panel ..................................................................................................................141
Loading and Saving Clip List Files ....................................................................................................142
Keyboard Shortcuts ...........................................................................................................................143
Clip List Buttons ...............................................................................................................................143

Appendix A Troubleshooting

Gathering Information for Troubleshooting .......................................................................................145
Appendix B Pipeline EDL Syntax

Pipeline EDL Syntax Requirements ........................................................................................................... 147

Appendix C Pipeline Control Codec Profiles

DNxHD Profiles ............................................................................................................................................. 152
DV Profiles .................................................................................................................................................. 153
DVCPRO Profiles ....................................................................................................................................... 153
DVCPRO HD Profiles .................................................................................................................................. 154
IMX Profiles ............................................................................................................................................... 154
ProRes 422 Profiles ..................................................................................................................................... 155
Motion JPEG Profiles ................................................................................................................................. 156
Uncompressed Profiles ............................................................................................................................... 156
Linear PCM Audio Profile .......................................................................................................................... 156
Chapter 1 Introduction

Figure 1–1. Pipeline automates and adds value to real-time transcoding workflows ...................................1
Figure 1–2. Pipeline SC – compact, and easy to set up .............................................................................2
Figure 1–3. Pipeline Quad – four-channels for high-volume applications ..................................................2
Figure 1–4. Pipeline HD Dual – two channels for high-volume HD applications ........................................3

Chapter 2 Pipeline Hardware, Installation & Setup

Figure 2–1. Pipeline SC front panel ...........................................................................................................8
Figure 2–2. Pipeline SC rear panel ............................................................................................................9
Figure 2–3. Pipeline Quad front panel ......................................................................................................10
Figure 2–4. Pipeline Quad rear panel ......................................................................................................11
Figure 2–5. Pipeline HD Dual front panel ..............................................................................................13
Figure 2–6. Pipeline HD Dual reset switches behind front panel .............................................................14
Figure 2–7. Pipeline HD Dual rear panel ...............................................................................................14
Figure 2–8. Pipeline video, VTR & network connections .........................................................................16
Figure 2–9. Pipeline video, VTR control & network LAN connections .....................................................17

Chapter 3 Implementing Pipeline & Installing Software

Figure 3–1. Best practices – isolated GigE LAN, dedicated Ethernet port, and a single switch ..............23
Figure 3–2. Best practices – for each 2 capture streams, use one Ethernet port .....................................24
Figure 3–3. Configuration for capturing 4 HD streams onto Fibre-attached storage ...............................24
Figure 3–4. Configuration for capturing 4 HD streams onto NAS with Fibre-attached buffer space .......25
Figure 3–5. FIFO disk buffering enhances file writing performance ......................................................27
Figure 3–6. Pipeline buffering process ..................................................................................................28
Chapter 4 Using Pipeline Direct

Figure 4–1. Bonjour panel displays Pipelines on your LAN.................................................................37
Figure 4–2. Connect dialog – enter your username and password to connect ..................................37
Figure 4–3. The Live panel displays by default when you connect to a Pipeline. ...............................38
Figure 4–4. The About panel displays a link to product registration..................................................39
Figure 4–5. Configure panel displays details & allows you to change settings ..................................40
Figure 4–6. Quad panel controls confidence monitoring.................................................................44
Figure 4–7. Confidence monitoring is performed by Pipeline 4 via internal Ethernet bridge.............45
Figure 4–8. Confidence monitor displays banner when no media stream...........................................46
Figure 4–9. Counters panel displays various processing values.........................................................47
Figure 4–10. Live panel allows you to control the VTR and create EDLs ............................................49
Figure 4–11. The virtual VTR panel allows you to control the VTR and create EDLs.........................51
Figure 4–12. The EDL panel displays clips you've marked, but not saved ........................................52
Figure 4–13. Upgrade panel allows you to upgrade Pipeline firmware ...........................................55

Chapter 5 Using Pipeline with FlipFactory

Figure 5–1. FlipFactory integrates with Pipeline to produce media from baseband sources.............60
Figure 5–2. Use the Submit Job window to stream media from Pipeline in real time..........................62
Figure 5–3. Set up the general job details before displaying the Capture Editor...............................63
Figure 5–4. Metadata added in Job Submit window is combined with metadata in Capture Editor ....64
Figure 5–5. Pipeline Capture Editor window. .....................................................................................65
Figure 5–6. VTR controls in Pipeline Capture Editor.................................................................66
Figure 5–7. Settings tab in Pipeline Capture Editor............................................................................66
Figure 5–8. Capture tab in Pipeline Capture Editor............................................................................67
Figure 5–9. Click Job Status to display Job Status window...............................................................69
Figure 5–10. Job Status window displays active & complete jobs ....................................................69
Figure 5–11. Status/History Window of job in process .......................................................................70

Chapter 6 Using Pipeline in Final Cut Pro & Episode Desktop

Figure 6–1. Select File > Import > Pipeline to display the Pipeline Browser........................................76
Figure 6–2. Use the Pipeline dialog to select the Pipeline and set the codec for this import..................76
Figure 6–3. Import Preferences...........................................................................................................77
Figure 6–4. Export Preferences..........................................................................................................78
Figure 6–5. Update Preferences..........................................................................................................78
Figure 6–6. Keyboard Preferences.......................................................................................................79
Figure 6–7. Use File > Import > Pipeline to import media from Pipeline in real time..................................80
Figure 6–8. Pipeline browser displays all Pipelines – select one and set the codec for this import ...........81
Figure 6–9. Use the Pipeline Import dialog to stream encoded media from your Pipeline.......................82
Figure 6–10. Pipeline Plugin Import dialog in action in Episode Desktop. ................................................82
Figure 6–11. Pipeline Import dialog’s video panel....................................................................................83
Figure 6–12. The Clip List panel allows you to work with and import clips.............................................83
Figure 6–13. The Clip Information dialog allows you to view and enter metadata values.......................84
Figure 6–14. Use the control panel to control your VTR and import clips. .............................................84
Figure 6–15. The Clip List buttons allow you to open clip list files and save clip lists as a file.................87
Figure 6–16. Click Load EDL to locate a clip list EDL file and load the entries into the Clip list..............87
Figure 6–17. Click Load XML to locate a clip list file and load the entries into the Clip list.......................88
Figure 6–18. Set up XML settings in Final Cut Pro. ..................................................................................88
Figure 6–19. Click Saved XML to save the entries in the Clip list as an XML file. .................................89
Figure 6–20. Select File > Export > Pipeline to export media to your Pipeline......................................90
Figure 6–21. Use the Pipeline browser to select the Pipeline for this export. .........................................91
Figure 6–22. Use the Pipeline Export dialog to stream media to your Pipeline.....................................92
Figure 6–23. Pipeline Export dialog video panel. ....................................................................................93
Figure 6–24. Use the control panel to control your VTR and export clips. .............................................93

Chapter 7 Using Pipeline Control

Figure 7–1. Task Selector in Pipeline Control (Mac OS X) ......................................................................96
Figure 7–2. Pipeline Control window for Windows (schedule Playout and Capture window)...................97
Figure 7–3. Pipeline Control window for Mac OS X (schedule Playout and Capture window)................97
Figure 7–4. Window panels and toolbars (Mac OS X – schedule panel shown).......................................98
Figure 7–5. Use the Pipeline Settings toolbar to select and configure a Pipeline for this window............102
Figure 7–6. Mac OS X Pipeline browser and selection window. ............................................................102
Figure 7–7. Windows Pipeline browser and selection window. .............................................................102
Figure 7–8. Typical video codec settings panel.......................................................................................103
Figure 7–9. Pipeline Control notifies you when a codec is not supported by the Pipeline.......................103
Figure 7–10. Typical audio codec settings panel. ...................................................................................104
Figure 7–11. FlipFactory publisher panel allows you to submit media to a specific factory.....................108
Figure 7–12. Episode Engine publisher allows you to submit media to a specific Episode Engine...........111
Figure 7–13. IM publisher allows you to send messages to specific IM recipients. ...............................113
Figure 7–14. Final Cut Pro publisher allows you to create an FCP XML Interchange file........................114
Figure 7–15. Copy File publisher allows you to duplicate just-completed clips.......................................115
Figure 7–16. Use the Preview panel to view incoming and outgoing streams or clip events..................116
Chapter 8 Using Scheduled Playout & Capture

Figure 8–1. The schedule panel allows you to create and manage your clip events. ...........................................129
Figure 8–2. Clip events in your schedule provide details about the clip..............................................................129
Figure 8–3. Pipeline Control displays the video clip’s folder. ..............................................................................131
Figure 8–4. Clip event general properties – file name, start and stop time, and event color...........................132
Figure 8–5. Clip event label values......................................................................................................................133
Figure 8–6. Use the Schedules Mode toolbar to place the schedule in various states. ....................................134
Figure 8–7. Schedule Toolbar. ..........................................................................................................................135

Chapter 9 Using Log and Capture

Figure 9–1. Use the Log and Capture window to create clip lists and capture media from Pipeline............139
Figure 9–2. Timecode, VTR, Jog and Shuttle in the Log and Capture window......................................................140
Figure 9–3. The Clip List panel allows you to work with and capture clips..........................................................141
Figure 9–4. The Clip List panel allows you to work with and capture clips..........................................................142
Pipeline™ is an industry-first, shareable, networked video capture system – a real-time media encoding and decoding hardware accessory. Pipeline systems provide real-time SD and HD SDI ingest and encoding into industry-standard QuickTime files, directly to network storage locations. Pipeline can also be used to stream media directly into Telestream® FlipFactory® transcoding workflow automation and Episode® media encoding applications, as well as 3rd party products, including Apple’s Final Cut Pro. Digital media platforms can also be used to play out QuickTime files in supported formats to Pipeline for real-time decoding and playout to SD and HD SDI.

Pipeline ingests media from tape or live sources, making it ideal for integration into a variety of broadcast, post-production, government, and other professional media workflow applications. A comprehensive Pipeline software development kit (SDK) is also available from Telestream, which enables easy integration into 3rd party applications.

**Pipeline Automates Real-time Media Workflows**

Designed into each Pipeline is the notion of ease of use for broadcasters, post-production houses, government agencies, universities, and video professionals. Setting up a Pipeline is easy. Connect Ethernet and SDI, attach an optional VTR, and configure your network settings – you’re often up and running in under ten minutes.

Figure 1–1. Pipeline automates and adds value to real-time transcoding workflows
Pipeline can play out SD and HD TIFO or QuickTime files with Uncompressed (HD only), DV, IMX 30|40|50, ProRes 422, DNxHD, and DVCProHD files to Pipeline systems for decoding into SDI (NTSC or PAL format) in real time. Pipeline also provides a fast and easy way to ingest media from tape in real time, encode to the same formats plus MJPEG A, and save the file to servers, archives, or digital asset management systems.

TELESTREAM’S PIPELINE FAMILY OF PRODUCTS

The Pipeline product line consists of three products: Pipeline SC, Pipeline Quad, and Pipeline HD Dual.

Pipeline SC

Pipeline SC is a single-channel, single-session device. It is ideally suited for low-volume workflows where easy location and setup is important.

Figure 1–2. Pipeline SC – compact, and easy to set up

Pipeline SC offers these features:

- Network-accessible SDI video encoding and playout
- Real-time encoding from standard definition NTSC/PAL SDI to DV, DVCPro, IMX 30|40|50, ProRes 422 SQ (SD), MJPEG A, and MPEG-2 50 mb/sec I-frame video
- Real-time decoding from standard definition DV, DVCPro, IMX, ProRes 422 SQ, and MPEG-2 50mb/sec I-frame to PAL/NTSC SDI video
- Extends FlipFactory, Final Cut Pro, and Episode to include workflows with tape or live sources
- VBI closed caption and time code data extraction
- Shared network access to Pipeline saves time, effort and money
- Digitizes tapes into online libraries for an end-to-end DAM solution
- Records clips to tape for sharing with clients or colleagues.

Pipeline Quad

Pipeline Quad is a four-channel, rack-mounted system with Gigabit Ethernet and four independent Pipeline channels. Pipeline Quad also has an SDI Reference input for synchronizing output streams and for extracting a VITC time code.

Figure 1–3. Pipeline Quad – four-channels for high-volume applications
The Pipeline Quad's rack-mount form is ideal for high-volume, scalable workflows where throughput and performance are important factors.

Pipeline Quad performs all encoding and decoding available in Pipeline SC, and adds these features:
- Four concurrent, independent Pipeline channels on a single, rack-mount device
- SDI Sync reference channel (sync in only) for frame-synchronized playout across all channels
- Optional, configurable confidence monitoring of client-bound video on a dedicated channel
- Gigabit Ethernet and dual, common power supplies for increased fail-safe operation.

**Pipeline HD Dual**

Pipeline HD Dual is a two-channel, rack-mounted system with dual Gigabit Ethernet enabling two independent Pipeline HD channels. Pipeline HD Dual also has an SDI Reference input for synchronizing output streams and for extracting VITC time code.

**Figure 1–4. Pipeline HD Dual – two channels for high-volume HD applications**

The Pipeline HD Dual's rack-mount form is ideal for high-volume, scalable workflows where throughput and performance are important factors.

Pipeline HD Dual performs all encoding and decoding available in Pipeline SC, and adds these features:
- HD codec support for Uncompressed SD 8- and 10-bit, Apple ProRes 422 HD, Avid DNxHD, and DVCProHD
- Two concurrent, independent Pipeline HD channels on a single, rack-mount device
- Sync reference channel (sync in only) for frame synchronized playout across all channels
- Optional, configurable confidence monitoring of client-bound video on a dedicated channel
- Gigabit Ethernet for each channel and dual, common power supplies for increased fail-safe operation.

**PIPELINE BENEFITS**

**A better way to ingest baseband media**

Pipeline is a dedicated, external media decoding and encoding device with flexible Ethernet connectivity that offers significant advantages and cost savings over typical capture card solutions. It is more reliable, eliminating the susceptibility of a server/card model. Pipeline also removes operating system and driver incompatibilities, and reduces the need to use an expensive broadcast server channel.

**Accessible from any workstation on your network**

Shared network access makes Pipeline a cost-effective video capture solution. FlipFactory users can access Pipeline via Pipeline Direct, an embedded Web app, eliminating the need for dedicated
workstations for each user. Factories can be designed to ingest media from Pipeline using edit decision lists (EDLs) to transcode media in real time.

Real-time encoding accelerates FlipFactory workflows

Media transfer can be controlled with a VTR, and streaming to FlipFactory begins immediately while encoding in Pipeline. Simultaneous transcoding in FlipFactory greatly improves overall workflow throughput. High-resolution files can be directed to storage, while a proxy or other version is being created by FlipFactory. An RS-422 VTR deck control provides frame accurate ingest from professional tape machines.

Supports a broad range of SD and HD formats

Pipeline features broad format support in a single device. Pipeline is network-configurable to encode/decode standard definition 8 and 10bit Uncompressed, DV and DVCPro 25, IMX 30|40|50, ProRes 422 SQ, and high definition DVCProHD, DNxHD and ProRes 422. With Pipeline, there’s no need to have multiple dedicated devices to handle your changing format needs. Plus, you can upgrade Pipeline right on the network to easily add new formats and features as they become available from Telestream.

**EXTEND FLIPFACTORY WORKFLOWS WITH PIPELINE**

This innovative, network-ready video capture accessory extends FlipFactory workflows, allowing real-time ingest of high-quality baseband media directly into a FlipFactory server.

You can use Pipeline Direct, a powerful embedded Web app in every Pipeline, to control (with a VTR) and preview streaming video, create and save EDL files, and crash record SD media into a TIFO (Telestream Intermediary Format (TIFO) on page 58) file for further processing.

Batch ingest from an EDL file allows users to encode multiple clips from a single tape. Plus, FlipFactory can automatically pick up EDLs from monitored folders for easy EDL integration. Together, Pipeline and FlipFactory automatically control the VTR and encode the clips needed.

You can schedule live ingest with Pipeline to capture incoming feeds at any time. By setting the start time and duration, live feeds, such as satellite, can be encoded and delivered when needed. You can also encode analog tapes into online digital libraries and asset management systems.

Pipeline can also be used to archive high-quality master files into DAM systems. Using the powerful metadata extraction tools in FlipFactory, master assets, proxy files and all associated metadata can be delivered to DAM systems in one single-step process.
Use this chapter to unpack and set up Pipeline SC, Pipeline Quad, and Pipeline HD Dual devices, connect video equipment, and configure the Pipeline for a LAN connection. Before proceeding, work with your network administrator to determine network setting requirements: IP address (automatic link-local, DHCP, or static) and netmask, and the gateway address. You should also understand your media workflow requirements and read Network and Hard Disk Performance Requirements (page 29).

**Note**

*Topics in this chapter refer to all Pipeline devices unless specifically noted.*

To set and configure your Pipeline correctly, complete the tasks in this chapter, referring to Chapter 4, Using the Configure Panel on page 40 for network configuration tasks.

**Topics**

- Environmental Operating Requirements (page 6)
- Power Requirements (page 6)
- Unpack the Pipeline (page 6)
- Locate the Pipeline SC (page 7)
- Locate the Pipeline Quad | Pipeline HD Dual (page 7)
- Pipeline SC Hardware (page 8)
- Front Panel Indicators (page 8)
- Rear Panel Ports and Connectors (page 9)
- Pipeline Quad Hardware (page 9)
- Front Panel Indicators (page 10)
- Rear Panel Ports and Connectors (page 11)
- Pipeline HD Dual Hardware (page 12)
- Connecting Pipeline Directly to Mac OS X or Windows Computers (page 16)
- Adding Pipeline to a Network (page 17)
- Powering up the Pipeline (page 17)
- Configuring & Connecting to Pipelines (page 18)
- Configuring Pipeline Network Settings (page 18)
- Installing Bonjour for Windows (page 18)
- Connecting to Pipeline via Bonjour (page 19)
- Connecting via IP Address (page 19)
- Register Your Pipeline (page 20)
ENVIRONMENTAL OPERATING REQUIREMENTS

Plan adequate space for cable routing from the back of the chassis. Ensure that the Pipeline is in close proximity to your Ethernet and video cables, and that cable connectors are not stressed, bent, or crimped. Also make sure that you have adequate space for a VTR deck, if necessary.

Caution

Do not place more than two Pipeline SCs in a stack. If you do, you risk overheating a unit, potentially leading to operational failure.

Allow at least six inches (15 cm) of space between the Pipeline and the nearest object to ensure adequate airflow. Keep the temperature range within acceptable limits (table below), and keep humidity moderate in the vicinity. Temperature specifications are as follows:

Table 2–1. Operating and Storage Temperature Parameters

<table>
<thead>
<tr>
<th>Modes</th>
<th>Temperature Ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Temperature</td>
<td>0°C to 40°C (32°F to 104°F)</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-40°C to 60°C (-40°F to 140°F)</td>
</tr>
</tbody>
</table>

POWER REQUIREMENTS

Input Voltage. Auto-sensing 100 to 240V AC, 50/60Hz

Caution

Telestream recommends connecting computer equipment to AC power through an uninterruptible power supply (UPS) with surge protection. Fluctuations in commercial supply voltage can damage unprotected electronic equipment.

A high quality surge suppressor may be substituted if a UPS is not available, but it may not provide adequate protection.

UNPACK THE PIPELINE

Unpack the contents of the original shipping container; identify each component and determine that they are in satisfactory condition. If any shipping damage is visible, note it on your shipping documents and contact your shipping agent and Telestream or authorized Telestream distributor.

Note

Save all packaging materials and store them in a safe place. If you require service – or move your Pipeline – the packaging materials may be used for safe shipment.
Pipeline SC Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:
• Software Installation and User’s Guide CD-ROM
• Power adapter with power cord
• Quick Start Guide (in CD case)

Pipeline Quad Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:
• Software Installation and User’s Guide CD-ROM
• Power cords
• Quick Start Guide (in CD case)

Pipeline HD Dual Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:
• Software Installation and User’s Guide CD-ROM
• Power cords
• Quick Start Guide (in CD case)

LOCATE THE PIPELINE SC
For permanent locations, select a stable and level, smooth, hard surface. Avoid carpeted or cloth-covered surfaces which inhibit airflow or reduce heat dissipation, which contributes to overheating. Select an isolated area that provides a proper operating environment and protection from accidental damage to the Pipeline. Route power and Ethernet and other cables to protect users from a tripping hazard and damage to the Pipeline.

LOCATE THE PIPELINE QUAD | PIPELINE HD DUAL
For permanent locations, mount the Pipeline Quad|HD Dual in a single rack-unit slot in a computer rack and secure it in place. Make sure the following issues are adequately addressed:

Elevated Operating Ambient. If installed in a closed or multi-unit rack assembly, the operating ambient temperature of the rack environment may be greater than room ambient. Therefore, consideration should be given to installing the equipment in an environment compatible with the maximum ambient temperature specified (Table 2–1 on page 6).

Reduced Air Flow. Installation of the equipment in a rack should be such that the amount of air flow required for safe operation of the equipment is not compromised.

Mechanical Loading. Mounting of the equipment in the rack should be such that a hazardous condition is not achieved due to uneven mechanical loading.

Circuit Overloading. Consideration should be given to the connecting equipment to the supply circuit and the effect that overloading of the circuits might have on over-current protection and supply wiring. Appropriate consideration of equipment nameplate ratings should be given when addressing this concern.
Reliable Earthing. Reliable earthing of rack-mounted equipment should be maintained. Particular attention should be given to supply connections other than direct connections to the branch circuit (e.g. use of power strips). Alternately, select a stable and level, smooth, hard surface. Avoid carpeted or cloth-covered surfaces, which can inhibit airflow or reduce heat dissipation, and contribute to overheating. Select an isolated area that provides a proper operating environment and protection from accidental damage to the Pipeline. Route power and Ethernet and other cables to protect users from a tripping hazard and damage to the Pipeline.

**PIPELINE SC HARDWARE**

The Pipeline SC is 7.5 inches (19.1 cm) wide, 5.5 inches (14.0 cm) deep, and 1.5 inches (3.8 cm) high.

Pipeline SC is a compact, network-ready SDI encoder/decoder device equipped with 10/100Mb Ethernet using TCP/IP, UDP, RTSP, and RTP and Bonjour for service discovery, plus Serial Digital Interface (BNC, SMPTE-259M 270mb/sec) with 8-channel embedded audio input and output ports with automatic detection of 525/625, and an RS-422 deck control port using Sony 9 Pin Protocol.

Pipeline can encode and decode NTSC or PAL with DV/DVCPRO 25Mb, IMX 30, 40, 50, and MPEG2 I-Frame 50Mb video (FlipFactory workflows), and 48 kHz, 16 bit, uncompressed audio.

**Processing VBI Closed Caption and Time Code**

Pipeline automatically processes Vertical Blanking Interval (VBI) data on ingest operations to obtain closed caption and time code data. Closed captions are extracted from line 21, and time code from lines 16 through 20 (5 lines beginning with line 16). The last line (usually 20) with a valid time code is the line whose data is used. Pipeline encodes the closed caption and time code data into the data stream of the digital output, making it available for processing by client applications, such as FlipFactory and Episode.

**Front Panel Indicators**

The front panel contains LED indicators, making it easy to check its status.

*Figure 2–1. Pipeline SC front panel*

There are three LEDs you use to determine the state of the Pipeline:

**Power.** Lights green when power is present.

**SDI In.** Lights green when Pipeline is configured to encode SDI In and send it out via Ethernet. How media is encoded is determined by the selected codec. If the LED lights orange, data is being lost. The reason should be corrected before continuing operation. During a firmware upgrade, this LED lights yellow until you reboot.
SDI Out. Lights green when the Pipeline is configured to encode digital media from the Ethernet port, and send encoded media to the SDI Out port. If the LED lights orange, data is being lost. The reason should be corrected before continuing operation.

Rear Panel Ports and Connectors

The rear panel contains the power jack, plus video and network connector ports.

Figure 2–2. Pipeline SC rear panel

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage.

DC Power Port. Use to connect and turn on the Pipeline. Only connect the Pipeline to power using the Telestream-supplied power supply.

10/100 Ethernet Port. The Ethernet port has two LEDs:
Link (left LED): If the LED is not lit, no link is available. If the LED is lit orange, link has been established.
Connection/Activity (right LED): If the port is connected at 100 Mb, the LED lights green, and blinks on activity. If the port is connected at 10 Mb, the LED is unlit, but blinks green during activity.

RS-422. Female DB-9 RS-422 port for VTR, using Sony 9 Pin protocol.

SDI In. BNC jack for SDI input signal.

SDI Out. BNC jack for SDI output.

Caution

If the Connection LED is unlit, the Pipeline is operating at 10 Mb, which is unacceptable for real time video traffic. Resolve the problem before continuing, to avoid video stream data loss.

PIPELINE QUAD HARDWARE

The Pipeline Quad is 17.3 inches (43.9 cm) wide, 13.2 inches (33.5 cm) deep, and 1.5 inches (3.8 cm) high. Pipeline Quad is a single rack unit, with four onboard SDI encoder/decoder devices equipped with an external Gigabit Ethernet port and an onboard switch routing 100Mb Ethernet to each device, using TCP/IP, UDP, RTSP, and RTP and Bonjour for service discovery. Serial Digital Interfaces are provided for each device (BNC, SMPTE-259M 270mb/sec) with four 8-channel embedded audio input and output ports with automatic detection of 525/625, and RS-422 deck control ports, using Sony 9 Pin Protocol.
Pipeline Quads can encode and decode NTSC or PAL with DV/DVCPRO 25Mb, IMX 30, 40, 50, and MPEG2 I-Frame 50Mb video (FlipFactory workflows), and 48 kHz, 16 bit, uncompressed audio, in up to four concurrent sessions; each individual Pipeline channel operates independently, each communicating via a common physical Ethernet port on the Quad’s backplane.

The Pipeline Quad provides common, dual power supplies for redundancy and fail-safe operation. The Pipeline can operate normally on a single power supply, but you lose the safety of the second power supply.

Using SDI Sync Input

The SDI Sync Input is used in both capture and playout modes but for two different purposes.

In capture mode, the SDI Sync Input is used as a method for supplying a common timecode reference to all input channels. For the timecode to be extracted, the SDI signal connected to the SDI Sync Input must contain a valid timecode in the vertical blanking area of the signal. This timecode is usually referred to as VITC (vertical interval timecode). The SDI signal must be a digital signal that is frame synchronized with the SDI signals used as the input video source for the timecode extraction to work properly. An analog signal cannot be connected to the SDI Sync input.

In playout mode, the SDI Sync Input is used as a frame synchronization source for each of the SDI outputs. Any timecode on the SDI Sync Input is ignored in this mode. If no signal is connected to the SDI Sync Input, each of the SDI outputs will free run (i.e. they will not be synchronized with each other or with any house reference). An analog signal cannot be connected to the SDI Sync input.

Using SDI Sync Out

The SDI Sync Out port is a re-clocked loop-through port of SDI Sync In. You can use this re-clocked reference for additional Pipelines or other devices.

Processing Closed Caption and Time Code Data

Pipeline automatically processes Ancillary Data on ingest operations to obtain closed captions and time code data. Pipeline encodes the closed caption and time code data into the data stream of the digital output, making it available for further processing by client applications, such as FlipFactory and Episode.

The Pipeline automatically analyzes the signal during the Vertical Blanking Interval (VBI) on ingest operations to obtain closed captions and time code data. Closed caption data is extracted from line 21, and time code data from lines 16 through 20 (the 5 lines beginning with line 16). The last line (usually line 20) with a valid time code is the line whose data is used.

Front Panel Indicators

The front panel contains LED indicators, making it easy to check its status.

Figure 2–3. Pipeline Quad front panel
SDI In. One per channel. Lights green when the Pipeline is configured to encode SDI In and send it out via the Ethernet port. Media is encoded based on the selected codec. If the LED lights orange, data is being lost. Correct problem before continuing. During a firmware upgrade, the LED lights yellow until you reboot.

SDI Out. One per channel. Lights green when the Pipeline is configured to encode digital media from the Ethernet port, and send encoded media to the SDI Out port. If the LED lights orange, data is being lost. The reason should be corrected before continuing operation.

The LED blinks orange at one second intervals when the internal Ethernet switch and network that connects the four Pipelines has failed. Usually, at least one of the Pipelines can’t communicate, indicating that potentially an input channel has failed, and confidence monitoring is not operational. Reboot to solve the problem, or contact Telestream customer service.

Link. Lights green when Ethernet link has been established.

Sync. Lights green when an SDI signal is detected on the sync reference input channel.

PWR 1 & 2. Lights green when power is present and the power supply is operating normally. PWR1 indicates power supply 1; PWR2 indicates power supply 2. An orange PWR LED indicates a failed power supply or that no power is present.

If a power supply fails, complete jobs in progress. RMA the Pipeline to Telestream for repair as soon as practical.

Rear Panel Ports and Connectors

The rear panel contains power plugs, plus video and network connector ports.

**Figure 2–4. Pipeline Quad rear panel**

![Pipeline Quad rear panel](image)

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage.

**AC Power Plugs.** Use to connect and turn on the Pipeline. Only connect the Pipeline Quad to power using the Telestream-supplied power cords. To insure fail-safe operation, be sure to use both power supplies. These supply common power to the Pipeline; if one power supply fails, the Pipeline continues to operate.

**Sync In.** The SDI Sync Input is used in both capture and playout modes but for two different purposes. In capture mode it is used as a method for supplying a common timecode reference to all input channels. In playout mode it is used as a frame synchronization source for each of the SDI output channels. (See “Using SDI Sync Input” on page 10.)

**Sync Out.** Re-clocked loop-through port of SDI Sync In. You can use this re-clocked reference for additional Pipelines or other devices.
Using SDI Sync Out

SDI Sync Out port is a re-clocked loop-through port of SDI Sync In. You can use this re-clocked reference for additional Pipelines or other devices.

**RS-422.** Female DB-9 RS-422 port for VTR, using Sony 9 Pin Protocol (one per channel).

**SDI In.** BNC jack for SDI input (one per channel).

**SDI Out.** BNC jack for SDI output (one per channel).

**Gigabit Ethernet Port.** The Ethernet RJ-45 jack has two LEDs: If the left, orange LED is lit and the right, green LED is lit, the port is operating at 1Gbs (gigabit). If only the orange LED is lit, the Ethernet port is not connected. Be sure to use CAT-6 cabling end-to-end from Pipeline to your Macintosh or Windows PC client for best results.

---

**Pipeline HD Dual Hardware**

The Pipeline HD Dual is 17.3 inches (43.9 cm) wide, 13.2 inches (33.5 cm) deep, and 1.5 inches (3.8 cm) high. Pipeline HD Dual is a single rack unit, with two onboard HD/SD-SDI encoder/decoder devices equipped with two external Gigabit Ethernet ports, using TCP/IP, UDP, RTSP, and RTP and Bonjour for service discovery. Serial Digital Interfaces are provided for each device (BNC, SMPTE-259M 270mb/sec) with two 8-channel embedded audio input and output ports with automatic input format detection, and RS-422 deck control ports, using Sony 9-Pin Protocol.

Pipeline HD Dual can encode and decode DV/DVCPRO 25/50, IMX 30, 40, 50, MPEG-2 50M I-frame, Apple ProRes SD/HD, Avid DNxHD and DVCProHD video, and 48 kHz, 16/24 bit, uncompressed audio.

Using SDI Sync Input

The SDI Sync Input is used in both capture and playout modes but for two different purposes.

In capture mode, the SDI Sync Input is used as a method for supplying a common timecode reference to all input channels. For the timecode to be extracted, the SDI signal connected to the SDI Sync Input must contain a valid timecode in the vertical blanking area of the signal. This timecode is usually referred to as VITC (vertical interval timecode). The SDI signal must be a digital signal that is frame synchronized with the SDI signals used as the input video source for the timecode extraction to work properly. An analog signal cannot be connected to the SDI Sync input.

In playout mode, the SDI Sync Input is used as a frame synchronization source for each of the SDI outputs. Any timecode on the SDI Sync Input is ignored in this mode. If no signal is connected to the SDI Sync Input, each of the SDI outputs will free run (i.e. they will not be synchronized with each other or with any house reference). An analog signal cannot be connected to the SDI Sync input.

---

**Caution**

If only the green LED is lit or the LED is unlit, the Pipeline is operating at 100 or 10 Mb respectively. These data rates are unacceptable for real time video traffic from all four channels. Resolve the problem by connecting at 1 Gbs before processing jobs to avoid data loss.
Processing Closed Caption and Time Code Data

Pipeline automatically processes Ancillary Data on ingest operations to obtain closed captions and time code data. Pipeline encodes the closed caption and time code data into the data stream of the digital output, making it available for further processing by client applications, such as FlipFactory and Episode.

When a Standard Definition SDI signal is connected, the Pipeline automatically analyzes the signal during the Vertical Blanking Interval (VBI) on ingest operations to obtain closed captions and time code data. Closed caption data is extracted from line 21, and time code data from lines 16 through 20 (the 5 lines beginning with line 16). The last line (usually line 20) with a valid time code is the line whose data is used.

When a High Definition SDI signal is connected, the Pipeline automatically processes all Ancillary data packets to obtain closed captions and time code data. Closed caption data is extracted from Ancillary data packets with a DID of 0x161 and time code data is extracted from Ancillary data packets with a DID of 0x260.

Front Panel Indicators

The front panel contains LED indicators, making it easy to check its status.

Figure 2–5. Pipeline HD Dual front panel

SDI In. One per channel. Lights green continuously when an HD source is connected. Flashes green when an SD source is connected. If the LED flashes orange, data is being lost. Correct problem before continuing.

SDI Out. One per channel. Lights green continuously when HD format media is being output. Flashes green when SD format media is being output. If the LED lights orange, data is being lost. The reason should be corrected before continuing operation.

Mode. Lights green continuously when the selected codec is creating HD content. Flashes green when the selected codec is creating SD content.

Reference. Lights green continuously when an HD source signal is detected on the sync input reference channel. Flashes green when the source signal is SD.

Sync. Lights green when an HD source signal is detected on the sync input reference channel. Flashes green when the source signal is SD.

LAN. Flashes green to indicate LAN activity.

PWR 1 & 2. Lights green when power is present and the power supply is operating normally. PWR1 indicates power supply 1; PWR2 indicates power supply 2. An orange PWR LED indicates a failed power supply or that no power is present.

If a power supply fails, complete jobs in progress. RMA the Pipeline to Telestream for repair as soon as practical.
Front Panel Reset Switches

With the front panel bezel removed, three recessed reset buttons are exposed. They are not labelled.

Figure 2–6. Pipeline HD Dual reset switches behind front panel

Channel 1 Reset. Depress the recessed button to perform a hardware reset on Channel 1. The channel will be disconnected from any client currently attached.

Channel 2 Reset. Depress the recessed button to perform a hardware reset on Channel 2. The channel will be disconnected from any client currently attached.

Factory Default Reset. Depress the recessed button to restore the factory defaults the entire Pipeline device. Both channels are returned to their original factory default values, including IP address and any options selected. During reset all LEDs glow green. When reset is complete, the LEDs return to their normal state.

Rear Panel Ports and Connectors

The rear panel contains power plugs, plus video and network connector ports.

Figure 2–7. Pipeline HD Dual rear panel

AC Power Connectors
VTR RS-422 (one per channel)
SDI Out (one per channel)

Gigabit Ethernet (one per channel)
Sync In/Out
SDI In (one per channel)

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage.

AC Power Plugs. Use to connect and turn on the Pipeline. Only connect the Pipeline Quad to power using the Telestream-supplied power cords. To insure fail-safe operation, be sure to use both power supplies. These supply common power to the Pipeline; if one power supply fails, the Pipeline continues to operate.

Sync In. The SDI Sync Input is used in both capture and playout modes but for two different purposes. In capture mode it is used as a method for supplying a common timecode reference to all input channels. In playout mode it is used as a frame synchronization source for each of the SDI output channels. (See “Using SDI Sync Input” on page 10.)
Sync Out. Re-clocked loop-through port of SDI Sync In. You can use this re-clocked reference for additional Pipelines or other devices.

RS-422. Female DB-9 RS-422 port for VTR, using Sony 9 Pin Protocol (one per channel).

SDI In. BNC jack for SD-SDI or HD-SDI input (one per channel).

SDI Out. BNC jack for SD-SDI or HD-SDI output (one per channel).

Gigabit Ethernet Ports. Each Ethernet RJ-45 jack has two LEDs: If the left, orange LED is lit and the right, green LED is lit, the port is operating at 1Gbs (gigabit). If you only connect Ethernet to the Channel 1 port, the second channel is accessible, but all traffic flows through the only connection (channel 1). This may cause performance problems. If so, connect an Ethernet cable to the second Ethernet port. If only the orange LED is lit, the Ethernet port is not connected. Be sure to use CAT-6 cabling end-to-end from Pipeline to your Macintosh or Windows PC client for best results.

---

Caution

If only the green LED is lit or the LED is unlit, the Pipeline is operating at 100 or 10 Mb respectively. These data rates are unacceptable for real-time video traffic from all four channels. Resolve the problem by connecting at 1 Gb/sec before processing jobs to avoid data loss.
CONNECTING PIPELINE DIRECTLY TO MAC OS X OR WINDOWS COMPUTERS

Pipeline can be connected to a Mac OS X computer – a Final Cut Pro workstation or Episode Engine server, for example. Or, it can be connected to a Windows computer – a FlipFactory server, for example. You can connect Pipelines directly or via LAN using a Gigabit Ethernet (Gig-E) switch for Pipeline Quad|HD Dual or 100MB Ethernet for Pipeline SC.

Note

For workstations or servers with multiple network adapters, you should always connect the Pipeline (or switch) to Ethernet 1 (en0 in Mac OS X).

If the 169.254 route (or route of the IP address you’ve assigned the Pipeline) isn’t on Ethernet 1 (en0), run these commands in a command window (verify with your network administrator):

To remove:
   sudo route delete -net 169.254
To add it back to en1 (Windows).

For Mac OS X, change the last parameter to en0:
   sudo route add -net 169.254 -interface en1

Telestream recommends turning off your WiFi card when using Pipelines.

Use the instructions in this section to make Ethernet and video connections to your Pipeline when connecting it directly to a Mac OS X or Windows computer – either directly or via a switch.

Figure 2–8. Pipeline video, VTR & network connections

1. Make sure the Pipeline is not plugged in.
2. Connect the Pipeline Ethernet port directly or via a switch to the computer with an Ethernet cable.
3. Connect your VTR SDI Out port to the Pipeline SDI In port with a BNC coax cable connected to your video source – a VTR, for example.
4. (Optional) Connect the VTR RS-422 Out port to the Pipeline RS-422 port.
5. (Pipeline Quad – Optional) Connect video equipment to your Sync In and Sync Out video ports.
One or more Pipelines can connect to a LAN. To assure acceptable performance, be sure to connect Pipelines to a media network or a single Gigabit switch dedicated specifically for Pipelines, edit stations, and media servers. If you connect to a backbone, ensure it is Gigabit, to handle the real-time traffic. Make certain that switches do not have a firewall, and that TCP and UDP ports 7000/7002 (video), 7004/7006 (audio), 7008/7010 (status), 554 (RTSP), and 80 (http) are open.

Each Pipeline SC is assigned a unique, automatically assigned, link-local IP address in the range 169.254.1.0 to 169.254.255.255, so that it can communicate directly with your computer without a gateway. Each of the Pipelines (channels) in a Pipeline HD Dual and Pipeline Quad is assigned an incremental IP address.

You can also set up the Pipeline with a static or DHCP address. Make IP address modifications with Pipeline Direct, a Web application built into each Pipeline (Using the Configure Panel on page 40).

Use these instructions to make power, Ethernet, and video connections to one or more Pipelines when connecting it to a LAN where FlipFactory server or Final Cut Pro editing stations are located.

**Figure 2–9. Pipeline video, VTR control & network LAN connections**

1. Make sure the Pipeline is not plugged in.
2. Connect the Pipeline Ethernet port to a network switch with an Ethernet cable on the same LAN as your Final Cut Pro editing station or FlipFactory server.
3. Connect each Pipeline SDI IN port to an SDI source such as your VTR or SDI router with a BNC cable.
4. (Optional) Connect each Pipeline’s RS-422 port to an RS-422 control, such as your VTR.
5. (Pipeline Quad – Optional) Connect video equipment to your Sync In and Sync Out video ports.

**Powering up the Pipeline**

For Pipeline SC, plug the Telestream-supplied power adapter jack into the power port on the back plane, and then connect the power cord to an AC source (or power converter) to power the Pipeline on.

For Pipeline HD Dual and Pipeline Quad (with redundant power supplies) plug both Telestream-supplied power cords into the power plugs on the back plane, and then connect each power cord to an AC source (or power converter) to power the Pipeline on.
CONFIGURING & CONNECTING TO PIPELINES

As with other network devices, each Pipeline has a fixed MAC address, a default IP address, which you can change. Before using Pipeline, you’ll need to contact your IT administrator (especially when connecting to a LAN) to determine which IP address and net mask to use for each Pipeline and how to set it up (automatic link-local, DHCP, or static), based on your facility’s network address policy.

Configuring Pipeline Network Settings

To view and modify the Pipeline’s network configuration, log on and display the Configure panel (click Configure in the toolbar at the top of Pipeline Direct). See Using the Configure Panel on page 40.

After plugging the Pipeline into the network and powering it on, you can connect to Pipeline via Bonjour, or you can use the Pipeline’s default IP address.

When you connect, Pipeline Direct displays in your browser. For details on using Pipeline Direct, see Chapter 4, Using Pipeline Direct on page 35.

Note

Pipeline is a shareable, network device. You can log onto a Pipeline with Pipeline Direct anywhere on your network, via a Web browser. However, only a single user can log on and use the Pipeline at a time. If Pipeline displays the “Pipeline in Use” message in the video panel, you should close the application without performing any tasks to avoid interrupting someone else’s Pipeline session.

Installing Bonjour for Windows

Bonjour is a service discovery system from Apple, Inc. Bonjour is integrated in Pipeline and FlipFactory, and most network printers as well, as a means of easily identifying and connecting to network devices.

Note

To determine if Bonjour for Windows is installed, run Internet Explorer and select View > Explorer Bar. If the Bonjour panel is not listed, Bonjour is not installed.

If the Bonjour panel is selected and displays the message “Bonjour Service Not Available”, the service is stopped. Go to start > Control Panel > Administrative Tools > Services. Right-click Bonjour Service and select Start from the menu to start the service.

Bonjour is installed in FlipFactory 6.0 by the FlipFactory installer, but the service is turned off. FlipFactory installation includes starting the Bonjour service.

If you plan to use Pipeline on a Windows computer and Bonjour for Windows isn’t installed, install it now:

1. Insert the Pipeline CD into your workstation.
2. Run the installer from the CD menu and follow the installer instructions to install Bonjour. (Bonjour-Setup.exe is in the Files/Utilities directory.)
3. When you’re done installing Bonjour, eject the CD and store it in a safe place.
Connecting to Pipeline via Bonjour

In addition to an IP address, each Pipeline has a Bonjour-friendly name:

- Pipeline SC default: Pipeline_XXXX where XXXX is the serial number
- Pipeline HD Dual default: PipelineHDDualXXXX_N where N is device number 1 or 2.
- Pipeline Quad default: PipelineQuadXXXX_N where N is device number 1, 2, 3, or 4.

You can use this name to use Bonjour to identify Pipelines on a network and connect.

To connect to a Pipeline using the Bonjour panel (not available to Firefox users), follow these steps:

**Internet Explorer (Windows)**

1. Open Internet Explorer and select View > Explorer Bar > Bonjour to display the Bonjour panel.
2. Select the Pipeline in the panel to log on and display Pipeline Direct.

**Safari (Mac OS X)**

1. Open Safari and select Bookmarks > Show All Bookmarks.
2. In the Collections panel, click Bonjour.
3. Select the Pipeline from the list to log on and display Pipeline Direct.

**Firefox (Windows | Mac OS X)**

1. Open Firefox and enter the IP address (http://169.254.1.0, for example) – Bonjour is not supported.
2. Press Enter to log on and display Pipeline Direct.

Connecting via IP Address

Each Pipeline from the factory is assigned a default, link-local IP address in the range 169.254.1.0 to 169.254.254.255. The factory-supplied IP address is printed on the bottom of Pipeline SC. On Pipeline HD Dual and Pipeline Quad, it is printed on the left side, when looking at the front of the device.

For Pipeline HD Dual, channel number 2 is incremented by one from the default address. On Pipeline Quad, channels 2, 3, and 4 are serially incremented by one from the default IP address of device 1 through 4. For example, if Pipeline 1 is 169.254.1.10, then Pipeline 4 is 169.254.1.13.

If the Pipeline’s IP address has not been modified, you can identify Pipelines on a network and connect using an IP address by following these steps:

1. Identify the Pipeline IP address by viewing the label on the bottom of the device.
2. Open a Web browser and enter the URL in the form: http://169.254.12.194, replacing this sample IP address with the address of the target Pipeline. Press Enter to log on and display Pipeline Direct, authenticating if you’ve supplied a password on the Pipeline.
Note

In the unlikely event that you can’t connect, try these steps:

Make sure the Pipeline is connected to a switch on your LAN and powered on, and the Power LED on the front is lit.

Ping the Pipeline using the IP address. If you can’t ping it, there may be an IP address conflict, causing Pipeline to use a secondary address. Unplug the Pipeline and connect the Pipeline directly to a computer via an Ethernet cable, plug it in and ping it again.

If you’re connected directly to a computer, but can’t ping it, you may be using a standard Ethernet cable, but due to computer limitations, you need to use a cross-over cable.

If you can ping the Pipeline but still can’t connect, you may have a firewall blocking the connection.

See Appendix A, TroubleShooting, for assistance.

Register Your Pipeline

When the Pipeline is operational and you can connect via Pipeline Direct, register the Pipeline – display the About panel and click the Register button. Follow the steps on the Web page to complete registration.

If the computer you’re using is on a LAN without Internet access, use a computer that has Internet access and go to dynamic.telestream.net/pipeline-register/register.asp to register your Pipeline. You should register your Pipeline to ensure ongoing warranty service and customer service, per the terms of service.
CHAPTER 3

Implementing Pipeline & Installing Software

To implement Pipeline workflows to capture or play out media on Mac OS X or Windows, you’ll need to install Pipeline software. Use this chapter to determine your workflow and system requirements, and to install, upgrade, or uninstall Pipeline software.

**Note**
*Telestream recommends that Pipeline Control be installed on a computer that is not hosting FlipFactory, Episode Engine, or other media processing applications: intense disk and CPU consumption can interfere with proper operation of both applications.*

*When you install or upgrade Pipeline software, you may need to upgrade your Pipeline firmware as well.*

**Topics**
- Pipeline Application Feature Comparison (page 22)
- Workflow Application Requirements (page 22)
- Typical Pipeline Systems and Considerations (page 23)
- Disk Requirements For Media Files (page 26)
- Platform and System Requirements (page 29)
- Installing Pipeline Software on Mac OS X (page 31)
- Upgrading Pipeline Software on Mac OS X (page 31)
- Removing Pipeline Software from Mac OS X (page 31)
- Installing Pipeline Software on Windows (page 32)
- Upgrading Pipeline Software on Windows (page 32)
- Removing Pipeline Software on Windows (page 33)

**Note**
*If you haven’t installed the Pipeline yet, proceed to Chapter 2, Pipeline Hardware, Installation & Setup on page 5 before continuing.*

*Before you use a Pipeline to capture and play out media, the device must be configured using Pipeline Direct (Chapter 4, Using Pipeline Direct on page 35).*
Chapter 3
Implementing Pipeline & Installing Software

PIPELINE APPLICATION FEATURE COMPARISON

Pipeline software includes two applications, compared in Figure 3–1, below.

Pipeline Control. Pipeline Control is available for Mac OS X, and Windows XP and Vista Ultimate. Using Pipeline Control you can capture or play out media from/to Pipeline SC, Pipeline Quad, and Pipeline HD Dual on a pre-determined schedule. You can also use Pipeline Control for realtime capture, and log and capture operations – to capture and play out media from/to Pipeline SD and Pipeline Quad without requiring Final Cut Pro or Episode.

Pipeline Plugin for Final Cut Pro and Episode | Episode Pro. Pipeline Plugin for Final Cut Pro and Episode or Episode Pro desktop applications on Mac OS X, provides the same log and capture features available in Pipeline Control, directly in Final Cut Pro and Episode on Mac OS X.

Table 3–1. Feature comparison of Pipeline applications

<table>
<thead>
<tr>
<th>Pipeline Software Features</th>
<th>Pipeline Control (Windows)</th>
<th>Pipeline Control (Mac OS X)</th>
<th>Pipeline Plugin (Log/Capture)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supports Pipeline HD Dual</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Supports Pipeline SC and Pipeline Quad</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>24-hour recurring capture &amp; playout</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Log &amp; Capture with deck control</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Open directly from Final Cut Pro</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Open directly from Episode Desktop</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Edit while capturing</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Transcode while capturing</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>(FlipFactory/Episode Engine)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Pipeline EDL files</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Import/Export Final Cut Interchange files</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Create QuickTime MOV files directly</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create TIFO files directly</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Standard Definition Codecs</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standard and High Definition Codecs</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

WORKFLOW APPLICATION REQUIREMENTS

Pipeline applications can be used with these versions of FlipFactory, Final Cut Pro, and Episode:

- Episode Engine version 5.0 or greater
- Final Cut Pro Version 5.1.4 or newer
TYPICAL PIPELINE SYSTEMS AND CONSIDERATIONS

Video and Audio Preview Implications During Capture

The most CPU intensive operation during a Pipeline capture session is projecting video and audio preview streams. In most cases, previewing multiple streams when capturing standard definition media will not affect the overall performance of your Pipeline capture system. However, two or more high definition preview streams may cause excessive CPU load and prevent critical real-time media processes from being serviced in a timely manner, leading to data loss and integrity of the resulting media file. Telestream recommends that you view only one HD preview stream at a time on a multi-stream HD capture system.

Best Practices for Networking Pipelines

For best results, Pipeline devices should be connected directly to the Pipeline’s host system or through a single Ethernet switch, as shown in the graphic following, depicting two Pipeline Quads on a dedicated GigE LAN, for an 8-channel SD workflow, connected via a single switch. Multiple hops via routers and switches increases the risk that video frames will not be processed in a timely manner, resulting in lost frames. Special care must be taken to insure that real-time processes are executed in a timely manner.

Best practices suggest that you separate Pipeline network traffic from other traffic by using a second, dedicated network adapter. Design your system with one (or more) Ethernet ports dedicated to the incoming Pipeline streams and with separate Ethernet port(s) for general data and media storage traffic.

Figure 3–1. Best practices – isolated GigE LAN, dedicated Ethernet port, and a single switch.

Other network processes, such as file copying, can consume significant bandwidth and excessive network stack cycles, causing Pipeline streams to be interrupted. When implementing a Pipeline system on an existing general-purpose network, be aware of processes using the network that may affect Pipeline traffic.

As a rule of thumb, you should not exceed 50% usage of any single Ethernet port. For example, when capturing Pro Res 422 HQ at 220Mbps, use one GigE Ethernet port on your host computer for every two media streams, as depicting in the following graphic, where two Pipeline HD devices are connected to the
host, each on a dedicated host port, to support 2 media streams each. Multiple port Ethernet cards, such as those from Small Tree Communications, are ideal for this purpose.

**Figure 3–2. Best practices – for each 2 capture streams, use one Ethernet port.**

---

**Storage Requirements for Typical Workflows**

When determining your storage requirements, there are two main factors to consider – the overall sustained read/write performance required, and if local data buffering is required.

To evaluate your requirements, first consider the data rate for the format that you'll be encoding and the number of concurrent streams the system is expected to capture. *Network and Hard Disk Performance Requirements (page 29)* provides approximate data rates for a variety of formats and resolutions. Use this information to calculate the overall read/write performance requirements for your main storage system and, if needed, for disk buffer storage (*Disk Buffering Details on page 27*). To enable disk buffering, see *Use Disk Buffering on page 119* (Mac OS X) or *Use Disk Buffering on page 123* (Windows).

**Capture-only Workflows**

For capture-only workflows, when writing to internal or direct attached (non-shared) RAID arrays, you only need to calculate the overall write speed requirements. Configure your media storage array based on the write performance required for the number of streams being captured.

**Figure 3–3. Configuration for capturing 4 HD streams onto Fibre-attached storage.**
Concurrent Edit/Transcode Workflows

For capture with concurrent edit or transcode workflows, calculate the total read/write speed requirements based on the write processes of Pipeline streams and read processes for edit and transcode operations.

---

**Note**

Disk buffering ([Use Disk Buffering on page 119 (Mac OS X)](#) or [Use Disk Buffering on page 123 (Windows)](#)) is required when the destination path is a located on a NAS, Shared Storage device, a shared network folder, or when edit/transcode while capture operations are to be performed on the incoming Pipeline media files.

---

To guarantee error-free operations you must use disk buffering. Use an internal or direct-attached non-shared RAID array that meets the read/write performance requirement ([Disk Buffering Details on page 27](#)).

Pipeline’s media storage location (NAS, direct-attached shared storage, or shared network folder) must also meet certain read/write performance requirements. When using NAS, direct-attached shared storage or shared network folder, be sure to verify that your system has the communications bandwidth for writing all Pipeline media data to the media storage location in real-time.

Capture Workflows Utilizing NAS|Direct-Attach Storage|Network Folders

For capture writing to NAS, direct-attached shared storage or shared network folder, you should enable Pipeline disk buffering ([Disk Buffering Details on page 27](#)).

---

**Note**

Disk buffering ([Use Disk Buffering on page 119 (Mac OS X)](#) or [Use Disk Buffering on page 123 (Windows)](#)) is required when the destination path is a located on a NAS, Shared Storage device, a shared network folder, or when edit/transcode while capture operations are to be performed on the incoming Pipeline media files.

---

Disk buffering requires a separate RAID array to guarantee error-free write operations of media streams.

**Figure 3–4. Configuration for capturing 4 HD streams onto NAS with Fibre-attached buffer space.**
When calculating disk buffer RAID array read/write performance requirements, you should use two times the required Pipeline streams write requirements. This is required to support a write and a read operation on the data buffer array for each Pipeline stream.

The Pipeline’s media storage location (NAS, direct-attached shared storage or shared network folder) must meet the write performance requirements. When using NAS, direct-attached shared storage or shared network folder, be sure to verify that your system has the communications bandwidth for writing all Pipeline media data to the media storage location in real-time.

**DISK REQUIREMENTS FOR MEDIA FILES**

Pipeline Control creates media files during log and capture, or when executing capture schedules. When using a schedule, clip events are created when a clip is ready to be captured. You can capture in QuickTime files and TIFO (Telestream Intermediary Format (TIFO) on page 58) files, and they increase in size as the media is ingested and written to disk. Conflicts and problems can occur if you don’t plan for disk requirements when capturing media.

If you have two or more schedules (either capture or playout) with the same storage location open in Pipeline Control and you activate both of them, the second schedule displays a store conflict error. You must select a different storage location before you can activate it. This doesn’t prevent you from creating a store conflict by using the same storage location in two different instances of Pipeline Control on the same (or different) computer. This situation should be avoided, because it may result in file name conflicts.

When you activate a Capture schedule, Pipeline Control checks on the space requirements based on the clip events in the schedule. Telestream recommends that when you create a new schedule, you determine that the selected store has adequate available space.

---

**Note**

*If Pipeline Control crashes during capture and you are using disk buffering, on Mac OS X you should reboot to delete temporary media files that may be stored in the standard Unix temporary directory (default: /tmp).*

*On Windows, empty your disk buffering directory (default: <boot disk>:\Documents and Settings\<current user>\Local Settings\Temp).*

---

**Media File Creation is Disk-Intensive.** File capacity and write speed requirements are based on how many clips you store, how many clips you capture at one time, and how large each file is. For example, if you create a schedule to capture 24 half-hour DV files at 25Mbps, storage requirements exceed 300GB in a 24-hour period.

Make sure that your disk, RAID, or SAN write speed is capable of saving media fast enough to avoid lost frames, and that your computer, Xsan or network store has available space before running production schedules. (See Platform and System Requirements on page 29).
DISK BUFFERING DETAILS

When Disk Buffering is checked, (Use Disk Buffering on page 119 (Mac OS X) or Use Disk Buffering on page 123 (Windows)) video and audio data are written into a FIFO disk buffer file in a local folder before the data is written to the media file destination.

Note

Disk Buffering must be enabled when the destination path is a located on a NAS, Shared Storage device, a shared network folder, or when edit/transcode while capture operations are to be performed on the incoming Pipeline media files.

During capture operations, when the file destination drive’s performance is reduced due to additional read processes (when performing transcoding, file editing or other disk-intensive activity), data is placed into the FIFO (First In, First Out) buffer.

Figure 3–5. FIFO disk buffering enhances file writing performance

These FIFO buffer files are elastic and grow as needed when write performance is temporarily reduced on the media file destination disk drive. Disk buffering prevents the RAM buffer from being overwritten when disk writes are temporarily blocked or performance is reduced on the media file destination disk.

The read/write performance for a volume used for disk buffering needs to be able to support the media format and number of channels being captured. As a rule of thumb, the buffer disk should be RAID-0 with the appropriate number of drives to support the read and write requirements for the number of channels with the respective media format used (Network and Hard Disk Performance Requirements (page 29)).

Note

The disk selected for buffering should be used exclusively for Pipeline video/audio data buffering. Using the disk buffer drive for other read/write processes may cause unpredictable results.
Enable Disk Buffering when your media file destination is not a local drive or array – such as a NAS, SAN, or shared network folder, and your workflow requires transcoding or editing of the media files while they are being captured.

**Figure 3–6. Pipeline buffering process**

The disk selected for buffering should be used exclusively for Pipeline video/audio data buffering. Using the disk buffer drive for other read/write processes may cause unpredictable results.

Never write to a disk buffer that does not meet the minimum performance requirement for the number of channels and media format being captured. See Network and Hard Disk Performance Requirements (page 29).

The disk buffering drive must never be the same as the media file destination drive. This will result in doubling the amount of read and write operations to this drive and will severely degrade overall disk performance.

When schedule events are touching (one file stops and the other starts at the same moment) and there is a handle setting of more than zero, the amount of data being processed and written to disk doubles for the duration of the handle.

Double capturing may result in data loss in workflows on slow computers, or in workflows with multiple simultaneous ingests, since the application may be pushing the limits of CPU capacity or disk write speed.
PLATFORM AND SYSTEM REQUIREMENTS

General Pipeline Host System Requirements

- CPU: Intel Core 2 Duo, Intel Quad Core, or greater
- Operating System:
  - Mac OS X Version 10.5 (Leopard) or newer (Mac OS X 10.4 – Tiger or earlier is not supported)
  - Windows XP Pro with Service Pack 2 or later, and Windows Vista Ultimate.
- Video card with OpenGL support for video preview on Mac OS X
- GigE or faster Ethernet adapter
- QuickTime Version 7.5.5 or newer with ProRes decoder component
- Final Cut Pro Version 5.0.1 or newer is required when using Pipeline plug-in

System Requirements for FlipFactory Pipeline Workflows

FlipFactory supports workflows utilizing Pipeline SD systems.

- FlipFactory v6.0 with Update Packs 1-5 or FlipFactory v6.1
- Concurrent Pipeline ingest streams may vary depending on CPU and disk speeds
- Recommended server spec:
  - Dual 2.3Ghz (or higher) Intel Quad Core CPU
  - Dedicated RAID-0 media storage
  - 2GB RAM
  - Bonjour for Windows

NETWORK AND HARD DISK PERFORMANCE REQUIREMENTS

Network and disk speed requirements by media format, per stream:

- Uncompressed 8-bit 4:2:2 (NTSC/PAL) - Network throughput 175Mbps; disk write speed 22MB/sec
- DV/DVCPro – Network throughput 35Mb/sec; disk write speed 4.4mb/sec
- IMX30 – Network throughput 43Mb/sec; disk write speed 5.3mb/sec
- IMX40 – Network throughput 56Mb/sec; disk write speed 7.0mb/sec
- IMX50/MPEG2 – Network throughput 67Mb/sec; disk write speed 8.3mb/sec
- ProRes 422 SQ (SD) – Network throughput 58Mb/sec; disk write speed 7.3mb/sec
- ProRes422 SQ (HD) - Network throughput 160Mbps; disk write speed 20MB/s
- ProRes422 HQ (HD) – Network throughput 240Mbps; disk write speed 30MB/s
- DNxHD 145 – Network throughput 160Mbps; disk write speed 20MB/s
- DNxHD 220 – Network throughput 240Mbps; disk write speed 30MB/s
- DVCProHD – Network throughput 135Mbps; disk write speed 16.5MB/s
Suggested Hardware Configurations for SD Ingest Processing

Each system should have media storage (internal or directly attached to the host system) with adequate storage to support 24 hours of captured media in the selected format. The media drive must be separate from the OS drive, and meet the specified minimum requirements. For edit-during-ingest and transcode-during-ingest workflows, increased I/O performance is required to support the additional read processes, and may require disk buffer cache drive system (see Pipeline User Guide disk buffering details).

Viewing HD preview streams causes high level CPU consumption, which may cause dropped frames. Telestream recommends that you turn off preview during HD capture operations.

Single Channel System
- Intel Dual Core 2.00Ghz CPU, 2GB RAM, SATA 1.5GBs 7200 RPM media storage drive

Dual Channel System
- Intel Dual Core 2.0Ghz CPU, 2GB RAM, min. 2 drive RAID-0 SATA 1.5GBs 7200 RPM media storage partition

Four Channel System
- Intel Quad Core (4 core) 2.33Ghz CPU, 4GB RAM, min. 3 drive RAID-0 SATA 1.5GBs 7200 RPM media storage partition

Eight Channel System
- Intel Dual Quad Core (8 cores) 2.33Ghz CPU, 6GB RAM, min. 4 drive RAID-0 SATA 3GBs 7200 RPM media storage partition

Suggested Hardware Configurations for HD Ingest Processing

Each system should have media storage local to the host system, with adequate storage to support 24 hours of captured media in the selected format. The media drive must be separate from the OS drive, and meet the specified minimum requirements. For edit-during-ingest and transcode-during-ingest workflows an additional disk buffer cache drive system is required.

Single Channel System
- Intel Dual Core 2.6Ghz CPU, 2GB RAM, min. 2 drive RAID-0 SATA 7200 RPM media storage partition

Dual Channel System
- Intel Quad Core (4 cores) 3.0Ghz CPU, 6GB RAM, min. 4 drive RAID-0 SATA 1.5GBs 7200 RPM media storage partition

Four Channel System
- Intel Dual Quad Core (8 cores) 3.0Ghz CPU, 8GB RAM, min. 8 drive RAID-0 SATA 1.5GBs 7200 RPM media storage partition
INSTALLING PIPELINE SOFTWARE ON MAC OS X

Pipeline for Mac OS X consists of:

• Pipeline Plugin for Final Cut Pro and Episode | Episode Pro
• Pipeline Control

All components are installed, so that you can use the components as you want.

Pipeline Software for Mac OS X is distributed via the Web as a disk image file, and is also distributed on the Pipeline CD as an installer package file.

When you download or open the Pipeline Software for Mac OS X dmg file with Safari, Mac OS X automatically mounts the disk image (if necessary) and runs the installer. If you download a dmg file using another Web browser, mount the file. Then, double-click it to run the installer.

You'll be asked for an administrator name & password during installation. If you don't have an administrative account, you’ll need to obtain one in order to perform installation. You must restart Final Cut Pro and Episode for the Pipeline plugin to work correctly.

UPGRADING PIPELINE SOFTWARE ON MAC OS X

Pipeline software upgrades are periodically posted on Telestream’s Web site at www.telestream.net. On the Telestream site, click Support > Support Home, then select Pipeline under the Pipeline section – Pipeline software updates are displayed in the left column.

Make sure that Final Cut Pro and Episode are not running before upgrading your software.

Follow the instructions in Installing Pipeline Software on Mac OS X (above) to upgrade your software.

REMOVING PIPELINE SOFTWARE FROM MAC OS X

To uninstall Pipeline software, remove the following files and restart your computer:

/Applications/Pipeline
/Library/Application Support/Final Cut Pro System Support/Plugins/Pipeline Plugin.bundle
/Library/Application Support/Pipeline/PlugIns/Copy File.plugin
/Library/Application Support/Pipeline/PlugIns/EpisodeEngine.plugin
/Library/Application Support/Pipeline/PlugIns/Final Cut Pro.plugin
/Library/Application Support/Pipeline/PlugIns/FlipFactory.plugin
/Library/Application Support/Pipeline/PlugIns/Instant Message.plugin
/Library/QuickTime/Pipeline.component
/Library/QuickTime/TIFO.component
/Library/QuickTime/Telestream IMX.component

Note

You can set up the Pipeline plugin to check for upgrades periodically. Go to Preferences and click the Upgrade tab to check for upgrades immediately, and determine how often you want to check for upgrades on a regular basis.

When you open schedules created in previous versions, you may need to reset the audio and video settings before using them.

Make sure that Final Cut Pro and Episode are not running before upgrading your software.

Follow the instructions in Installing Pipeline Software on Mac OS X (above) to upgrade your software.
Removing Pipeline does not remove any schedules or log and capture documents you’ve created, or any media you’ve saved on this computer.

**INSTALLING PIPELINE SOFTWARE ON WINDOWS**

Pipeline Control for Windows is distributed from Telestream’s Web site (www.telestream.net) as an MSI file, and is also distributed on the Pipeline CD. After verifying that you have all of the required subsystems (below), download or open the Pipeline Software for Windows installer and run it. Follow the steps to install Pipeline Control for Windows.

**Pre-requisite Subsystems**

These software subsystems are required before installing Pipeline software on Windows computers:

**QuickTime**

Pipeline Control requires QuickTime 7.5.5 or later. If you need to install or update your QuickTime software, stop the Pipeline installation process. Install the new version of QuickTime from Apple’s Web site (apple.com). Then, re-start the Pipeline Software installer.

**Avid DnxHD Codec**


Extract the zip file to the desktop. Run AvidCodecsLE_1.8<or current version > PC\AvidCodecsLE_Install\disk1 SETUP.EXE and follow the instructions to install the DnxHD codec.

**Bonjour for Windows**

Pipeline Control requires Bonjour for Windows. To install/update Bonjour, stop Pipeline installation. Obtain Bonjour for Windows from Apple’s Web site (apple.com). Then, re-start the Pipeline Software installer.

**.Net Framework 3.5**

Pipeline Control for Windows requires .Net Framework 3.5. If you need to install or update your version of .Net, stop the Pipeline installation process. Install or update .Net from Microsoft’s Web site (microsoft.com). Then, re-start the Pipeline Software installer.

**UPGRADING PIPELINE SOFTWARE ON WINDOWS**

Pipeline software upgrades are periodically posted on the Flip4Mac Web site at www.telestream.net. On the Telestream site, click Support > Support Home, then select Pipeline under the Pipeline section – Pipeline software updates are displayed in the left column.

Before running the installer, be sure to remove the previous version of Pipeline, using Add/Remove Programs in Control Panels. Then, follow the instructions in Installing Pipeline Software on Windows (above) to upgrade your Pipeline software.
REMOVING PIPELINE SOFTWARE ON WINDOWS

To uninstall Pipeline Control, display Control Panel > Add/Remove programs. Select Pipeline and click Remove. Removing the Pipeline application does not remove any schedules you've made, or any media you've saved on this computer.
Pipeline Direct is a Web application embedded in each Pipeline, which enables you to connect to Pipelines on your network with a Web browser.

You can use Pipeline Direct to perform administrative tasks on the Pipeline, including network configuration and firmware upgrades. With an attached VTR, you can also use Pipeline Direct to create EDL files from streaming media for submitting jobs to FlipFactory. Additionally, you can use Pipeline Direct to crash record SD media and save it as a TIFO file (Capturing SD Media to a TIFO File (page 53)) for processing with FlipFactory or Episode | Episode Pro, or for conversion to QuickTime.

Topics
- Supported Web Browsers (page 36)
- Browser Settings for Pipeline Direct (page 36)
- Launching Pipeline Direct (page 36)
- Pipeline Direct Panels (page 38)
- Using the About Panel (page 39)
- Using the Configure Panel (page 40)
- Using the Quad Panel (page 44)
- Using the Counters Panel (page 47)
- Using the Live Panel (page 49)
- Live Panel Components (page 50)
- Capturing SD Media to a TIFO File (page 53)
- Using the Upgrade Panel (page 55)
**SUPPORTED WEB BROWSERS**

You can use Pipeline Direct in the following browsers:

- Internet Explorer 6 or later on Windows (QuickTime is not required). Video preview utilizes an Active-X control which supports audio preview. May require security settings adjustments to install correctly.
- Safari Version 2 or 3 on Mac OS X with QuickTime 7.0.4 or later – no support for audio preview
- Firefox Version 2 or later on Windows and Mac OS X – with QuickTime 7.0.4 or later for Mac OS X, or QuickTime 7.2 or later for Windows – no support for audio preview.

---

**Note**

*Web browsers are supported only on the platform specified. You may encounter situations where features may function correctly in all cases.*

---

You can run Pipeline Direct from anywhere on your network. You can run it directly on a FlipFactory server, and save EDL and TIFO files locally in the target directory for the EDL monitor. You can also run Pipeline Direct on other computers, and save files locally, then copy them to the target directory via Windows networking, or save them via Windows networking directly into the target directory.

**Browser Settings for Pipeline Direct**

To ensure that you can connect and use the Pipeline Direct application in Pipeline, make sure that Internet Explorer security settings are set as follows (enable similar functionality in Safari and Firefox so that you run signed Active-X controls and download files (for EDL and TIFO files)):

- Add Pipelines to your Trusted Intranet sites.
  
  Click Tools > Internet Options. On the Security tab, click Trusted Sites. Then, click the Sites button and add `http://<IP address>` (http://169.254.1.200, for example) for each Pipeline. Make sure that you have unchecked the Require Server Verification option, because that requires an HTTPS connection and Pipeline communicates via HTTP. Click OK to close the dialog and continue.

- Click Default Level and drag the selector to Low. Click OK to update and close the Setting dialog.
  
  This setting enables Active-X Controls and plug-ins, automatic prompting for file downloads, and scripting of Java applets, which may also be set individually.

**LAUNCHING PIPELINE DIRECT**

To connect to a Pipeline and launch Pipeline Direct, follow these steps (if you’ve assigned a password to the Pipeline, you’ll need to authenticate before you can connect – no password is required by default):

1. Launch your Web browser. (Bonjour is not supported in Firefox – connect using the IP address instead – skip to step 3.)
2. To connect using Bonjour, connect via:

   **Internet Explorer (Windows).** Open Internet Explorer and select View > Explorer Bar > Bonjour (or click the Bonjour icon in the toolbar) to display the Bonjour panel on the left, and double-click the Pipeline in the panel to log on and display Pipeline Direct.
Safari (Mac OS X). Open Safari and select Bookmarks > Show All Bookmarks. In the Collections panel, click Bonjour. Select the Pipeline (under Web pages) from the list, to log on and display Pipeline Direct.

**Figure 4–1. Bonjour panel displays Pipelines on your LAN**

3. To connect using the IP address, enter the IP address of the Pipeline in the URL field – `http://209.254.12.254`, for example – and press Enter to display Pipeline Direct:

4. The first time you connect to this Pipeline since starting the browser, if the Pipeline is password-protected (configure panel > Security), the browser displays a Pipeline Authentication dialog:

**Figure 4–2. Connect dialog – enter your username and password to connect**

5. Enter the username (always `administrator`) and password if you added one, to connect to the Pipeline and display Pipeline Direct.

**Note**

The first time you connect to a Pipeline, a Pipeline Active-X control must be installed. Depending on your settings, you may or may not be required to OK this installation.
Whenever you connect to a Pipeline and display Pipeline Direct, the Live panel displays by default.

**Pipeline Direct Panels**

Pipeline Direct has several panels you can use to perform various tasks:

1. **About** – provides general information about Pipeline, and registration.
2. **Configure** – displays Pipeline and network settings, allows you to change network settings and options.
3. **Counters** – displays statistical information about Pipeline.
4. **Live** – displays streaming media, provides VTR control, and enables you to create EDLs for submitting media to FlipFactory for transcoding.
5. **Upgrade** – allows you to select an upgrade file (a `firmware-xxxxx.pln` file where `xxxxx` is the version number), and upgrade the firmware and Pipeline Direct in your Pipeline.

You can access to the Pipeline User’s Guide (the document you are currently reading) from each panel by clicking the User’s Guide link at the bottom of each panel.
USING THE ABOUT PANEL

To display the About panel, click about in the menubar at the top of the window:

Figure 4–4. The About panel displays a link to product registration.

Register the Pipeline by clicking the Register button. Follow the steps on the Web page to complete registration. If you’ve already registered this Pipeline, the Register button no longer displays.

If the computer you’re using is on a LAN without Internet access, use a computer that has Internet access and go to dynamic.telestream.net/pipeline-register/register.asp to register your Pipeline. You should register your Pipeline to ensure ongoing warranty service and customer support.

The About panel – as well as the other panels – provides online access to the Pipeline User’s Guide (this document), by clicking the link in the lower left corner.
**Using the Configure Panel**

To display the Configure panel, click **configure** in the menubar at the top of the window:

*Figure 4–5. Configure panel displays details & allows you to change settings*

Use the Configure panel to view and make changes to Pipeline’s identity, IP settings, and options. Click Network, Security, and Options to view their controls. Each control is described in the following table.
Table 4–1. Configure Panel controls and descriptions.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pipeline Identity</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Editable field. Default for Pipeline SC: Pipeline-&lt;XXXX&gt;, where XXXX is the serial number printed on the bottom of the Pipeline. Default for Pipeline Quad: PipelineQuadXXXX_N where N is the device number 1 through 4. To change the name, enter a new name, and click Save Changes. The name is updated in the Pipeline, and is reflected in the Bonjour panel. Limit: 255 characters. If you enter a friendly name that already exists, Pipeline adds (1), (2), as necessary to maintain uniqueness. For best naming practices, you should identify the Pipeline model (SC or Quad), uniquely name it, and, in the case of the Quad, refer to the channel number. For example, PipelineQuad_Prod7_Channel2.</td>
</tr>
<tr>
<td>App (firmware version)</td>
<td>This displays the Pipeline’s firmware version number, composed of &lt;Major Version&gt;,&lt;Minor Version&gt;&lt;Build Number&gt;,&lt;Channel Number Identifier&gt;. For example: 1.5,33165,00 indicates Version 1.5, Build 33165, channel 0. On Pipeline SC, the channel number ID is always 0. Upgrades are identified by major version and minor version numbers: 1.5, for example.</td>
</tr>
<tr>
<td>Loader (version)</td>
<td>This displays the Pipeline’s boot loader version number, also composed of &lt;Major Version&gt;,&lt;Minor Version&gt;&lt;Build Number&gt;,&lt;Channel Number Identifier&gt;.</td>
</tr>
<tr>
<td>CPLD Version</td>
<td>CPLD chip version number on the Pipeline, for Telestream use.</td>
</tr>
<tr>
<td>FPGA</td>
<td>FPGA chip version number on the Pipeline, for Telestream use.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Four digit serial number of the device, not changeable.</td>
</tr>
<tr>
<td><strong>Network</strong></td>
<td></td>
</tr>
<tr>
<td>Self-Assigned</td>
<td>Select to utilize the default link-local IP address, generated based on the Pipeline’s serial number; incremented on Pipeline 2, 3, and 4 on Quad.</td>
</tr>
<tr>
<td>DHCP</td>
<td>Select when you want your DHCP server to assign an IP address.</td>
</tr>
<tr>
<td>Static</td>
<td>Select to use the IP address, subnet mask, &amp; gateway, entered manually.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Enter the IP address assigned by your network administrator.</td>
</tr>
<tr>
<td>Mask</td>
<td>Enter the subnet mask assigned by your network administrator.</td>
</tr>
<tr>
<td>Gateway</td>
<td>Enter the gateway address provided by your network administrator.</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Editable field. No password is assigned by default. (Username is always administrator.) Limited to 15 characters; standard HTTP password rules apply. May be empty to disable authentication.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Editable field. Enter second time to confirm.</td>
</tr>
<tr>
<td><strong>Control</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Pipeline detects the video standard of the incoming SDI signal on startup. If no signal is present during startup, by default, the Pipeline generates color bars or black in NTSC format. When this option is checked, Pipeline generates color bars or black in PAL format. When an SDI signal becomes present the Pipeline switches its internal signal generation to the standard of the incoming video.</td>
</tr>
<tr>
<td>Default to PAL if SDI not present on startup</td>
<td>Pipeline generates a test pattern when no SDI input signal is present. If this option is checked the generated test pattern is a black frame, otherwise the generated test pattern is color bars. The pattern is generated in NTSC or PAL, based on the mode it is in. The last valid SDI signal sets the mode.</td>
</tr>
<tr>
<td>Default to black if SDI not present</td>
<td>When checked, Pipeline Direct always displays the Live panel when it connects. If unchecked, the Configure panel displays.</td>
</tr>
<tr>
<td>Default to live panel on startup</td>
<td>When checked, streaming media is stopped after 10 minutes of inactivity. If unchecked, the live panel remains connected as long as the Live panel detects end user interaction. While the Live panel is connected, other processes can not connect to the Pipeline. For example, a FlipFactory EDL monitor can not connect to process the EDL it has received.</td>
</tr>
<tr>
<td>Disconnect live panel after 10 minutes</td>
<td>Unchecked by default, to insure capture quality. Check when you don’t want Pipeline to report missing or partial frames in input stream during capture. This is useful if, for example, you’re capturing from a satellite feed where these types of errors occur more frequently, and you do not want Pipeline to report the error to the Pipeline Final Cut Pro plugin, because it will abort the capture.</td>
</tr>
<tr>
<td>Ignore input discontinuities</td>
<td>Prevents input SDI from being present on the output SDI during capture.</td>
</tr>
<tr>
<td>Disable loopback</td>
<td>When checked, during encoding, Pipeline constructs a frame by using a field pair consisting of an F2 field followed temporally by an F1 field. This is in contrast to normal operation, which constructs a frame using a field pair consisting of an F1 field followed temporally by an F2 field.</td>
</tr>
<tr>
<td>Assume F2 dominant input</td>
<td>When checked, Pipeline overlays the timecode it is using as its primary clock on the video image.</td>
</tr>
<tr>
<td>Burn in Timecode</td>
<td>When checked, Pipeline strips each frame of VBI data, before passing it to the encoder for compression.</td>
</tr>
<tr>
<td>Remove VBI data before compression</td>
<td></td>
</tr>
</tbody>
</table>
### Control

#### Timecode

<table>
<thead>
<tr>
<th>Description</th>
<th>Timecode Sources (select one)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Auto, RS422, SDI, Channel 1 (Pipeline Quad only) or SNTP. In Auto mode, Pipeline selects the time code source by priority (Pipeline SC — auto mode clock source options and Pipeline Quad and HD Dual— auto mode clock source options on page 105). For Pipeline Quad channels 2, 3, and 4, you can select Channel 1 as the source. Channel 1 itself must be set to an external source. <strong>Note:</strong> Auto selection is ignored by the Pipeline Control application, whose schedule settings override those of the selected Pipeline.</td>
<td></td>
</tr>
</tbody>
</table>

#### SNTP Server

- When SNTP is selected as a time code source, edit field for entry of SNTP server IP address.

#### Buttons

- If another user is connected and processing media with this Pipeline, using these buttons will interrupt the process, and it must be re-started.

- **Save Changes**
  - Click to update the Pipeline with the new settings. If you change the IP address (by any means – returning to self-assigned, enabling DHCP, or assigning a static address), in about 30 seconds, Pipeline Direct displays an error: “Unable to communicate with Pipeline”. Click OK, then reconnect to the Pipeline using the new IP address.

- **Default**
  - Return settings to default.

- **Reboot**
  - This reboot performs a hardware-level reset, which disconnects Pipeline from any client which may attached without warning. Click to reboot the Pipeline if you change the password, to log on using the new password. You do not need to reboot when changing IP settings.

- **Soft Reboot**
  - This reboot resets the Pipeline without disconnecting from an attached client. In cases where the Pipeline is non-responsive, click Software Reboot to clear the problem and continue. However, performing a soft reboot during streaming will interrupt the stream.
**USING THE QUAD PANEL**

The Quad panel only displays when Pipeline Direct is connected to one of the Pipeline channels on a Pipeline Quad. When you’re connected to a Pipeline SC, this page is not available.

To display the Quad panel, click **quad** in the menubar at the top of the window:

*Figure 4–6. Quad panel controls confidence monitoring*

Use the Quad panel to set up confidence monitoring.
### Table 4–2. Configure Panel controls and descriptions.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Confidence Monitoring</strong></td>
<td></td>
</tr>
<tr>
<td>Normal Operation – no monitoring</td>
<td>Check to disable confidence monitoring. When confidence monitoring is disabled, channel 4 (Pipeline 4 on the Quad) operates normally, and can be used for capture/playout operations.</td>
</tr>
<tr>
<td></td>
<td><em>Note: This option is only enabled when you log on to channel 4. You cannot make this change from other channels.</em></td>
</tr>
<tr>
<td>Monitor channel 1</td>
<td>2</td>
</tr>
</tbody>
</table>

### Confidence Monitoring

Confidence monitoring is the process of employing channel 4 on the Pipeline Quad to sniff the exact same video packets being captured from any of the other Pipeline channels on the Quad and processed by the client application during a capture operation (or crash recording), for the purpose of verifying that the output is a true representation of the input, or that the output meets certain quality limits or other metrics.

Confidence monitoring can be enabled when you are performing a capture operation or crash recording from channels 1, 2, or 3 on a Pipeline Quad. When enabled, Pipeline 4 is also dedicated to the capture operation for the duration of the capture operation.

**Figure 4–7. Confidence monitoring is performed by Pipeline 4 via internal Ethernet bridge**

As SDI is being fed into the capture channel’s SDI In port, it is encoded and sent out in TCP packets on the Ethernet port to the client application (Pipeline Direct, FlipFactory, Episode, Final Cut Pro, and other media systems). Unlike other confidence monitoring that just re-encodes the media directly in the same device, the channel 4 Pipeline sniffs the very same packets on the Ethernet just as the client does; it then decodes the Ethernet input, and outputs the resulting SDI on its own SDI Out port.
Operators can attach monitors and vector scopes to the SDI out to view and measure the actual media in a full-circle operation, confident that they are testing and viewing exactly the same input as the client system is receiving.

---

**Note**

To enable confidence monitoring, you must log on to channel 4 to display the enabled confidence monitoring option on the Quad panel. Channel 4 must be idle before you can enable confidence monitoring. You can confidence monitor both capture operations and crash recording operations.

---

When confidence monitoring is enabled and the preview media stream from the channel selected is being consumed by Pipeline Direct or in the FlipFactory console, the confidence monitor (channel 4 SDI Out) displays a black frame.

If the monitored channel's stream is DV, DVCPro, IMX or MPEG-2, then the confidence monitor displays the full frame video as it is encoded.

If the monitored channel is not streaming media on the Ethernet, then the confidence monitor displays a banner on the image. The frame background is either the last frame of the previous stream or black.

**Figure 4–8. Confidence monitor displays banner when no media stream**
USING THE COUNTERS PANEL

To display the Counters panel, click **counters** in the menubar at the top of the window:

**Figure 4–9. Counters panel displays various processing values**

Use the Counters panel to view various values related to encoding and decoding to determine if operations are normal, or there are failures that must be corrected. These values are reset each time a new RTSP connection is made. This information may also be utilized when you are working with Telestream Customer Service to resolve an issue.

**Table 4–3. Counters Panel controls and descriptions.**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frames</td>
<td>The number of frames processed during this RTSP session.</td>
</tr>
<tr>
<td>Process</td>
<td>The number of frames dropped because of excessive CPU load. If this number is greater than zero, you're losing frames and quality. Determine the cause of the error and reprocess the media.</td>
</tr>
<tr>
<td>Video Sent</td>
<td>Number of video frames sent over RTP connection during an capture operation. Note: in TIFO mode, the Video Sent value counts both the video and audio frames sent, multiplexed over the same RTP connection.</td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Audio Sent</td>
<td>The number of audio frames sent during capture over RTP.</td>
</tr>
<tr>
<td>Status Sent</td>
<td>The number of status frames sent during capture over RTP.</td>
</tr>
<tr>
<td>Video Encode Time</td>
<td>Number of microseconds it took to process the current video frame.</td>
</tr>
<tr>
<td>Video Queue</td>
<td>The number of video frames dropped due to excessive network traffic. If this number is greater than zero, you’re losing frames and quality. Determine the cause of the error and reprocess the media</td>
</tr>
<tr>
<td>Audio Queue</td>
<td>The number of audio frames dropped due to excessive network traffic. If this number is greater than zero, you’re losing frames and quality. Determine the cause of the error and reprocess the media</td>
</tr>
<tr>
<td>Status Queue</td>
<td>The number of status frames dropped due to excessive network traffic.</td>
</tr>
<tr>
<td>Video Sequence</td>
<td>Count of frames where the timecode (as observed on the RS-422 connection) was not incrementally increasing.</td>
</tr>
<tr>
<td>Audio Align</td>
<td>Number of times the audio processor re-synchronized due to an Embedded SDI audio error.</td>
</tr>
<tr>
<td>Video Align</td>
<td>Number of times the video processor had to re-synchronize due to an SDI video error.</td>
</tr>
<tr>
<td>Video Frame Exceeded</td>
<td>CBR codec error counter.</td>
</tr>
<tr>
<td>Audio Frames Requested</td>
<td>During playout, Pipeline requests audio and video frames serially. This is the number of audio frames requested, and should be the same number as Audio Frames Received.</td>
</tr>
<tr>
<td>Audio Frames Received</td>
<td>Number of audio frames received during playout.</td>
</tr>
<tr>
<td>Video Frames Requested</td>
<td>Number of video frames requested during playout. Should be the same number as Video Frames Received</td>
</tr>
<tr>
<td>Video Frames Received</td>
<td>Number of video frames received during playout.</td>
</tr>
<tr>
<td>TCP retransmissions</td>
<td>Number of times TCP packets had to be retransmitted.</td>
</tr>
</tbody>
</table>
Using the Live Panel

To display the Live panel, click **live** in the menubar at the top of the window.

You'll spend most of your time here, especially when you're producing digital media with Pipeline for processing by applications including Final Cut Pro, FlipFactory, and others.

---

**Note**

You can only use the Live panel to capture SD media. If you want to capture HD media, you must use Pipeline clients, including Pipeline Control and FlipFactory.

When capturing or crash recording from channels 1 through 3 on a Pipeline Quad, you can perform confidence monitoring of the decoded SDI input to qualify your video. See Confidence Monitoring (page 45).

---

**Figure 4–10. Live panel allows you to control the VTR and create EDLs**

- **VTR/Pipeline Status Bar with 16 x 9 Preview check box**
- **Video Preview region**
- **Click to create an EDL file.**
- **Click to crash record or capture a single clips of SD media into a TIFO file.**
- **EDL Clip panel – where clips display each time you add one to the queue. Drag to re-arrange, drag up to the Pipeline graphic heading to remove it from the queue.**
- **Mark-in/Mark-out and VTR controls**
- **Metadata fields – enter data for this clip before adding it to the queue.**
- **Click to empty the EDL queue of all clips.**
- **After setting mark-in and mark-out points and adding metadata, click to add to list.**
You use the live panel (which displays when you first connect) to view video streaming from the connected Pipeline, control a VTR, create and save EDL files, or crash record live feeds or video being played out from a playback device such as a VTR or VCR.

Note

*Be sure to set your browser security settings to Low to use all features of this panel uninterrupted.*

Live Panel Components

The components include: status bar, video region, VTR controls, metadata editor, EDL panel, and buttons for various tasks.

VTR/Pipeline Status Bar

Right above the video panel is a VTR/Pipeline status bar. It provides equipment status information at a glance:

VTR Mode. **Local | Remote.** If a VTR is connected via RS422, displays the current mode of the VTR. In order to control the deck from the Live panel, the VTR must be in remote mode. When in local mode, the VTR controls are disabled. If the VTR is off or the RS422 cable disconnected, this status is not displayed.

Deck Status. **Deck On | Deck Off.** If a VTR is connected via RS422, advises whether the VTR is on or off.

SDI Status. **No SDI | SDI OK.** If No SDI displays, indicates that there is no signal on the Pipeline SDI input port or there is no cable attached to SDI input. When SDI OK displays, there is a valid SDI signal on SDI Input.

Timecode. The timecode reported from the VTR via the RS422 port. When the VTR reports drop-frame timecode, the second/frame separator is a semicolon. For example: 00:29:30;16 is a drop frame timecode. Non-drop frame notation applies a colon between the second and frame values.

16 x 9. Check when video is 16 x 9 format for proper video display. Any EDL produced with this option checked will also set the ANAMORPHIC flag to TRUE:

*TELESTREAM_METADATA: ANAMORPHIC TRUE*

This flag insures that anamorphic flags are set in appropriate output files in FlipFactory.

Video Preview Region

The video region displays streaming video when present, based on the status of your VTR controls, if active. If there is no SDI signal present, the preview region displays Bars and Tone or black (if Use Black is SDI Unplugged is checked in the Configure panel).

Note

*In Internet Explorer (unlike Safari and Firefox), an Active-X player control is used for video and video control. The control supports audio preview, and some security adjustments may be necessary to properly install it.*
VTR Controls

Start and End Timecodes. Timecodes that identify the mark-in and mark-out points on the current clip. Click \{ to set the start, or mark-in point. You can also set the start timecodes manually (HH:MM:SS:FF). Click \} to set the end, or mark-out point. You can also set the stop timecodes manually (HH:MM:SS:FF).

When the VTR reports drop-frame timecode, the second/frame separator is a semicolon. For example: 00:29:30;16 is a drop-frame timecode. Non-drop frame notation applies a colon between the second and frame values.

Use the VTR controls to adjust your timecode settings before setting them.

Duration. Timecode of the difference between the mark-in and mark-out values of the clip you just marked.

VTR Controls. Use the VTR controls to control video preview when a VTR is attached. These controls are disabled if the deck is off, the RS422 cable is disconnected, or the deck is in local mode. The scrubber bar, immediately below the VTR controls, displays when Pipeline is connected to a VTR deck with RS422 control in remote mode.

Figure 4–11. The virtual VTR panel allows you to control the VTR and create EDLs.

Shuttle. Use the shuttle to quickly play through the content at different speeds, in fast and slow motion. It also shifts the pitch of audio (Internet Explorer only) as it plays at varying speeds. In slow motion, this can make it easier to locate specific words and sounds for editing. Drag the slider to the right to fast-forward and to the left to rewind. Playback speed varies depending on the distance of the slider from the center of the control.

Clip Metadata. Enter text in these metadata fields for the current clip; stored with each clip and saved in the EDL for further processing. In Firefox and Internet Explorer, you can enter metadata information, and each time you create new mark-in/mark-out points and save the clip, the clip name increments by one.

Note

The default clip name is PipelineIngest_x. If you want the name to automatically increment, it must end in _.# (underscore pound).

The information is stored in a cookie, so it can be displayed in the metadata editor when you connect again.
Edit Decision List Panel

Clip List. Displays each of the clips that are currently in the EDL panel.

Figure 4–12. The EDL panel displays clips you’ve marked, but not saved

To re-arrange clips in the list, click and drag a clip to the new location. To delete a clip, drag it into the Pipeline heading at the top of the page.

Task Buttons

Create EDL. Click to create an EDL file from the clips in the list. Pipeline displays a File Open dialog: you can click Open to view the EDL details, but to save them you must cut and paste them into a text file outside the browser, because the edit decision list is erased. Click Save to save the list in a folder.

When you create an EDL file, Pipeline Direct disconnects the video, audio, and data streams, so that FlipFactory (or other applications) can connect and process the media under control of the EDL file.

When the EDL file is saved in a target directory monitored by the EDL monitor, FlipFactory processes the file and submits a job for each clip. Each job is processed by processing each clip entry to produce a stream from the selected encoder. FlipFactory transcodes the stream in real-time to produce output based on your factory’s product settings. For details, see Submitting Jobs Via an EDL Monitor on page 61.

Capture. Click to crash record live feeds or video played out from a playback device (a VTR or VCR). See Capturing SD Media to a TIFO File on page 53. (If you have clips in the list, Capture produces TIFO files for each clip.) When you click Capture to crash record, Pipeline Direct disconnects the media stream from the Pipeline so that the process can connect and process the media, saving it in the TIFO file.

Note

You should set your local intranet security settings to Low, to allow scripts to run and the browser to download files without intervention.
CAPTURING SD MEDIA TO A TIFO FILE

You can capture live standard definition feeds or video playing out from a playback device such as a VTR, by connecting your video into the Pipeline’s SDI In port. Pipeline encodes the media and transmits it in real time to your PC via the LAN, where it is saved directly into a TIFO file under control of Pipeline Direct.

Warning

Capturing TIFO files from Pipeline Direct is not intended for critical production workflows. Dependence on non-real time Browser applications can present unforeseen issues, and can cause a loss of data and a significant risk of failure during capture.

When you’re capturing media and no clips are in the clip list, you have control over the Pipeline via the VTR so that you can crash record the media playing out. When you capture media with a single clip is in the list, the clip is played out based on the mark-in and mark-out time codes. In each case, the media is saved in a TIFO file. When more than one clip is in the list, you can not use this method to capture media.

When you capture media, Pipeline encodes the SDI input and streams digital media to your computer via the LAN, which is encoded based on your current format selection in Pipeline Direct. The digital stream is written to a TIFO file (Telestream Intermediary Format (TIFO) on page 58) in real time.

TIFO files created by Pipeline can be used as source media in FlipFactory 6.0 (or later) and/or Episode 5.0 (or later) workflows for transcoding and delivery.

Connect and Select a Format

To capture streaming media connected to the SDI Input port on your Pipeline, follow these steps (this example utilizes Internet Explorer 6 and 7 – the experience in other browsers is similar):

1. Open your browser, log on to the Pipeline and display the Live panel.
2. Use VTR controls or queue your video source for preview (unless you’re capturing a single clip or crash recording). Make sure that the list is empty (or there’s a single entry if you want to capture it).
3. Now, hover over the Capture button in the EDL panel to display a format list.
4. Click the format you want to capture media in.

Save the File with the Pipeline File Download Manager

5. Right-click in the video preview region and make sure Use Download Manager is checked.
6. Click Capture in the EDL List panel to display the Pipeline Download Manager status information in the video preview region:

7. Click Start in the EDL List panel when you want to begin capturing media (Start changes to Stop).

8. Pipeline streams the media; Pipeline Direct saves it in the TIFO file. The file is saved in the directory selected in Pipeline Download Manager Preferences (below), with a default name. You can view transfer progress in the video preview region. During crash recording, you can also display the Pipeline Download Manager Preferences to view details.

9. When you want to stop capturing, click Stop (renamed from Start). Pipeline closes the TIFO file.

### Pipeline Download Manager Preferences

**Note**

*Telestream recommends using the Pipeline Download Manager. If you disable the Pipeline Download Manager, you'll use the download manager provided by your browser, and should know how it functions.*

10. To display Pipeline Download Manager Preferences, right-click in the video preview region and select Show Download Manager options.

**Download Folder.** Click Change to browse and select a download folder where all TIFO files will be saved during crash recording.

**File Table.** Displays a list of TIFO files that have been saved in this session, with details.
Using the Upgrade Panel

Pipeline is designed so its firmware and Pipeline Direct Web application can be upgraded easily when new revisions of Pipeline software are made available by Telestream. Pipeline Direct periodically attempts to communicate with the Telestream Web site to determine if upgrades are available, and notify you of the opportunity to upgrade Pipeline software.

Note

To determine the current version of your Pipeline, log on and display the Configure page. The version number is the value in the App field, which displays the firmware version number: <Major Version>,<Minor Version><Build Number><Internal Use>. For example: 1,1,33165,00 indicates Version 1.1, Build 33165.

If your Pipeline is blocked from the Internet or direct-connected to your computer, periodically check the Pipeline support page to determine if there is newer software. (Registered users are notified of upgrades via email.)

Pipeline firmware upgrades are periodically made available in the Pipeline section of the Telestream Web site at www.telestream.net.

You can also access the Pipeline software updates from www.telestream.net. On the site, click Support Home in the main menu at the top of the page, then select Pipeline downloads on the right side of the page. Pipeline firmware updates are displayed in the center column.

To upgrade a Pipeline, follow these steps:

1. Connect to the target Pipeline and determine the current firmware version via the Configure panel (Using the Configure Panel on page 40).

2. Log on to the Pipeline support page (http://www.telestream.net/support/support_pipeline.htm).
3. Download the Pipeline firmware file (firmware-xxxxx.pln) file to your computer.

Upgrade Steps
After downloading the firmware file, upgrade the firmware by following these steps:

1. Log on to the target Pipeline.
2. Select Upgrade from the menu to display the Upgrade panel.
3. Click Choose File to locate and select the firmware file (firmware.xxxxx.pln) you plan to use.
4. Click Upgrade and observe the progress bar and notes about the process.
   During a firmware upgrade, the front SDI In LED (on left) lights yellow during the upgrade process. When the Pipeline has been upgraded, Pipeline Direct reboots the Pipeline and displays a rebooting message on the Upgrade page. In about 15 to 30 seconds, both the In and Power LEDs light green. Pipeline Direct reconnects automatically and displays the Configure panel.

   **Note**
   The first time you display the live panel after upgrading, you may have to install the Pipeline Library.

5. When you display the live panel, Pipeline Direct may display an installation message in the preview panel: “Click here to install the following ActiveX control: Pipeline Library, from Telestream, Inc.” Click to install the activeX control, and click Install on the installer window.
You can use Pipeline with FlipFactory (version 6.0 or newer) to encode digital media streams from Pipeline for transcoding into media files of any supported format.

This chapter is written for professionals who understand how to use FlipFactory and configure factories to meet their transcoding requirements. For information about installing and configuring FlipFactory, and for creating factories and submitting jobs for processing, refer to the FlipFactory User’s Guide.

**Note**

*Telestream recommends that Pipeline Control be installed on a computer that is not hosting FlipFactory or other media processing applications: intense disk and CPU consumption can interfere with proper operation of both applications.*

*When capturing or crash recording from Pipeline Quad and Pipeline HD Dual, you can perform confidence monitoring of the decoded SDI input to qualify your video. See Confidence Monitoring (page 45).*

**Topics**

- FlipFactory Platform Requirements (page 58)
- Obtaining a Pipeline License (page 58)
- Telestream Intermediary Format (TIFO) (page 58)
- Pipeline Media Processing in FlipFactory (page 59)
- Pipeline | FlipFactory Workflows (page 60)
- Submitting Pipeline Media to FlipFactory (page 60)
- Submitting Jobs Via an EDL Monitor (page 61)
- Submitting Streaming Media from Pipeline (page 62)
- Using the Submit Job Window to Stream Pipeline Media (page 63)
- Pipeline Capture Editor (page 65)
- Submitting TIFO File Jobs (page 69)
- Checking Pipeline Job Status (page 69)
- Creating a Factory to Submit Jobs via EDL Monitors (page 71)
- Sample Workflows (page 72)
FLIPFACTORY PLATFORM REQUIREMENTS

When using FlipFactory with Pipeline, Telestream recommends that the Flip Server platform have hard drives/raids with a minimum sustained write speed of at least 60 mb/sec per session, when ingesting DV25, IMX 30/40/50, ProRes 422 SQ, or MPEG-2 50 mb/sec media, and 270mb/sec when ingesting HD content into ProRes 422, DNxHD and DVCProHD.

Because Pipeline can utilize real-time, streaming media (instead of file-based media transfer), the disk write speed is the gating factor in performance when ingesting media from Pipeline directly. Using disks with disk striping (RAID level 0) improves performance.

Depending on the write speed of your disk, you may encounter limits when ingesting more than one media stream concurrently in FlipFactory. If your write-access is too slow, you may not be able to process incoming media streams successfully (See “Network and Hard Disk Performance Requirements” on page 29.).

OBTAINING A PIPELINE LICENSE

A Pipeline license for FlipFactory is a no-charge option in FlipFactory 6.0 and later. If you purchased FlipFactory 6.0 in September, 2007 or later, your FlipFactory license already has a Pipeline license entry. However, if you add a Pipeline to a FlipFactory server purchased before September 2007, you need to obtain a Pipeline license before you can build a Pipeline factory or use Pipeline with FlipFactory.

Follow these steps:

1. Contact Telestream customer service at license@telestream.net, indicating that you are licensed user of FlipFactory and Pipeline and you want to obtain a Pipeline license for FlipFactory. Attach your current license to this email so they can update it for you and return it.

2. Telestream will email you an updated license, with update instructions for each FlipFactory server.

3. Restart the FlipEngine service or restart the FlipFactory server for the Pipeline license to take effect.

TELESTREAM INTERMEDIARY FORMAT (TIFO)

Telestream Intermediary Format (TIFO) is an intermediate media wrapper format designed by Telestream as a uniform, interchangeable file format to ensure interoperability among Telestream’s media processing solutions, including FlipFactory, Episode, and Pipeline. TIFO provides a lightweight, low-overhead wrapper that is essence-agnostic, with metadata, timecode, and closed caption support.

Using TIFO improves the ability to move media files between Telestream’s media processing solutions with all media essence elements and metadata intact, preserving the widest range of transcoding options.
PIPELINE MEDIA PROCESSING IN FLIPFACTORY

When you configure a factory to transcode media from a Pipeline, the factory can produce a TIFO file (by adding a Duplicate Original product in the factory) and one additional product of any other type (a Windows Media or QuickTime product in the factory, for example) in a single pass.

You can produce two products in a single pass, provided that one of the products is a Duplicate Original, which produces a TIFO file when the ingested media is streamed from a Pipeline. For this reason, Telestream recommends producing a TIFO file if you need to produce more than one other file, because it will require only a single streaming pass of the media.

You can not produce two products in a single pass of the streaming media from the Pipeline unless one of the products is a Duplicate Original. Producing two products, neither of which is a Duplicate Original TIFO file, results in two passes of the media – it requires a single pass of the file for each product.

After producing a TIFO file from a Pipeline using a Duplicate Original factory, you can automatically forward the TIFO file to a second factory which you configure to produce as many products as necessary for your workflow. Or, you can manually submit a TIFO file at any time for transcoding in factories you create to meet your workflow requirements.
PISTLINE | FLIPFACTORY WORKFLOWS

FlipFactory can ingest digital media in real time from a Pipeline by using its EDL monitor, which controls the attached VTR to produce video clips based on clip specifications in the EDL you submitted to FlipFactory.

Figure 5–1. FlipFactory integrates with Pipeline to produce media from baseband sources.

For each clip in the EDL, FlipFactory processes the media stream into a digital media file of the same essence, wrapped as a TIFO file for further transcoding in second-stage factories. During the initial TIFO file job, one additional transcode process can take place, producing a second media file.

Additionally, FlipFactory can ingest TIFO files in the same manner as other media, or you can crash record directly from the Pipeline into a TIFO file. Sample workflows are detailed in Sample Workflows (page 72).

SUBMITTING PIPELINE MEDIA TO FLIPFACTORY

You can submit Pipeline media to FlipFactory for processing in three ways. Your choice depends on your workflow requirements and the FlipFactory version you’re using:

- Submit jobs via an EDL Monitor
- Submit streaming media in real time using the Pipeline Capture Editor
- Submit TIFO files (created via Pipeline Direct) manually or via monitor.

When submitting media via an EDL monitor, you can produce up to two media files (products) from the factory per pass: a TIFO file (which can be forwarded or submitted to other factories for further transcoding), and a second media file of your choice. If you add a third product, or you produce two products and neither is TIFO, Pipeline must perform a file pass for each product you create.
SUBMITTING JOBS VIA AN EDL MONITOR

The EDL monitor is a process in FlipFactory which monitors a folder for Edit Decision List (EDL) files and generates one job per clip entry in the file. After you've created a factory with an EDL monitor, you can stream media directly from a Pipeline into the factory for processing.

The contents of the EDL file must conform to the Pipeline EDL syntax (Pipeline EDL Syntax on page 147). When a new EDL file is processed, the monitor reads, extracts, and creates jobs based on each clip entry in the EDL. The selected Pipeline device is used as the media source for the job.

**Note**

*The Pipeline identity used to create the EDL is part of the metadata. This entry will override the selection of the Pipeline in the EDL monitor if it is different, but the codec selection is not overridden.*

You can use Pipeline Direct to create your EDL and save the file in a monitored folder. The folder may be local or a share (network folder). When the new EDL file is recognized by the FlipFactory EDL Monitor, it submits jobs to FlipFactory for processing.

For each clip entry in the EDL, a new job is submitted. To process the job, FlipFactory must be able to connect to the Pipeline’s video, audio, and data sources (which means that Pipeline Direct or other client applications must not be connected), and controls the VTR deck associated with the target Pipeline to stream SDI media into the Pipeline, then encode and stream the media into FlipFactory, based on the mark in and mark out points in the clip entry. For example, an EDL with five clips creates five separate FlipFactory jobs. Jobs submitted in this manner are processed serially, in real time, until all entries in the EDL are complete.

Pipeline automatically avoids contention and controls access to its services (thus, serializing a series of clip processing jobs) by queuing requests for encoding. Thus, you can implement Pipeline factories in load balance groups and FactoryArrays, and allow your EDL monitor to send jobs to other FlipEngines for processing.
Submit Streaming Media from Pipeline

You can ingest media from Pipeline into FlipFactory in real time by using the Pipeline Streaming feature in the Submit Job window in FlipFactory, specially configured to accept streaming media in real time.

Figure 5–2. Use the Submit Job window to stream media from Pipeline in real time.

Overview

To submit jobs that stream media into FlipFactory from Pipeline in real time, you’ll follow these general steps (the sections following describe this process in detail):

1. Log on to the FlipFactory console and click Submit Job to display the Submit Job window (above).
2. Use the Submit Job window to select the factory that you want to use, and optionally set up a deferred schedule. Make all other job settings (priority, factory selection, subject and description, flip engine and store, and optional metadata) before proceeding.
3. In Source, select Stream, and then select the Pipeline from the source type dropdown menu.
4. Next, click Pipeline Control to display the Pipeline Capture Editor (details shown below).
5. In the Settings tab, select the Pipeline and codec and, optionally, adjust pre-roll and offset values.
6. In the Capture tab, select Automatic or Manual, enter the respective values, and click Add to Queue or Flip It! to stream the media into FlipFactory for encoding (streaming will occur immediately unless you’ve set up a deferred job).
Using the Submit Job Window to Stream Pipeline Media

The Submit Job window is used to provide general information about any job. Pipeline-specific details are configured in the Pipeline Capture Editor, which is explained following.

Figure 5–3. Set up the general job details before displaying the Capture Editor.

Before displaying the Pipeline Capture Editor (by clicking Pipeline Control), configure the following items:

**Priority of Submitted Jobs (optional).** Select the job submission priority (1 - 4). When the FlipEngine accepts another job from the job queue, it selects the job to process next, based on its job priority.

**Factory (required).** Select a Pipeline factory from the Factories list. To select more than one factory, use the Control or Shift key to select additional factories.

**Subject (required in 5.1).** Type the subject for this job (required). This information is included in the notification email sent to the account owner and displayed with the job entry in the Job Status window.

**Description (optional).** Type a Description. This information is also included in the notification email sent to the account owner and displayed with the job entry in the Job Status window.

**Schedule (optional).** Leave Defer unchecked to process this job immediately upon submission. To delay processing, click to select Defer. Enter the time, and select the month and date and year.

When you submit a deferred job, FlipFactory accepts the job and stores it in the database for later processing at the time you specify. For example, you may be streaming broadcast media into a Pipeline – a competing newscast, for example, and you want to capture it beginning at 10:00 PM.
Source (required). Click Stream, and then select Pipeline from the Stream type dropdown menu.

Note

Do not click Pipeline Control to display the Pipeline Capture Editor until you have completed the fields below the Source section.

FlipEngine. When a load balance group or FactoryArray is established, select from the popup list which FlipEngine is designated to process this job (see FactoryArray User’s Guide).

Store. Select which store is designated for localization (See Adding Custom Stores in Chapter 4 of the FlipFactory User’s Guide).

Metadata. To include metadata labels, click Metadata to check the option. Click the tab corresponding to the label you want to use and complete the fields in the editor panel.

Figure 5–4. Metadata added in Job Submit window is combined with metadata in Capture Editor.

The available labels are determined by the source type, filters, destinations, and notifications specified in the factory to which the job is being submitted.

Submit Multiple Files as Separate Jobs. Leave unchecked when using with Pipeline jobs.

Pipeline Control. When you're done configuring the general details of a Pipeline job, click Pipeline Control to display the Pipeline Capture Editor and continue configuring the media for the job, then submit the job or jobs from the Capture Editor panel.
**Pipeline Capture Editor**

The Pipeline Capture Editor provides functionality similar to Pipeline Direct (the embedded Web application in Pipeline), directly accessed from FlipFactory’s Submit Job window.

To access the Pipeline Capture Editor in FlipFactory, click Submit Job on the main FlipFactory console, select Stream as your source and Pipeline as the stream type, then click Pipeline Control. The Pipeline Capture Editor window displays. The Capture Editor extends the functionality of the Submit Job window by adding metadata and Pipeline controls.

You can operate the Pipeline Capture Editor in manual mode to directly control the VTR when submitting media, or you can operate it in automatic mode, when you want to create one or more clips and have FlipFactory and the Pipeline with VTR produce the clips for you, based on the clip entry timecodes.

When you use the Pipeline Capture Editor, notice that the Flip It! button at the bottom of the FlipFactory Submit Job window is de-activated, and is replaced by the same button (in manual mode) or Add to Queue and Close (in automatic mode) in the Pipeline Capture Editor, to submit Pipeline jobs.

### Using the Capture Editor’s Main Panel

The main panel (left side of window) displays the video preview panel at the top, and which Pipeline and FlipFactory factory you’re using display at the bottom.

*Figure 5–5. Pipeline Capture Editor window.*

Directly below the video preview on the left is the name of the Pipeline you’re connected to, and the codec you’ve selected. The selected factory is also displayed (select the factory from the Submit Job window).

To the right are two tabbed regions (described following), for settings and capture control.
Chapter 5
Using Pipeline with FlipFactory

Video Preview Panel

The Video Preview panel displays video when you’re connected to a Pipeline. Use the VTR controls to adjust your timecode settings before submitting them as a job.

VTR Controls. Use the VTR controls to control video preview when a VTR is attached. Disabled if the deck is off, the RS422 cable is disconnected, or the deck is in local mode.

Figure 5–6. VTR controls in Pipeline Capture Editor.

Shuttle. Use the shuttle to quickly play through the content at different speeds, in fast and slow motion. It also shifts the pitch of audio as it plays at varying speeds. In slow motion, this can make it easier to locate specific words and sounds for editing. Drag the slider to the right to fast-forward and to the left to rewind. Playback speed varies depending on the distance of the slider from the center of the control.

Using the Capture Editor’s Settings Tab

Use the Settings Tab to select a Pipeline and related control settings.

Figure 5–7. Settings tab in Pipeline Capture Editor.

Each control is described in the following table.
### Table 5–1. Settings tab controls and descriptions.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Icon</td>
<td>Click to save a custom Pipeline stream after you’ve filled out the settings. A save dialog displays, where you can enter the stream name and click OK.</td>
</tr>
<tr>
<td>Select</td>
<td>Click to display a selection dialog, where you can select the Pipeline you want to connect to use, and also select the codec. Click Select to connect, and close the dialog. When selected, the Pipeline name is displayed at the right of the button.</td>
</tr>
</tbody>
</table>

#### Device Protocol

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preroll</td>
<td>Specify the number of seconds to position the tape before the actual start timecode during capturing, so that the tape is running at the correct speed when the first frame is captured. Default: 2 seconds.</td>
</tr>
<tr>
<td>Offset</td>
<td>A value that is added to the timestamp acquired from the RS422 port to account for any discrepancy between the received and actual timestamps (rarely used). Default: 0.</td>
</tr>
<tr>
<td>Abort on Dropped Frames</td>
<td>Check to stop capturing or crash recording and report a job error if frames are dropped during streaming video.</td>
</tr>
</tbody>
</table>

### Using the Capture Editor’s Capture Tab

Use the Capture tab to capture streaming media from a Pipeline and submit a job for processing.

**Figure 5–8. Capture tab in Pipeline Capture Editor.**

- Enter metadata to submit with this job.
- Select Automatic and make your mark-in & out points. Click Add to Queue to submit the job to FlipFactory and process it when the Pipeline becomes available by closing the Capture Editor.
- Select Manual, enter the duration and click Flip it! (not shown in this example) at the bottom to immediately start ingesting stream media from the Pipeline.
- Uncheck Video or Audio to drop the channel from the capture process.

Each control is described in the following table.
Table 5–2. Capture tab controls and descriptions.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metadata fields</td>
<td>Fill in the editable metadata fields for this clip for submission with the job. The clip name automatically increments the numeric suffix on the name.</td>
</tr>
<tr>
<td><strong>Automatic Time Code</strong></td>
<td><strong>Select when you want to specify a mark-in and mark-out point to capture. The tab displays Add to Queue and Close buttons at the bottom.</strong></td>
</tr>
<tr>
<td>Mark In</td>
<td>Use VTR controls to control your video, click Mark to capture the mark-in value, or enter the value in the HH:MM:SS:FF field and click GOTO to jump to this timecode. Non-drop-frame timecode separators are all colons. Drop-frame notation applies a semi-colon between the second and frame values. For example: 00:29:30;16 is a drop-frame timecode.</td>
</tr>
<tr>
<td>Mark Out</td>
<td>Use VTR controls to control your video, click Mark to capture the mark-out value, or enter the value in the HH:MM:SS:FF field and click GOTO to jump to this timecode.</td>
</tr>
<tr>
<td>Duration</td>
<td>Displays the current length of the clip, based on the difference between the mark-in and mark-out values. If you manually edit the duration, the mark-out timecode is automatically adjusted to compensate for the change.</td>
</tr>
<tr>
<td>Video</td>
<td>Check to capture the video stream.</td>
</tr>
<tr>
<td>Audio</td>
<td>Check to capture the audio stream.</td>
</tr>
<tr>
<td>Add to Queue</td>
<td>Click to submit a job. These jobs are held for processing until the Pipeline is free (the Capture Editor is closed). If you have checked Defer in the Submit Job window, the job will be processed according to the schedule you set. Otherwise, it will be processed as soon as possible based on scheduling priorities in FlipFactory and availability of the Pipeline. Multiple clips can be queued up. When all clips are queued, click Close.</td>
</tr>
<tr>
<td>Close</td>
<td>Click to close the Capture Editor, disconnecting from Pipeline and freeing it for attachment by FlipFactory and allowing all queued jobs to process.</td>
</tr>
<tr>
<td><strong>Manual</strong></td>
<td><strong>Select when you want to crash record from the current stream.</strong></td>
</tr>
<tr>
<td>Duration</td>
<td>Specify the duration of the clip to capture.</td>
</tr>
<tr>
<td>Flip It!</td>
<td>Click to submit a job to FlipFactory for processing. If you have checked Defer in the Submit Job window, the job will be processed according to the schedule you set. Otherwise, it will be processed as soon as possible based on scheduling priorities in the FlipFactory and availability of the Pipeline. Flip It! closes the Capture Editor immediately to free the Pipeline and allow Pipeline jobs to be immediately processed.</td>
</tr>
</tbody>
</table>
SUBMITTING TIFO FILE JOBS

FlipFactory supports TIFO file format as an input file, along with the other supported formats. TIFO files are files you’ve captured (Capturing SD Media to a TIFO File on page 53) in Pipeline Direct from Pipeline. TIFO files can be submitted to any factory you’ve created, and you can submit the media via the Manual Submit process or you can submit them to a monitor.

CHECKING PIPELINE JOB STATUS

When you submit a Pipeline job, FlipFactory displays extra information in the Job Status window. When Pipeline jobs are queued, you can check them in the Job status window and click History to view details.

Note
For complete information on using the Job Status and History windows to manage your Pipeline jobs, see Viewing Job Status in Chapter 7, FlipFactory User’s Guide.

Viewing Job Status and History

To view Pipeline jobs submitted to each factory in your account, display the FlipFactory console (when logged on to your account), in the User’s panel on the console, click Job Status.

Figure 5–9. Click Job Status to display Job Status window

FlipFactory displays the Job Status window

Figure 5–10. Job Status window displays active & complete jobs

In the top panel, FlipFactory displays active and scheduled jobs; in the bottom panel, FlipFactory displays all of the jobs in your account, with details on its status. Select a job to view details.
Displaying Job Status/History

To display the status of a job in progress or the history of a completed job, select the job in either panel and click the Status/History icon (2nd from left – hover to view name) in the toolbar.

FlipFactory displays the Message Progress window.

**Figure 5–11. Status/History Window of job in process**

FlipFactory displays each action, the session or action information, start time and status. You can also view notes to identify a specific Pipeline clip that has been processed.
CREATING A FACTORY TO SUBMIT JOBS VIA EDL MONITORS

You use Pipeline Direct (Chapter 5, Using Pipeline Direct on page 35) to produce EDLs that you can ingest into factories that have been configured with an EDL Monitor in FlipFactory. You can not manually submit jobs from Pipeline EDL files using FlipFactory’s Job Submit window. Before you can submit an EDL to FlipFactory for processing, you need to create a factory with an EDL monitor to submit jobs.

Follow these steps to create a factory with an EDL monitor (if you don’t know how to create factories, see Chapter 6, Building Factories, in the FlipFactory User’s Guide):

1. Create a factory and name it Pipeline (or other suitable name).
2. Add and configure the Pipeline EDL monitor.
   Important settings include selecting the Pipeline and encoder, and creating a directory on the FlipFactory server or a share on a network server, and selecting it as the folder to monitor where you’ll save EDL files for processing.
3. Configure other settings as required for your workflow.
   For details on configuring the EDL monitor, display the online help page by clicking the help button in the toolbar at the top of the monitor Editor panel.
4. Optionally, add a Duplicate Original product, which will produce the TIFO file.
5. Add one other product – a proxy QuickTime file, for example.
   You must always add one other product to a factory that has a Duplicate original so that it can be produced, and it won’t add extra time to the job, because the second product is transcoded simultaneously with the TIFO file process.
   However, if you add a third product, the job time will approximately double, because FlipFactory will rewind the VTR and perform a complete second pass on the stream. So, to make other products, you should consider a stage-two factory and use the TIFO file as input for the other products. If you have a factory with 2 products and neither is a duplicate original, you’ll force FlipFactory to perform two passes on the stream, doubling processing time.
6. Configure the destinations, process/analyze tools, filters, and notifications in the factory.

Note
The Pipeline CD contains sample FlipFactory factories that you can use to capture DV, IMX30, and MPEG2 media using the PipelineEDLFactories.xml file. See FlipFactory User’s Guide, Chapter 5, Using FlipFactory, for details on importing factories.
SAMPLE WORKFLOWS

This section describes the four typical Pipeline to FlipFactory workflows and how to configure factories to support them. These workflows are described in detail in the app note entitled “FlipFactory Pipeline Workflows”, which is available on the Telestream Web site in the FlipFactory section.

Note

The Pipeline CD contains sample FlipFactory factories that you can use to capture DV, IMX30, MPEG2 media using the PipelineEDLFactories.xml file. See FlipFactory User’s Guide, Chapter 5, Using FlipFactory, for details on importing factories.

For these sample workflows, you may need additional FlipFactory licenses.

High-Res Archive Workflow. Produce a single, high-resolution file containing DV, DVCPro, IMX30/40/50 or MPEG2 50mb/sec I-Frame video essences. Formats such as MXF or GXF; MPEG2 or DV files for broadcast servers from Grass Valley, Pinnacle, Leitch, Seachange, Omneon, Quantel and many others; files for edit systems such as Final Cut Pro, Avid, Adobe, Pinnacle, and more.

Hi-Res Archive and Proxy Workflow. Produce a single high-resolution file and one additional file such as a lower resolution file to be placed on a broadcast server, a medium resolution proxy file for off-line editing, or a streaming media file such as Windows media, Flash or MPEG4.

Single Transcode Workflow. Produce a single transcoded file such as MPEG4 for iTunes, an MPEG-2 file for a broadcast server, a Flash file for posting on your web site or a Windows Media file for daily production review.

Multiple File Transcode Workflow. Produce multiple files of differing types, from high-resolution to low-resolution stream files for the web or mobile.

High-Res Archive Workflow

Requirement: Create a high-res MXF file for archive and deliver it to a Digital Asset Management system.

- Products – One (1) MXF Stream D-10 OP1A MPEG2 30mb/sec
- Destinations – One (1) network destination to the DAM SAN
- Notification – One (1) DAM system notification

This factory ingests the Pipeline video and audio streams directly and wraps them in the appropriate container. For example, to create an MXF D-10 OP1A file containing 30mb/sec MPEG2 video, build a factory that directs Pipeline to generate an IMX30 video stream and four (4) channels of audio. This factory has one product consisting of an MXF Stream D-10 MPEG2 Direct Convert. In this configuration, the factory is taking Pipeline’s compress video essence directly, compressing the audio streams into their appropriate format and wrapping them in an MXF container.

This kind of direct convert Factory uses minimal CPU cycles and can be used to create a multitude of file formats using DV, DVCPro, IMX30/40/50 or MPEG2 50mb/sec I-Frame video essences.
Hi-Res Archive and Proxy Workflow

Requirement: Create a high-resolution DVCPro file for archive and a Windows Media 9 proxy with embedded time code for off line editing. Deliver the high-resolution files to an archive SAN and the WMV9 proxy to your editor’s workstation. This is a two factory workflow.

Factory #1 (two products). This factory creates a high-res TIFO (Telestream Intermediary Format) file and a Windows Media 9 proxy file with embedded time code. The TIFO is forwarded to Factory #2.

- Product #1 – Duplicate Original (TIFO file with DVCPro video essence)
- Destination – None, delivery will be to FlipFactory’s default location
- Product #2 – WMV9 proxy with time code
- Destination – Network location
- Notification – Forward to a Factory #2 for further processing

Factory #2 – (one product). This factory receives the TIFO files as source from Factory #1 where it is direct-converted into a DVCPro DV file. This file is delivered to a DAM SAN storage server.

- Product – DVCPro direct convert
- Destinations – Network destination to the DAM SAN
- Notification – DAM system notification

This workflow uses a two factory process, with factory #1 creating the high-res intermediary TIFO file and a WMV9 proxy file. The TIFO file is forwarded as the source file for the second Factory. Factory #2 takes the TIFO file and directly converts it to a DVCPro DV file, then delivers it to the DAM and notifies the DAM.

Single Transcode Workflow

Requirement: Create a single iTunes-compatible QuickTime MPEG4 file. Deliver the file to your Web server with associated XML metadata for Podcast posting.

- Product – iTunes compatible QuickTime MPEG4
- Destination – Network location, Web server
- Notification – XML metadata

This type of factory can be used to create any type of format needed. In this example, you create an iTunes-compatible MPEG4 file and deliver it to the Web server’s shared network folder. Also included in this factory is the creation of iTunes compatible metadata.
Multiple File Transcode Workflow

Requirement: Create a high-resolution MXF file for archive, a 6mb/sec MPEG-2 file for a SeaChange spot-server and 3 low-resolution proxy files. Deliver the high-resolution file to an DAM archive SAN, the SeaChange file to the BML server and the low-resolution files to the DAM SAN. Notify the DAM database with paths to all associated media files and provide metadata such as keyframes, time code. Additional Notification to the automation server. This is a two-factory workflow.

Factory #1 – (two products) . This Factory to creates a high-resolution TIFO (Telestream Intermediary Format) file and a Seachange 6mb/sec MPEG-2 file. The TIFO is forwarded to Factory #2 and the Seachange file is delivered to the Seachange spot server.

- Product #1 – Duplicate Original (TIFO file with IMX video essence)
- Destination – None, delivery will be to FlipFactory’s default location
- Product #2 – Seachange 6mb/sec MPEG-2
- Destination – Seachange BML spot server
- Notification – Forward to a Factory #2 for further processing

Factory #2 – (three products). This Factory receives the TIFO files as source from Factory #1 where it is directly converted into an MXF D-10 OP1A file and transcoded into WMV9 and QT MPEG4. These files are delivered to a DAM SAN storage server and the playout automation system is notified.

- Product #1 – MXF D-10 OP1A direct convert
- Destination – Network destination to the DAM SAN
- Product #2 – WMV9 proxy with time code
- Destination – Network destination to the DAM SAN
- Product #3 – QT MPEG4 proxy with time code
- Destination – Network destination to the DAM SAN
- Notification – DAM system notification and Automation system notification

This workflow uses a two-factory process with Factory #1 creating the high-res intermediary TIFO file and a Seachange MPEG-2 file. The TIFO file is used as the source file for the second Factory, Factory #2 takes the TIFO file and directly converts it to an MXF D-10 OP1a and transcodes it into WMV and QT.

With this type of factory workflow any number of formats can be created based on the TIFO file.
Use this chapter to learn how Pipeline Plugin works in Final Cut Pro and enables you to import and export media via Pipeline. The Pipeline plugin also works in Episode | Episode Pro Desktop for importing media from Pipeline.

Topics
- Setting Preferences (page 76)
- Importing Media Into Final Cut Pro | Episode Desktop (page 80)
- Crash Recording Media with Pipeline Import Dialog (page 86)
- Loading and Saving Clip List Files (page 87)
- Exporting Media to Pipeline From Final Cut Pro (page 90)

Note
The Pipeline Plugin supports Pipeline SC and Pipeline Quad only. Before using Pipeline with Final Cut Pro or Episode, the Pipeline must be installed and configured (Chapter 2, Pipeline Hardware, Installation & Setup on page 5). Configure Pipeline using Pipeline Direct (Chapter 4, Using Pipeline Direct on page 35).
**SETTING PREFERENCES**

The Pipeline Plugin allows you to set up your import and export preferences, determine how often to check for software updates, and select preset or custom keyboard settings of your choice.

### Displaying the Preferences Panel

**Final Cut Pro.** Open Final Cut Pro and select File > Import > Pipeline.

**Episode.** Open Final Cut Pro and select File > Import > Pipeline.

*Figure 6–1. Select File > Import > Pipeline to display the Pipeline Browser.*

The Pipeline Plugin displays the Pipeline Browser.

*Figure 6–2. Use the Pipeline dialog to select the Pipeline and set the codec for this import.*

Click Preferences to display the Pipeline Preferences window. (The Preferences button is also displayed on the Pipeline Import window for your convenience.)

In addition to the tabs, the window displays two important buttons:

- **Default.** Click to return all preferences for this tab to their default settings.
- **OK.** Click to update all preferences and close the window. You can display each tab and make changes before clicking OK.
Import Preferences

In the Pipeline Preferences dialog, click Import to display the Import Preferences panel:

**Figure 6–3. Import Preferences.**

![Image of Import Preferences panel]

**Scratch Folder.** Click to select the directory where you want Pipeline Plugin to create the scratch folder. Default: same scratch folder as Final Cut Pro’s default scratch folder. Pipeline Plugin can not automatically detect and take advantage of changes that have been made to Final Cut Pro’s scratch folder preferences.

**Quality Priority.** Select Image Quality to turn on the High Quality bit in the movie, and preserve image quality when playing the movie, dropping frames if necessary – this setting is best for presenting detail when video contains less action or movement. Select Frame Rate to preserve frames and reduce picture quality if necessary during play – this choice is best for preserving smoothness of motion. The Quality Priority setting does not affect encoding, only playback. (You can display a QuickTime movie’s properties and alter this setting if you choose.)

**Preroll Duration.** Specify the number of seconds to pre-roll video from start timecode during import operations.

**Postroll Duration.** Specify the number of seconds to post-roll video past end timecode during import operations.

**Prompt to Insert Tapes.** Check to have the Pipeline plugin sort the clips by tape or reel, and then notify the user when to insert the tape or reel and import all clips from the inserted reel, then proceeding to the next one in order.

**Default.** Click to return all preferences to default settings.

**OK.** Click to save changes and close the dialog.
Export Preferences

In the Pipeline Preferences dialog, click Export to display the Export panel:

**Figure 6–4. Export Preferences.**

- **Leader Duration.** Specify the number of seconds of time to write blank media to the file before encoding.
- **Trailer Duration.** Specify the number of seconds to write blank media to the file after encoding.
- **Pipeline Frame Queue Size.** Set the queue size (in number of frames). The minimum is 8 frames and the maximum is 22 frames. The default is 22 frames, in order to provide the most reliability.

During playout, Pipeline keeps a queue of frames in memory to compensate for network latencies. If queue size is set for a large number of frames, the Pipeline can ‘ride out’ higher transient latencies in the network. However, a large number also introduces a longer delay between the time the frame is emitted on the network and the time that the frame appears on the SDI connection (roughly 1/4 second for 8 frames, up to about 3/4 second for 22 frames).

If you are concerned with latency between the time video is exported from the computer and the time it is sent out the Pipeline device, you should adjust the value lower. However, lowering this value will make the export connection more susceptible to errors due to insufficient CPU power or network bandwidth.

Update Preferences

In the Pipeline Preferences dialog, click Update to display the Update panel:

**Figure 6–5. Update Preferences.**

- **Check for Updates.** Select how often Pipeline Plugin should check for updates, or select never.
Check Now. Click to check for updates immediately. If Pipeline Plugin can make a connection to the Telestream Web site, you’ll be notified if your software is up-to-date or an update is available.

Keyboard Preferences

In the Pipeline Preferences dialog, click Keyboard to display the Keyboard panel:

Figure 6–6. Keyboard Preferences.

Preset. Select among available preset keyboard shortcuts (which updates the Action table), or select Custom to set your own.

Action Table. Select a key on any row in the table to edit its value.
IMPORTING MEDIA INTO FINAL CUT PRO | EPISODE DESKTOP

You can use the Pipeline Importer to encode and import DV25, DVC Pro, IMX 30/40/50, Pro Res SQ, and Motion JPEG media directly into Final Cut Pro or Episode Desktop as a QuickTime movie.

**Note**

When capturing or crash recording from Pipeline Quad, you can perform confidence monitoring to qualify your video. See Confidence Monitoring (page 45).

To import Pro Res into Episode, Final Cut Pro must be installed on the same computer.

In both Final Cut Pro and Episode, when the Pipeline Plugin installed, a new Pipeline menu item is added to the Import menu (example shown in Final Cut Pro):

**Figure 6–7. Use File > Import > Pipeline to import media from Pipeline in real time.**

Here’s an overview of how to encode and import media from a Pipeline (detail follows):

1. Select File > Import > Pipeline to display the Pipeline browser.
2. Select a Pipeline and codec, and connect to the Pipeline.
3. Create your clip list using the VTR controls (for log and capture), or crash record it.
4. Encode and Import the clips into Final Cut Pro as QuickTime movies.
Importing Streaming Media Clips from Pipeline

You can use the Pipeline Import dialog to create one or more clips, and encode and import each clip as a QuickTime movie directly from a Pipeline that is attached via Ethernet (directly or via LAN). (You can also crash record media from Pipeline into a file – see Crash Recording Media with Pipeline Import Dialog on page 86.)

To encode and import media from Pipeline, follow these steps:

1. **Display Pipeline browser.** Select File > Import > Pipeline to display the Pipeline browser.

   ![Pipeline browser](image)

   Figure 6–8. Pipeline browser displays all Pipelines – select one and set the codec for this import.

   - **Status:** Idle | Playing | Capture. You can only connect to idle Pipelines.
   - **Bonjour:** Used to identify Pipelines on the network. Select the Pipeline and verify the status before connecting. Other details include IP address, software revision, and current format.
   - **Codec:** Select the codec to use to encode the media you’re streaming.
   - **Audio:** Select 2 or 4-channel audio.
   - **Click OK to connect after selecting a Pipeline.**

2. **Select Pipeline and codec and Connect.** Select the Pipeline and select the codec you want to use for this import operation, plus 2 or 4-channel audio.

   **Note**

   In Final Cut Pro, the MPEG2 50mb/sec i-frame codec is not available.

   If your Pipeline is in NTSC mode, DVCPro is in the list, because from the NTSC video compression perspective, there is no difference between DV and DVCPro: both are 720x480, 25mb/sec using 4:1:1 chroma sampling.

   In PAL mode, DV compression is 720x576, 25mb/sec with 4:2:0, while DVCPro compression is 720x576, 25mb/sec with 4:1:1. Therefore, both DV and DVCPro display in the list.

Click OK to connect and display the Pipeline Import dialog. (The codec that matches your project is selected by default.)
3. **Create Clips.** Use the Import dialog to create clips and encode and import your media into the Final Cut Pro bin or the Episode job batch window (following, in Final Cut Pro).

**Figure 6–9. Use the Pipeline Import dialog to stream encoded media from your Pipeline.**

In the figure following, the Pipeline Import dialog is depicted in Episode Desktop:

**Figure 6–10. Pipeline Plugin Import dialog in action in Episode Desktop.**

When you connect, streaming media (if present) displays in the video preview region. A clip list displays on the right. VTR and Clip List controls, preferences and Import commands display at the bottom of the panel.

If you have a VTR and it is in Remote mode, you can control your video using the VTR controls and produce clips to be encoded and imported, or the video can be crash recorded. (If you’re viewing a live feed, you can only crash record media.)
Video Panel

The video panel displays the encoded video stream in real time.

Figure 6–11. Pipeline Import dialog’s video panel.

At the bottom, the video panel displays start, current, duration and end timecodes and mark in/out buttons, and a log button for adding a clip to the clip list. The Log button is disabled unless both timecode values are entered. If the start value is less than or equal to the end value, an error is displayed. Non-drop-frame timecode separators are all colons. Drop-frame notation applies a semi-colon between the second and frame values. For example: 00:29:30;16 is a drop-frame timecode.

Clip List Panel

The Clip List panel displays a list of clips you’ve created.

Figure 6–12. The Clip List panel allows you to work with and import clips.

To create a clip entry, you play video, then click the Start button to mark the start timecode (at right of start timecode value field). Click the End button to mark the end timecode (at right of end timecode value field). When you have a start and end timecode value (and the start timecode is previous to the end time code) you can click Log to add the clip to the list. Optionally, enter a start timecode and a duration – the end timecode will be calculated for you.

You can also delete, import, and preview clips using the Clip List buttons displayed directly below the Clip List panel, in the control panel below.
Editing Clip List Metadata

At any time when a clip list is displayed, you can view or edit metadata. To view or edit metadata, double-click a specific clip list entry to display the Clip Information dialog:

Figure 6–13. The Clip Information dialog allows you to view and enter metadata values.

Edit the values for each metadata tag, or select recently added values from the popup menu. Click OK to close the window and save the metadata.

Control Panel

The control panel contains VTR, shuttle/jog controls, clip list buttons, and Preferences and Import buttons.

Figure 6–14. Use the control panel to control your VTR and import clips.

VTR Controls

Shuttle. Click and drag to roll left and right, moving the tape reverse and forward, increasing in speed the farther from center you go. When you release the wheel, it returns to center and stops the tape. You can also click on the shuttle wheel to left or right of center to shuttle in small increments and then return to center. The further from center you click, the more frames you'll play, in either direction.

Fast Reverse. Click to rewind tape at double speed.

Halt. Click to stop tape.

Pause. Click to pause tape – this command sends a shuttle zero command to the VTR.

Play. Click to preview/play video at normal forward speed.

Capture. Click once to start capture/crash recording. During capture, click to stop.

Fast Forward. Click to roll tape forward at double speed.

Jog. Click and drag to Click to roll tape forward or reverse frame by frame.
Keyboard Shortcuts

The Pipeline Plugin enables you to use keyboard shortcuts for video control – Play, Rewind, Log, Mark Out, Fast Forward, Mark In, Step Forward, Step Backward, Go To Mark In, and Go To Mark Out. Keyboard shortcuts can be customized to your own preferences, or you can select default Final Cut Pro or Avid shortcuts. To view and customize shortcuts, see Keyboard Preferences (page 79).

Clip Buttons

Delete. Click to permanently remove the selected clips from the list. Or, press Delete on the keyboard.
Capture. Click to capture selected clips. If not captured, they must be captured or discarded during Import.
Preview. Click to preview the selected clips.

Buttons

About. Click to display the About dialog, which displays the version that is installed.
Preferences. Click to display the Preferences dialog (see below).
Cancel. Click to close the dialog without importing media.
Import. Click to save all of the clips as files and add them to the bin. Clips that haven’t been captured as temporary files, must be captured (or discarded) during the Import process.

Note

You can also jog media using the scroll wheel or scroll ball on a mouse so equipped.

Clips that display a green check logo already have been captured, and have a permanent (non-temporary) file. If you click Cancel, these files will be deleted.

The Pipeline Plugin displays a dialog so you can choose how to treat clips you haven’t captured yet:

4. Import Clips into Bin (Final Cut Pro). After you’ve created your clips, click Import to capture any previously uncaptured clips, save them as files, and import them into the bin.

The Pipeline Plugin ingests the uncaptured clips by controlling Pipeline via the VTR to encode the clip and stream it to the plugin, then writes the media as a QuickTime movie (.mov) file, and saves each file in the destination folder. After the files have been captured, they are all added to the Final Cut Pro bin.

When the import process completes, the Pipeline Import dialog is closed.
CRASH RECORDING MEDIA WITH PIPELINE IMPORT DIALOG

You can crash record live feeds or video playing out from a playback device such as a VTR into the Pipeline via SDI. To crash record media, follow these steps:

1. Select File > Import > Pipeline to display the Pipeline dialog.

   Note

   When capturing or crash recording media from Pipeline Quad, you can perform confidence monitoring of the decoded SDI input to qualify your video. See Confidence Monitoring (page 45).

2. Select the Pipeline (make sure status is Idle) and encoder. Select 2 or 4 channel audio.
3. Click OK to connect to the selected Pipeline.
4. Queue up your video and click the Capture button.

   The Pipeline Plugin rolls the tape if VTR-controlled, and begins capturing the streaming media in the same manner as that performed when you select a clip and click Capture. Click the Capture button again to stop capturing. The clip is listed in the Clip List with a Captured icon.

You can crash record one or more clips, then click Import to save the files and display them in the bin.
LOADING AND SAVING CLIP LIST FILES

The Pipeline Plugin enables you to load the clip list from an EDL or an XML file. You can also save any clip list in Final Cut Pro’s XML Interchange format. Loading and saving clip lists via files improves the transfer of clip lists between applications without manually re-creating them. The XML file is created immediately when the event starts, so that the XML file can be imported into Final Cut Pro as the import is occurring.

For example, you can export a clip list as XML from the Pipeline Plugin in Final Cut Pro, and then import the list into the Pipeline Plugin in Episode so that you can ingest the clips from tape directly into Episode.

These interchange files can be used for time-shifting your work, to avoid performing the same actions multiple times, or to participate in workflow tasks with others. For example, one person can define a list of clips, save the list as an XML file, and then pass the file on to someone else on the network who uses the clip list to ingest the required media.

To load or save clip lists, use the buttons just below the clip list panel:

- **Figure 6–15. The Clip List buttons allow you to open clip list files and save clip lists as a file.**

  - Click Load EDL to populate the clip list with entries from a Pipeline EDL file.
  - Click Load XML to populate the clip list with entries from an EDL file in Final Cut Pro XML Interchange Format.
  - Click Save XML to create a file with entries for this clip list, in Final Cut Pro XML Interchange Format.

Loading the Clip List from an EDL File

To load the clip list from an EDL file, click Load EDL. EDL files can be created from Pipeline Direct.

- **Figure 6–16. Click Load EDL to locate a clip list EDL file and load the entries into the Clip list.**

  Use the Open window to browse and open EDL files you’ve saved previously.

When you click Load EDL, Pipeline Plugin displays a File Open dialog, which you can use to browse and locate the EDL file you want to load. Select the file (only files with the edl suffix are available), click Open to load the clips in the list into your Clip list.
Loading the Clip List from an XML File

To load the clip list from an XML file, click Load XML.

**Click Load XML to locate a clip list XML file and load it.** You can load a Clip List from an XML file that has been saved in Final Cut Pro, the Pipeline Plugin, Pipeline Control, or any other application that supports Final Cut Pro XML Interchange format.

*Figure 6–17. Click Load XML to locate a clip list file and load the entries into the Clip list.*

When you click Load XML, Pipeline Plugin displays a File Open dialog, which you can use to browse and locate the XML file you want to load. Select the file (only files with the xml extension are available), and click Open to load the clips in the list into your Clip list.

Save the Clip List as an XML File

To save the clips in the list as entries in a Final Cut Pro XML Interchange Format XML file, first set up your Final Cut Pro settings. In your Pipeline document window, select Final Cut Pro in the Publish dropdown menu. The Pipeline Plugin displays the following settings dialog:

*Figure 6–18. Set up XML settings in Final Cut Pro.*

**XML Output Location.** Click to select the desktop, or another drive and/or folder location where you want the output to be delivered.

Next, choose how to set the path to all video files in the XML file:

**Original Location.** Select Original Location when you want to leave the videos at the original location where it was created. You might choose this option while you’re editing while encoding, for example.

**Replace with New Path.** Select another location to move it after being created.

With your settings adjusted for your workflow, click OK to update the settings and close the dialog.
Now, click the Capture button. The XML file is immediately created in the location you specified.

Then, click Save XML.

**Figure 6–19. Click Saved XML to save the entries in the Clip list as an XML file.**

![Image: Save window to browse to the target directory and save the clip list as an XML file.]

XML Interchange Format can be generated from Final Cut Pro or other application that supports XMLIF. XML Interchange Format is the format that Pipeline-supported import/export programs load from and save in, to promote interoperability. Clip list files can also be generated and/or edited manually.

Final Cut Pro XML Interchange files are intended to be imported into Final Cut Pro or other applications that are compatible. Use one of the following ways to import these files:

- Double-click the Final Cut Pro XML Interchange file
- Drag the Final Cut Pro XML Interchange file to the Final Cut Pro icon on the desktop or in the Dock.
- Drag the Final Cut Pro XML Interchange file into a Final Cut Pro bin
- Use the Import menu.

For further details, refer to Apple’s documentation on Final Cut Pro XML Interchange format:

[http://developer.apple.com/documentation/Applications/Reference/FinalCutPro_XML/AboutThisDoc/chapter_1_section_1.html](http://developer.apple.com/documentation/Applications/Reference/FinalCutPro_XML/AboutThisDoc/chapter_1_section_1.html)
EXPORTING MEDIA TO PIPELINE FROM FINAL CUT PRO

The Pipeline plugin allows you to export DV, DVCPro, IMX, Pro Res SQ (SD), or Motion JPEG NTSC/PAL clips or sequences for real time playout on the Pipeline’s SDI out port. In most cases, you’ll set your sequence setting the same as your clip format to avoid format conversion, because you’re performing decoding to SDI directly in the Pipeline.

Note

Playing out SDI from Pipeline to a VTR is not a frame accurate operation. The Pipeline plug-in and Pipeline Control pad the front and the back of the media with black frames for the length of time set in the Pipeline Preferences (see Leader and Trailer duration parameters on Page 78). Frame accuracy is not guaranteed.

When exporting media to Pipeline Quad for playout, use the SDI Sync In port to sync your output with a house reference signal. See Using SDI Sync Input on page 10.

Typically, during an export operation, the SDI out port of the Pipeline is connected to a VTR for capturing to tape or other archival operations. Or, it may be connected to a monitor or other real-time system.

With the Pipeline Plugin installed in Final Cut Pro, a new Pipeline menu item is added to the Export menu:

Figure 6–20. Select File > Export > Pipeline to export media to your Pipeline.

Export Overview

Here’s an overview of how to export media from Final Cut Pro:

1. Select a clip or select a sequence.
2. Select File > Export > Pipeline
3. Click Preferences to view or change the current settings.
4. Select the Pipeline you’re exporting to, and click OK to connect.

5. Export your media (Final Cut Pro must render the media first, if not already rendered). The Pipeline Plugin displays the Pipeline Export window:

   With a VTR connected and the VTR is in Remote mode, use the VTR controls to queue the tape. Next, press Capture (the round red button) to play out the clip or sequence in real time.

   With a VTR connected and VTR is in Local mode, queue the tape manually and press Capture on the VTR simultaneously with clicking Capture on the Export dialog.

   With a monitor or other real-time system connected, click Capture when you want to start exporting.

During the time that Final Cut Pro is playing out media, the Pipeline Export dialog displays “Exporting clip or sequence name” and displays the progress bar until export is complete.

Figure 6–21. Use the Pipeline browser to select the Pipeline for this export.

6. **View or Change Settings.** Click Preferences if you want to view or change settings (Setting Preferences (page 76)).

7. **Select a Pipeline and Connect.** Select the Pipeline you want to use for this export operation.

   **Note**

   *If your project has mixed format timelines, Final Cut Pro renders the media to meet Pipeline format requirements before exporting the media.*

When you connect, the Pipeline plugin displays the video that is present on the SDI out port (if a VTR is connected), or advises you if no video signal is present on the SDI out port, because you may want to queue up your tape or roll it to a specific point before exporting the media.
8. **Export your media.** Final Cut Pro must render the media first, if not already rendered. The Pipeline Plugin displays the Pipeline Export window:

*Figure 6–22. Use the Pipeline Export dialog to stream media to your Pipeline.*

When you connect, video from the VTR connected to Pipeline SDI In (if available) displays in the video preview panel. VTR controls and preferences display at the bottom of the panel.

If you have a VTR and it is in Remote mode, you can queue up the tape or jog to a specific point on your tape (or other media) by using the VTR controls before capturing your media.

If the VTR is in Local mode, you can’t queue the tape using the VTR controls in the Pipeline Export window. You’ll have to queue the tape manually and press Capture on the VTR simultaneously with playing out the media (selected clip or sequence) in Final Cut Pro.

With a monitor or other real-time system connected, just click Capture when you want to start exporting. During the time that Final Cut Pro is playing out media, the Pipeline Export dialog displays “Exporting *clip or sequence name*” and displays the progress bar until export is complete.
Video Panel

The video panel displays the encoded video stream in real time.

Figure 6–23. Pipeline Export dialog video panel.

At the bottom, the video panel displays start (comes from start point of tape in VTR), duration (from the clip or segment you selected to export) and end timecode (timecode + duration).

Non-drop-frame timecode separators are all colons. Drop-frame notation displays a semi-colon between the seconds and frame values. For example: 00:29:30;16 is a drop-frame timecode.

Control Panel

The control panel contains VTR, shuttle and jog controls, plus a Preferences button.

Figure 6–24. Use the control panel to control your VTR and export clips.

Shuttle Wheel

Jog Wheel

Click to stop exporting and close the Control Panel.

Displays Preference dialog

Displays version number.

VTR Controls

**Shuttle.** Click and drag to roll left or right, moving the tape reverse or forward, increasing in speed the farther from center you move the wheel. When you release the wheel, it returns to center and stops the tape. You can also click on the shuttle wheel to left or right of center to shuttle in small increments and then automatically return to center and stop. The further from center you click, the more frames you’ll play, in either direction.

**Fast Reverse.** Click to rewind tape at double speed.

**Halt.** Click to stop tape.

**Pause.** Click to pause tape.
**Play.** Click to play out video at normal forward speed.

**Capture.** Click once to start playing out the selected file. During playout, click to stop playout.

**Fast Forward.** Click to roll tape forward at double speed.

**Jog.** Click and drag to roll tape forward or reverse frame by frame.

**Keyboard Shortcuts**

The Pipeline Plugin enables you to use keyboard shortcuts for video control – Play, Rewind, Log, Mark Out, Fast Forward, Mark In, Step Forward, Step Backward, Go To Mark In, and Go To Mark Out. Keyboard shortcuts can be customized to your own preferences, or you can select default Final Cut Pro or Avid shortcuts. To view and customize shortcuts, see Keyboard Preferences (page 79).

**Buttons**

**About.** Click to display the About dialog, which displays the Pipeline Plugin version you have installed.

**Preferences.** Click to display the Preferences dialog (see below).

**Cancel.** Click to close the dialog without importing media.

**Performing Multiple Export Operations**

After you've completed an export, you can export the same clip or sequence again, as many times as you need. You may want to export the clip again if you placed it at the wrong part of a tape, or you want the same clip or sequence export repeated several times.

After the export is complete, press the Capture button. Pipeline Plugin displays a progress bar dialog with Done button in the lower right corner. Now, using the VTR controls, navigate to the target location on your tape and press the Capture button again. You can repeat the same process over and over again.
Pipeline Control is a client application for controlling capture and play out from Pipeline devices. The Mac OS X version supports log and capture, scheduled capture, and scheduled play out. The Windows version supports scheduled capture only. Both application support SD and HD Pipeline devices – Pipeline SC, Pipeline Quad, and Pipeline HD Dual. The user interface is similar on both platforms, but there are minor differences.

Use this chapter to learn how to use the general features Pipeline Control. For details on scheduled playout and capture, see Chapter 8, Using Scheduled Playout & Capture (page 125). For details on realtime log and capture, see Chapter 9, Using Pipeline Control (page 95).

**Topics**

- Opening Pipeline Control (page 96)
- Pipeline Control Overview (page 97)
- Pipeline Control Menus (page 99)
- The Pipeline Settings Toolbar (page 102)
- Configuring Publishers (page 107)
- The Preview Panel (page 116)
- Preferences – Mac OS X (page 119)
- Preferences – Windows (page 122)
- Using the Diagnostics Panel (page 124)

When there are differences in how you perform a task on Mac OS X and Windows, instructions are presented as illustrated in this example:

- Click Start > All Programs > Telestream > Pipeline.
- In the Finder, double-click the Pipeline Control icon in the Applications folder.

---

**Note**

*Pipeline Control can only be used with Pipelines whose firmware is compatible.*

*When you install or upgrade Pipeline software, you may need to upgrade your Pipeline firmware as well. If you select a Pipeline with older firmware, you will be warned that this may cause problems.*
OPENING PIPELINE CONTROL

How you open Pipeline Control depends on the computer you’re using:

- **Click Start > All Programs > Telestream > Pipeline.**
- **In the Finder, double-click the Pipeline Control icon in the Applications folder.**

On Mac OS X, you can also add the Pipeline Control icon to the Dock for convenient access. To add it to the dock, open the Application folder and drag the Pipeline Control icon directly onto the dock. Position it among the other icons where you want it displayed, and release it.

You can also open Pipeline Control by double-clicking a Pipeline schedule document you’ve saved or by dropping a Pipeline schedule document onto the Pipeline Control icon in the Applications folder or in the dock.

---

**Note**

*When you open schedules created in previous versions, you may need to reset the audio and video settings before using them.*

---

By default, Pipeline documents are saved in your Documents folder. When you open Pipeline Control in this manner, the Pipeline document you double-clicked is displayed.

---

**Note**

*If you’re opening Pipeline Control for the first time, you should set up preferences. For details on setting up Pipeline Control preferences, see Preferences – Mac OS X (page 119) or Preferences – Windows (page 122).*

---

On Mac OS X, when you open Pipeline Control, it presents a dialog that allows you to choose the type of task you want to perform.

**Figure 7–1. Task Selector in Pipeline Control (Mac OS X)**

![Task Selector](image)

When you select the task, Pipeline Control displays the appropriate document in a window.
PIPELINE CONTROL OVERVIEW

Pipeline Control has two types of windows: Log and Capture, and Scheduled Capture and Playout. Pipeline Controls allows you to open several windows (or tabs, in Windows) at one time.

Figure 7–2. Pipeline Control window for Windows (schedule Playout and Capture window)

Pipeline Control executes the events on each window tab independently.

If you have several windows open, select Window > Arrange All to automatically resize each window to the minimum size, and arrange them on your monitor. If there is enough room, all windows are arranged so that no part is obscured. If not, windows are staggered so that the document title and settings are visible.
Before you start working on a specific window tab, make sure the active window tab is actually the one you want to update. This is particularly important when more than one is open at a time.

**Figure 7–4. Window panels and toolbars (Mac OS X – schedule panel shown).**

**Settings.** Use to configure Pipeline for use in this schedule.

**Preview panel.** Displays video.

**Status/Scrubber.** Displays status. Scrubber displays for local clips.

**Time Code.** Displays when connected.

**Preview Controls.** Controls local clip file playback.

**Audio Meter.** Displays volume by channel.

**Storage Location.** Displays the current folder where files to be captured will be stored.

**Schedule Toolbar.** Provides buttons for frequently used functions.

**Schedule panel.** Displays all clips in a timeline.

**Clip Event.** Add these clip events to capture or play out video on schedule.

**Schedule Details.** Displays number of clips, total capture hours, and approx. space required.

**Schedule Mode Toolbar.** Controls how you use the schedule.

Each window displays several toolbars and panels, each designed to help you perform log and capture tasks, or to create schedules to capture or play out clips. Each panel, toolbar, and feature is described below.
**Pipeline Control Menus**

Use this section as a quick reference describing relevant Pipeline Control menu items. (General menus and menu items are not described.)

**Pipeline Control Menu (Mac OS X)**

About Pipeline Control. Displays the About dialog, so you can view the Pipeline Control version number.

Preferences. Displays Capture, Play Out, and Update preferences panels. For details, see Preferences – Mac OS X (page 119).

**File Menu**


New Log (Mac OS X). Displays a new, untitled Log and Capture window.

Open. Displays an Open dialog so you can browse to and open previously saved Pipeline Control documents.

Import Pipeline EDL (Mac OS X). Displays an Open dialog, so you can select and import a Pipeline EDL from a file. (Loading and Saving Clip List Files (page 142).

Import Final Cut Pro XML (Mac OS X). Displays an Open dialog, so you can select and import a Final Cut Pro XML Interchange file. (Loading and Saving Clip List Files (page 142).

Export Final Cut Pro XML (Mac OS X). Displays a File dialog, so you can save the current clip list as a Final Cut Pro XML Interchange file. (Loading and Saving Clip List Files (page 142).

Close. Closes the current Schedule Capture and Playout window or Log and Capture window. If the document has not been saved or has unsaved changes, Pipeline Control asks you if you want to save the document before closing.

Save. Saves the changes to the open Schedule Capture and Playout window or Log and Capture window.

Save As. Displays a File dialog, so you can save the current window as a document with a different name, or in a different location.

**View Menu (Windows)**

View Diagnostics Window. When connected to a Pipeline, displays the Pipeline Control Diagnostics window so you can view information about the queues and view Pipeline console messages. The diagnostics window is for advanced users, to aid in troubleshooting and technical support.

**Control Menu**

The menu items under the control menu control the action of the selected Pipeline.

Preview (Mac OS X). Connects to the selected Pipeline if disconnected, and projects the source media, if any. Select again to stop preview.
Start Preview (Windows). Connects the selected Pipeline if disconnected, and projects the source media, if any (Preview mode), displaying video and audio per your settings.

Start Capture (Windows). Begins capturing the clips in the clip list of the selected tape.

Stop Preview or Capture (Windows). Stops preview or capture.

Stop (Mac OS X). Disconnects the Pipeline.

Capture (Mac OS X). Begins capturing the clips in the clip list of the selected tape.

Start in all documents (Windows). Starts preview or capture in all open documents.

Stop in all documents (Windows). Stops preview or capture in all open documents.

Device Menu (Mac OS X)
The commands in the Device menu provide menu items and keyboard shortcuts for VTR controls.

Play. Put VTR in play mode, normal forward speed.

Stop. Stop the VTR.

Rewind. Normal rewind.

Fast Forward. Play forward at 2x normal speed.

Step Backward. Step one frame backward per click.

Step Forward. Step one frame forward per click.

Go To Start. Return the tape to its beginning location.

Go To End. Go to the end of the tape.

Preview Video. Select once to enable video display during preview; select again to turn video off.

Preview Audio. Select once to turn sound on during preview; select again to sound off.

Clip Menu (Mac OS X)
The commands in the Clip menu allow you to edit or delete clips, and provide menu items keyboard shortcuts for mark commands while creating a new clip.

Add. Creates a new event in the schedule.

Delete. Remove the selected clip from the schedule (the file is not deleted from the file system.) The selected clip is indicated with a blue border in the Log and Capture window.

Edit. Edit the selected clip details and metadata – indicated in the Log and Capture window by caution tape above and below the tabs.

Review. In Schedule window, select to play a captured clip in the Preview panel.

Quick Mark. Single-click feature for logging a clip and setting a new mark in point. Click to set the current point on the tape as the mark out point and logs the clip. The last clip’s mark out point becomes the new mark in point, so that you only have to click Quick Mark again to set the out point and log the clip.

Set Mark In. Set the current point on the tape as the clip’s in point.
Set Mark Out. Set the current point on the tape as the clip’s out point.

Go To Mark In. Roll the tape to this point.

Go To Mark Out. Roll the tape to this point.

Log Clip. Create a clip under the current tape name in the tape field, using the values in the General and metadata tabs.

Help (Windows)

About. Displays the About dialog, so you can view the Pipeline Control version number.
Chapter 7
Using Pipeline Control

THE PIPELINE SETTINGS TOOLBAR

At the top of each window is the Settings toolbar. There are eight selectors in the toolbar. These selectors enable you to select a specific Pipeline, and set it up for use with this operation.

When you place a schedule or log and capture window in Playout, Preview, or Capture mode, the settings are disabled and you can’t make changes. To make changes, you must first return to Idle or Preview mode.

Figure 7–5. Use the Pipeline Settings toolbar to select and configure a Pipeline for this window.

- **Pipeline Selector**. Click to select a Pipeline.
- **Video**. Click to select and configure the video codec.
- **Audio**. Click to select and configure the audio codec.
- **Publish**. Click to select an action to perform when each clip is
- **Storage**. Identifies folder for clips.
- **Clock**. Click to select a system to provide clock signal.
- **Format**. Click to select a file type.
- **Handles**. Adjust the time value of handles.

These settings are saved with the document. When the document is connected to a Pipeline, the Pipeline is utilized based on these settings.

Selecting a Pipeline. Click the Pipeline dropdown menu and select a recently-used Pipeline, or select Browse to display a list of all Pipelines on your network for you to choose from.

Figure 7–6. Mac OS X Pipeline browser and selection window.

Figure 7–7. Windows Pipeline browser and selection window.
A green bullet icon indicates that this Pipeline is available for connection. A red bullet indicates that it is currently busy (connected and dedicated to another client). Gray indicates offline; orange indicates an unknown state. Pipelines that are busy, offline, or in an unknown state can't be selected.

Selecting and Configuring a Video Codec. Click the Video drop down menu to select the video codec you want to use and configure it to meet your workflow requirements.

**Figure 7–8. Typical video codec settings panel.**

![Codec Settings Panel](image)

When you don't have a Pipeline selected (None), all codecs display. When you select a specific Pipeline, only those codecs supported by the target Pipeline display. When choosing your frame rate, make sure you're providing an appropriate (NTSC or PAL) source.

---

**Note**

*If you've already selected a codec – and you select a Pipeline that doesn't support it – Pipeline Control will notify you that it doesn't support the selected codec.*

---

**Figure 7–9. Pipeline Control notifies you when a codec is not supported by the Pipeline.**

![Codec Error Notification](image)

Based on your Pipeline, you can select from Uncompressed, DV, DVCPro, IMX, DVCPro HD, ProRes, DNxHD, or Motion JPEG codecs. Each codec has one or more profiles from which you can choose.

Each codec's profile details are located in Appendix C, Pipeline Control Codec Profiles on Page 151.

When you select a codec only the resolutions that apply to that codec are selectable. Frame Rate and Quality settings are filtered based on the resolution you select. Based on the SDI signal of the connected Pipeline, resolutions and frame rates that display a green circle are compatible with the current signal.

---

**Note**

*If your source is HD and you choose an SD codec, Pipeline will down-convert the video per your codec settings. However, the quality of the video may not meet your workflow requirements.*

---

The SD SDI stream being ingested by the Pipeline may be an NTSC or a PAL source: if you select an NTSC codec to encode PAL video or a PAL codec to encode NTSC, the Pipeline software will display an error and prevent the capture from occurring.
In Capture mode, each clip is encoded in the selected codec’s format. In Playout mode, each of the clips in the schedule must contain a track in the selected codec. The codec is also used in Preview mode, and affects the way the preview is displayed.

When selecting a Quality setting for NTSC or PAL captures be sure to select a setting with an Anamorphic suffix if the SDI source of the Pipeline is anamorphic. When selected, video preview is displayed at the correct aspect ratio, and Pipeline Control embeds clues in the QuickTime file so that other QuickTime applications can determine the correct display aspect ratio.

Selecting and Configuring the Audio Codec. Click the Audio drop down menu to select the audio settings and configure it for this workflow.

**Figure 7–10. Typical audio codec settings panel.**

When you don’t have a specific Pipeline selected (None), all Quality settings can be selected. Audio parameters include Channels (2, 4 or 8), Sample Rate (always 48K) and Quality (16-bit or 24-bit Big Endian and Little Endian).

**Storage Location for Captured Media.** Because Pipeline Control is a high-performance media file reading and writing application and these files are most often used with other media systems, an important aspect of planning is determining where you save your media as it is captured.

The current storage location is displayed at the top of the Schedule window (Figure 7–4, above). By default, Pipeline Control on Mac OS X stores media in the Movies folder of the current user. Pipeline Control on Windows stores media in the My Documents folder of the current user. To change locations:

- **Click Browse to locate the select the new directory for the store, or directly edit the directory path.**
- **Click the Storage location. Pipeline Control displays a browser panel, which you can use to navigate to and select a new store location.**

You can store media directly on your computer or you can store it on a SAN, RAID, or network file server. If you plan to submit media to FlipFactory or Episode Engine via publishers, plan ahead to make submission dependable and effective. Use of network stores may introduce performance problems due to network bandwidth and disk write performance limitations (Typical Pipeline Systems and Considerations on page 23). Test your configuration before going into production.

Selecting a Clock Source. Click the Clock dropdown menu to select which device provides the clock source signal from the connected Pipeline. You must be connected to a Pipeline in order to obtain a clock signal, regardless of the source you choose. Choose from Auto (default in Mac OS X), RS422 Device, Reference Input (Pipeline Quad and Pipeline HD Dual), Video Input, Pipeline Clock, Computer Clock.
(default in Windows). On Quad, you can select Channel 1. When you change your clock source, save your file to save changes.

**Note**

*The clock settings in the Pipeline Control application are used instead of the clock settings in the Pipeline. The Pipeline’s clock settings can be viewed and changed using Pipeline Direct (Using the Configure Panel on page 40) Using the Configure Panel). When you configure clock settings in a schedule they are stored with the schedule, and do not change the settings in the selected Pipeline.*

**Auto.** When you select Auto in your schedule and the selected Pipeline is set to a specific timecode option, the Pipeline provides a clock source based on the setting. For example, if the Input SDI signal for Timecode option is checked and the Input SDI signal contains a VITC timecode, the Input SDI signal VITC timecode is always used. (However, if there is no timecode in SDI, a zero timecode is supplied (see reference column on right for timecode source priority).

When you select Auto in the schedule and also select Auto in the Pipeline itself (Using the Configure Panel on page 40) using Pipeline Direct, utilize the two tables below (Table 7–1 for Pipeline SC, Table 7–2 for Pipeline Quad), The timecode source availability is noted, along with the hierarchy (top to bottom) of clock references, at the far right.

**Table 7–1. Pipeline SC – auto mode clock source options**

<table>
<thead>
<tr>
<th>Available Time Code sources</th>
<th>Primary reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDI Input time code available</td>
<td>RS422 time code available</td>
</tr>
<tr>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Not available</td>
<td>Not available</td>
</tr>
<tr>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Not available</td>
<td>Not available</td>
</tr>
</tbody>
</table>

**Table 7–2. Pipeline Quad and HD Dual– auto mode clock source options**

<table>
<thead>
<tr>
<th>Device option</th>
<th>Available Time Code sources</th>
<th>Primary reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Input SDI signal for Timecode&quot; option</td>
<td>SDI Input time code available</td>
<td>RS422 time code available</td>
</tr>
<tr>
<td>Checked</td>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Checked</td>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Not checked</td>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Not checked</td>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Not checked</td>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Not checked</td>
<td>Available</td>
<td>Available</td>
</tr>
<tr>
<td>Net checked</td>
<td>Available</td>
<td>Available</td>
</tr>
</tbody>
</table>

For example, if you’re connected to a Pipeline SC and RS422 has a timecode, it will be used because it is highest priority (column on right). If not, SDI time code will be used (2nd priority), etc.

**RS422 Device.** Uses the timecode provided by device attached to the RS-422 port on the target Pipeline; usually a VTR. If timecode is not available, the Pipeline timecode is provided; a zero-based timecode is provided if the Pipeline is not configured to use an SNTP server.
Reference Input. For use with Pipeline Quad and HD Dual only. Uses the timecode provided through the Reference Input signal in VBI or VANC. If timecode is not available, a zero-based timecode is provided. Do not select Reference Input if you are connected to a single-channel Pipeline.

Video Input. Uses the timecode provided on the Pipeline’s video input signal in VBI or VANC. If timecode is not available, a zero-based timecode is provided if the Pipeline is not configured to use an SNTP server.

Pipeline Clock. Uses the timecode provided by the Pipeline itself. A zero-based timecode is provided if the Pipeline is not configured to use an SNTP server.

Computer Clock. Uses the timecode provided by the host computer on which Pipeline Control is running.

Channel One. When connected to a Pipeline Quad you can select Channel One’s timecode. This enables multiple channels of a Quad to share a common time code when an external time code, either on the video input or the Reference input, is not available.

Selecting a File Format. Click the Format dropdown menu to select QuickTime or TIFO as the file format for this clip file when captured. When used in Playout mode, all clips in the schedule must be in QuickTime and the same media format as the selected codec.

QuickTime files created by Pipeline Control are unique, in that they can be opened and edited in Final Cut Pro as they are being captured. Because of this characteristic, the length specified in the QuickTime file header is set at the beginning of the capture event. If the captured event stops before the event’s predetermined time, the QuickTime file still retains the initial length.

TIFO files are also unique, in that they can be transcoded with FlipFactory or Episode Engine as they are being captured. To use this feature select Pipeline Control’s FlipFactory or Episode Engine publish plug-in.

Setting up Handles. Enter the value in minutes and seconds, up to 10:00 minutes (Windows) or 5:59 minutes (Mac OS X) to capture before and after the actual scheduled capture time.

Selecting a Publisher. Click the Publish dropdown menu to select the system that you want to notify for each clip event. FlipFactory and Episode Engine automatically send jobs when the file is ready. For details about setting up each type of publisher, see Configuring Publishers (page 107).

FlipFactory and Episode Engine publishers are used for Capture mode schedules. Instant Message publisher can be used in both Capture and Playout modes.

If you don’t want to directly connect to another system in your workflow to pass the saved media file and optional metadata, select None.
**CONFIGURING PUBLISHERS**

Publishers are methods of notifying a specific system that an event has occurred, or that media is available for processing. Methods differ, based on the notification requirements of the system you’ve selected. When you select a publisher, you’re prompted to configure it. Publishers include two media processing systems from Telestream: FlipFactory and Episode Engine. You can also publish instant messages to IM users to notify them of events occurring in your schedule. You can select and use one publisher per schedule.

- **FlipFactory Publisher** (page 107)
- **Episode Engine Publisher** (page 110) (Mac OS X only)
- **Instant Messenger Publisher** (page 112) (Mac OS X only)
- **Final Cut Pro Publisher** (page 113) (Mac OS X only)
- **Copy File Publisher** (page 114)

**FlipFactory Publisher**

Set up and use the FlipFactory publisher in Pipeline Control when you want to automatically submit media to a factory for processing when it is ready.

**Note**

*Telestream recommends that Pipeline Control be installed on a computer that is not hosting FlipFactory or other media processing applications: intense disk and CPU consumption can interfere with proper operation of both applications.*

*To publish media for processing by FlipFactory, you must be running FlipFactory version 6.0 (with update packs 1 through 4 installed), or greater.*

*When submitting jobs with TIFO files, it is important to save the file a a drive directly on the FlipFactory server. Telestream recommends not using TIFO when saving to a network drive.*

Configure the FlipFactory publisher to submit jobs (via MDML messages) to the target FlipFactory factory.

If you want to speed up your workflow to near real-time by starting transcoding as soon as capture starts, select TIFO as the file type. When capturing to TIFO files, FlipFactory is notified as soon as the file is created, and transcoding the media occurs as soon as it is available, thus shortening the total processing time.

If you capture media in a QuickTime file, FlipFactory is notified when capture is complete and the file is closed.
To select FlipFactory as a publisher, select Publish > FlipFactory. The following edit panel displays.

**Figure 7–11.** FlipFactory publisher panel allows you to submit media to a specific factory.

Complete the panel and click OK. Make sure you test before putting the schedule into production.

**FlipFactory Server.** Select the target FlipFactory server from the list or enter its IP address in the Address text field.

If you're submitting jobs to a FactoryArray, enter the FactoryArray's virtual IP Address in the Address field (using port 9000) as follows: <IP Address xxx.xxx.xxx.xxx>:9000. After entering the address, click the File Location window and the FlipFactory Publisher will connect to the FlipFactory database to obtain the accounts and associated factories and display them.

**Address.** Displays the currently selected FlipFactory IP address.

**Account.** Select the account on the selected server from the popup menu. When you select an account, Pipeline Control queries the FlipFactory for a list of factories in the selected account. This may take a few seconds.

**Factory.** Select the factory from the list of factories in the selected account.

**File Location.** Enter a path to the file, including the host, path, and file name or use permitted tokens, including slashes but without spaces between them, to form a valid path to the source file being ingested. The path must be valid from the FlipFactory server's view.

When publishing files to FlipFactory, Pipeline Control resolves the path and inserts it (based on your publisher settings) into the FlipFactory MDML message to process the job:

```
file name="mxf-test 2.tif" path="ff-pipeline1/nabfiles/mxf-test 2.tif" version="original"> <protocol name="Universal Naming Convention" role="destination" seperator="/" type="unc" user="#USER#"> Pipeline Control <connection name="Network File" type="pull">
```

**%HOST% Token.** The %HOST% token resolves to the name of the Mac OS X Platform where Pipeline Control is running. When the source file is on the same computer as Pipeline Control, you can use the HOST token to supply the name of the computer. When the source file is on another Mac OS X platform (a server, or an Xsan, for example), do not use the HOST token. Enter the host name manually.

**%FILEPATH% Token.** Do not use the %FILEPATH% token. It provides the fully-qualified path to the file, which cannot be accessed by FlipFactory, because the path reference is not local to FlipFactory. Instead, implement a share, and enter the share name manually.

**%FILENAME% Token.** The %FILENAME% token resolves to the name of the file, including the extension.
To translate a Windows network path to a Pipeline plug-in UNC path:

Windows path example: `\myServer\ShareName\SubFolder`.

Pipeline plug-in UNC example: `myServer/ShareName/SubFolder`.

The proper syntax of the File Location entry for this example is: `myServer/ShareName/SubFolder/%FILENAME%`.

**Forming Paths to Files on Mac OS X.** Use a combination of literal values, slashes, share names, and tokens to form the correct path to the file, so that it is accessible from the FlipFactory server.

Be sure to add the remaining `/` before the `FILENAME` token: `/%FILENAME`.

Example: `Mac_6PM_NEWS/Movies/%FILENAME%`

The best way to validate the correct path is to browse to the source file’s location using Windows Explorer directly from the Flip server and compare it to the entry you’ve entered in the File Location text field.

To make Mac OS X files accessible to FlipFactory, follow these guidelines:

- File Sharing must be on (System Preferences > Sharing).
- Share files and folders using SMB (Samba) must be checked (System Preferences > Sharing > File Sharing > Options).
- The folder where the source files are located must be added as a Shared Folder (System Preferences > Sharing > File Sharing). In the Shared Folders list of the Sharing panel, click the + icon to add a folder. Navigate to the folder (for example, the default Movies folder in your user account) and add it.
- Users must include an entry for Everyone (or a specific user, if known), with Read Only access to the Shared Folder.

**Forming Paths to Files on Windows.** When the source file is on a Windows platform that is separate from the Flip server where the target factory is running, do not use the HOST token. Enter the host name manually. FlipFactory servers display via Bonjour, shown in the list as `FlipFactory_<ServerName>`. The Bonjour prefix `FlipFactory_` is not part of the host name. The host name is the remaining text, for example: `FF_Traffic`.

Don’t use the FILEPATH token unless the source file is stored locally on the target FlipFactory server (thus eliminating the host name) – it provides the fully-qualified file path. If you’ve configured Pipeline Control to save the file directly onto the Flip server, supply `%FILEPATH%/%FILENAME%`. If FlipFactory is on a separate server, the Share Name must be supplied, with a prepended `/`. For example, `/Movies`.

Be sure to add the remaining `/` before the `%FILENAME%` token: `/%FILENAME`.

Examples:

- File on different Windows platform: `FF_Traffic/Movies/%FILENAME%`
- File on target Flip server platform: `%FILEPATH%/%FILENAME%`

The best way to validate the correct path is to browse to the source file’s location using Windows Explorer directly on the Flip server and compare it to the entry you’ve entered in the File Location text field.

To make Windows files accessible to FlipFactory, follow these guidelines:
• Windows File Sharing must be enabled.
• The folder where the source files are located must be added as a Share.
• Users must include an entry for Everyone (or a specific user, if known), with Read Only access.

Episode Engine Publisher
Set up and use an Episode Engine publisher in Pipeline Control when you want to automatically submit media to a specific setting in Episode Engine for processing when it is ready.

---

**Note**

*Telestream recommends that Pipeline Control be installed on a computer that is not hosting Episode Engine or other media processing applications: intense disk and CPU consumption can interfere with proper operation of both applications.*

*To publish media for processing by Episode Engine, you must be running Episode Engine version 5.0 or greater.*

*When submitting jobs with TIFO files, it is important to save the file at a drive directly on the Episode Engine server. Telestream recommends not using TIFO when saving to a network drive.*

---

Select and configure the Episode Engine publisher to submit media to the target Episode Engine.

If you want to speed up your workflow to near real-time by starting transcoding as soon as capture starts, select TIFO as the file type. When capturing to TIFO files, Episode Engine is notified as soon as the file is created, and transcoding the media occurs as soon as it is available, thus shortening the total processing time.

If you capture media in a QuickTime file, Episode Engine is notified when capture is complete and the file is closed.

---

**Note**

*As an alternative method of accessing media from Pipeline, consider Episode Engine file monitors: specifically, Network File Monitor and Pipeline File Monitor.*
To select Episode Engine as a publisher, select Publish > Episode Engine. Pipeline Control displays the following edit panel. Complete the panel and click OK. Make sure you test your configuration before putting the schedule into production.

**Figure 7–12. Episode Engine publisher allows you to submit media to a specific Episode Engine.**

![Episode Engine publisher interface](image)

**Episode Engine Address/IP Address.** Click to select the target Episode Engine from the list or enter the IP address of the target Episode Engine manually in the IP Address field.

**User.** Enter the user name.

**Password.** Enter the password (default: anonymous).

**File Location.** Enter a path or URI to the file, including the host, path, and file name or use permitted tokens, including slashes but without spaces between them, to form a valid path to the source file being ingested. The path must be valid from the Episode Engine server’s view.

- **%HOST% Token:** The %HOST% token resolves to the name of the Mac OS X Platform where Pipeline Control is running. When the source file is on the same computer as Pipeline Control, you can use the %HOST% token to supply the name of the computer. When the source file is on another Mac OS X platform (a server, or an Xsan, for example), do not use the %HOST% token. Enter the host name manually.

- **%FILEPATH% Token.** When the source file is on the same Mac OS X platform as the Episode Engine server, you can use the %FILEPATH% token and %FILENAME% tokens, which provide the fully-qualified path to the file. Be sure to add the remaining / before the %FILENAME% token. If the file is not on the same platform as the Episode Engine, do not use this token, because the fully-qualified path is not valid when it is used on another computer.

- **%FILENAME% Token.** The %FILENAME% token resolves to the name of the file, including the extension.
Forming Paths to Files on the Same Macintosh. When the file is located locally, on the same computer as Episode Engine, do not use the %HOST% or the %FILEPATH% token – enter the path manually, followed by /%FILENAME%.cd

Example: %FILEPATH%/%FILENAME%

Forming URIs to Files on Other Mac OS X and Windows Servers. When the source file is on a Mac OS X or Windows platform that is separate from the computer where the target Episode Engine is running, you must mount the target share on the Episode Engine computer. In Finder, select Go To Server and open the target share in the Finder.

Because the share name may be different in Finder from the actual share name, open Terminal (in Utilities), and drag the share from the Finder window onto the Terminal window, to resolve it.

For example, your target file is on the server Venus, in a share called CaptureMedia. When mounted in Finder, the share icon is named CaptureMedia. Drag this icon into the Terminal window, and it displays as /Volumes/CaptureMedia.

Don’t use the %HOST% token or the %FILEPATH% token – it provides the fully-qualified path to the file. Be sure to add the / before the %FILENAME% token: /%FILENAME.

Example: /Volumes/CaptureMedia/%FILENAME%

The best way to validate the correct URI is to browse to the source file’s location directly on the Episode Engine computer, and compare it to the entry you’ve entered in the File Location text field.

To make remote files accessible to Episode Engine, follow these guidelines:

- File Sharing must be enabled.
- The folder where the source files are located must be added as a Share.
- Users must include an entry for Everyone (or a specific user, if known), with Read Only access.
- The target share must be mounted on the target Episode Engine computer.

Setting. Select the setting that you want to process the file with, from the list.

Instant Messenger Publisher

Set up and use an IM publisher in Pipeline Control when you want to automatically send instant messages to IM recipients when events occur in the schedule.

To select IM as a publisher, select Publish > IM. Pipeline Control displays the following edit panel. Complete the panel and click OK. Make sure you test your configuration before putting the schedule into production.
Configure the IM publisher to notify selected IM recipients that a specific event has occurred in a schedule.

Figure 7–13. IM publisher allows you to send messages to specific IM recipients.

While you can select any of the IM types displayed, the IM publishing plug-in only supports AIM and Jabber, because these are the only types that iChat currently supports. Additionally, the sender and receiver must have each other on their buddy lists using the same account type.

Events. Check one or more events that Pipeline Control should notify the recipient of.

User. Select an IM recipient screen name.

IM Type. Select the type of IM tool to filter the list of users by, and to advise Pipeline Control how to communicate with the specific IM system.

Message. Enter the text to send, along with an optional FILEPATH token.

Check each event that you want the recipient to be notified of, and select a recipient from the list. Next, enter the message you want to send and click OK. You can include tokens in the text and they will be resolved before sending the message to the recipient.

You can use the FILEPATH token plus literal text in messages and in the message field. %FILEPATH% is the fully-qualified specification of the directory path from the root store to the directory.

Tokens are reserved words that act as variables. When the event is triggered, each token is replaced with actual names of the host, file path, and file name that is associated with the event.

Final Cut Pro Publisher

Set up and use a Final Cut Pro publisher when you want to generate a Final Cut Pro XML Interchange file for each clip that is created while running a schedule. Using Final Cut Pro XML Interchange files makes importing clips easier in Final Cut Pro, because you can store the video clip on a server designated for video storage, and just share the XML files that point to the video. You can also set up Pipeline Control to drop the XML files into a Final Cut Server watched folder, for automatic video ingest.

Final Cut Pro XML Interchange files are intended to be imported into Final Cut Pro or other applications that are compatible. Use one of the following way to import these files:
• Double-click the Final Cut Pro XML Interchange file
• Drag the Final Cut Pro XML Interchange file to the Final Cut Pro icon on the desktop or in the Dock
• Drag the Final Cut Pro XML Interchange file into a Final Cut Pro bin
• Select File->Import->XML in Final Cut Pro.

The XML file is created when the clip event occurs. Files referenced by the XML file may already be complete and closed when the XML file is opened in Final Cut Pro. Or, the file may still be in the process of being captured. Creating the XML file immediately permits Final Cut Pro to open QuickTime MOV files (not TIFO files) and begin editing them, while they are in the process of being created by Pipeline.

To select Final Cut Pro as a publisher, select Publish > Final Cut Pro. Pipeline Control displays the following edit panel:

**Figure 7–14. Final Cut Pro publisher allows you to create an FCP XML Interchange file.**

Complete the panel and click OK to save these settings and close the dialog. Make sure you test your settings in Final Cut Pro or Final Cut Server before putting the schedule into production.

**XML Interchange File Output Location.** Click to display the File System dialog, and select the server and folder where you want these FCP Interchange XML Interchange files stored. This location is used in Final Cut Pro to import the referenced file, or in Final Cut Server’s watched folder to automatically ingest the referenced file.

Next, choose how to set the path to all video files in the XML file (Set Path to files in XML):

**Original Location.** Select Original Location when you want to reference the videos in the location specified in Storage (Storage Location for Captured Media (page 104)) where it was created. You might choose this option when you plan to capture and edit while encoding, for example.

**Replace with a New Path.** Use Replace with New Path to specify a network path to the media file when the Final Cut Pro system accessing them is on a system other than the one running Pipeline Control.

**Copy File Publisher**

The Copy File publisher can be used to copy a captured clip to another local or network location. Configuration settings include the destination of the copied file, options for when a file of the same name already exists and whether to append the date/time to the file name.
To select Copy File as a publisher, select Publish > Copy File. The following edit panel displays.

**Figure 7–15. Copy File publisher allows you to duplicate just-completed clips.**

![Copy File publisher panel]

Complete the panel and click OK. Save the schedule to save these settings. Make sure you test your configuration before putting the schedule into production.

**Copy File To.** Click to display the File System dialog, and select the folder where you want to copy the file.

**If File Already Exists.** Select what action to take if there is already a file of the same name in this folder: Replace the existing file, save the new file with a unique name, or don’t copy the new file.

**Append date and time to file name.** The date and time is appended, in the format YYYY-MM-DD HH-MM-SS. For example, if the file *Pipeline10.MOV* was created on December 5, 2008 at 13:15 when copied, it would be named *Pipeline10 2008-12-05 13-15-00.MOV*. 
THE PREVIEW PANEL

The preview panel displays video and plays audio whenever a clip event while a capture event is in progress (converting an SDI signal to a digital media file), and when a clip playout event is in progress (converting a media file to SDI)

You can also play clip files – events that have already been captured) in the schedule. Hover over the event and select Play.

Preview of video and audio can be turned off or on, using the Preview Video and Preview Audio buttons.

Figure 7–16. Use the Preview panel to view incoming and outgoing streams or clip events.

When incoming video is being encoded and streamed from the Pipeline, you can preview the media. When Pipeline Control is in Capture or Playout mode, video that is being captured or played out may be displayed in the preview panel.

If you have more than one schedule open, the previewed video frame rate is scaled back to prevent excessive CPU usage. Preview is played at full frame rate as long as the Pipeline host computer has one processor (or core) per 349,920 (720 * 486) pixels being decoded.

Caution

Once this ratio is exceeded, the frame rate is reduced by half. It is reduced again to a third of the full frame rate, then a fourth of the full frame rate, etc. as the number of pixels in preview panels increases. This allows computers with more processing power to have smoother previews, and computers with less processing power to be less burdened by the previews.

To play a local clip (directly on your computer, SAN, or connected server), hover the mouse over the clip event and click the Play button that displays. If the file exists and is accessible, it plays in the preview area.
The Timecode, Status/Scrubber and Preview Controls Panel

When you’re connected to a Pipeline in Preview, Idle, or Capture mode, the timecode, status, and preview controls panel (directly below the preview panel) displays a status bar and the current timecode of the Pipeline video, in HH:MM:SS:FF format.

![Preview Video and Preview Audio buttons display directly under the preview panel.](image)

Figure 7–17. The status window displays current Pipeline activity.

The status bar (directly above the time code) displays the current mode of the schedule: Idle, Closing connection, Establishing connection, Previewing, Capturing, Preparing, Playing out, etc.

When you play a local clip (roll over the clip event body to display the play icon, and click it), the timecode panel (directly below the preview panel) displays a scrubber instead of the status bar, and also displays the current timecode of the selected clip, in HH:MM:SS:FF format. (When you disconnect from a Pipeline, no timecode displays.)

Figure 7–18. When playing a local clip, you can scrub it.

When you play a local clip attached to an event, a scrubber displays, so that you can use the preview scrubber to scrub to any point in the clip. You can also use the preview controls to control the video when playing a locally-saved clip event.

Figure 7–19. You can use preview controls to control playout of local clips.

Start of Clip. Click to reset the clip to play from the beginning.

Fast Reverse. Click to rewind at double speed.

Pause. When playing, click to pause.

Play. When paused, click to play video at normal forward speed.

Fast Forward. Click to roll tape forward at double speed.

End of Clip. Click to go to the end of the file.
Using the Preview Buttons

Use the Preview buttons to control video and audio preview.

Figure 7–20. You can preview video and/or audio of streaming media.

Click Preview Video to display the streaming video from the connected Pipeline in the Preview panel.
Click Preview Audio to play the audio track of the streaming video.
Disabling Preview (video and audio) decreases the CPU load during capture or playout.

Audio Volume Meters

The volume meters depict the volume of the currently playing audio (up to 8 channels).

Figure 7–21. Volume meters activate for each audio channel in the media.

The scale of the meter is -72 dBFS to 0S dBFS, in 6 dB increments.

You can adjust the sound volume of the preview using the volume slider.
Use the Preferences panels to set up Pipeline the way you want to use it.

Capture Preferences

**Figure 7–22. Capture Preferences**

**Default Clip Name.** Enter the text you want Pipeline to use when creating new clip names. Pipeline appends this string with a unique number to create unique clip names.

**Use Disk Buffering.** Check to use disk-based stream buffering during capture (Disk Buffering Details on page 27).

**Disk Buffer Path.** When Disk Buffer is checked, enter the path specifying the directory (Unix format) on a local disk where Pipeline Control should write the temporary buffer file during capture, before it is transferred to the final folder, as specified in the schedule’s store (Storage Location for Captured Media (page 104)).

**Automatically Eject Tapes.** Check to have Pipeline Control eject the tape from the VTR when capture is complete.
Playout Preferences

Figure 7–23. Playout Preferences

Filler. Select Black, Test Pattern, or other QuickTime file to play out during spaces in the schedule.

Queue Size. Set the queue size (in number of frames). The minimum is 8 frames and the maximum is 22 frames. The default is 22 frames, in order to provide the most reliability.

During playout, the Pipeline keeps a queue of frames in memory to compensate for network latencies. If queue size is set for a large number of frames, the Pipeline can ‘ride out’ higher transient latencies in the network. However, a large number also introduces a longer delay between the time the frame is emitted on the network and the time that the frame appears on the SDI connection (roughly 1/4 second for 8 frames, up to about 3/4 second for 22 frames).

If you are concerned with latency between the time video is exported from the computer and the time it is sent out the Pipeline, you should adjust the value lower. However, lowering this value makes the connection more susceptible to errors due to insufficient CPU power or network bandwidth.

When the schedule document is in active Playout mode, video playout is based on the events in the schedule. When no event is scheduled for a particular time then media is played out as determined by the Playout Preference panel selections.

If you want to play out custom video during times with an empty schedule, the video must meet the following requirements:

The user-supplied QuickTime movie must have video and audio formatting that matches the settings in the schedule document. For example, if the schedule document is set to IMX30 PAL with 4 channels of audio, then the selected QuickTime must also be IMX30 PAL with 4 channels of audio.

To provide a single filler file that you can use with any schedule regardless of the settings, you can create a QuickTime movie with one video track per supported codec, and eight channels of audio.
Update Preferences

Figure 7–24. Update Preferences

The Update panel enables you to determine when to check for updates from the Telestream Web site.

Check for Updates. Select Daily, Weekly, Monthly, or Never, to check for application updates.

Check Now. Click Check Now to check Telestream’s Web site for application updates right now, and let you know if Pipeline Control is up to date or updates are available.
PREFERENCES – WINDOWS

Use the Preferences panels to set up Pipeline Control the way you want to use it.

General Preferences

Figure 7–25. General Preferences (Windows)

Reload last document at startup. Check to always open the last document saved when you used Pipeline Control last.

Display warning when default video folder path is not a shared folder. Check to display a warning when the video folder you select is not a share.

Display warning before changing filename when clip name changes. Check to display a warning when you change the name of a file associated with an event in the active schedule. For example, a schedule has been running for an entire cycle, and has captured 24 one hour events. The event scheduled at 8 am is named 8AMevent, and is associated with a file named 8AMevent.mov on the Pipeline host’s disk drive. You change the mode to Idle, and modify the file name in the Scheduled Item Editor dialog. Pipeline displays the “Display warning….” to warn you that the file name will be renamed as well as the event name.

Continuously loop schedule documents. Check to continuously process schedules. If unchecked, the schedule runs to the end of the current 24-hour period and stops.

Start Preview after selecting a Pipeline. Check to automatically stream video from the connected Pipeline and display it in the Preview panel.

Capture Default Video Folder. Click browse to navigate to and select the default folder where captured video files are written.

Default Clip Name. Enter the phrase to use as the root name for new video files.
Append Date/Time. Check to append the value (as specified by the date and time syntax) to the default clip name if any.

**Caution**

Continuously running schedules will overwrite previously captured files unless you append a date/time stamp, which may cause you to lose data.

If you rename an event that has a file associated with it (in the same location), the file is automatically renamed to match the event. In Windows, if you checked Display Warning When Changing File Names preference (General tab), you’ll be asked before renaming the file.

Use Disk Buffering. Check to use disk-based stream buffering during capture (Disk Buffering Details on page 27).

Disk Buffer Path. When checked, enter the path specifying the directory on a local disk where Pipeline Control should write the temporary buffer file during capture, before it is transferred to the final folder, as specified in the schedule’s store (Storage Location for Captured Media (page 104)).

For more information on disk buffering, see Disk Buffering Details on page 27.

**Auto Update Preferences**

Figure 7–26. Auto Update Preferences (Windows)

The Auto Update panel enables you to determine when to check for updates from the Telestream Web site.

Check for Updates. Select Daily, Weekly, Monthly, or Never, to check for application updates.

Check Now. Click Check Now to check Telestream’s Web site for application updates right now, and let you know if Pipeline is up to date or updates are available.
USING THE DIAGNOSTICS PANEL

To display the diagnostics panel in Mac OS X, select Window > Show Diagnostics Panel. On Windows, select View > View Diagnostics Panel (only when connected to a Pipeline).

Figure 7–27. Diagnostics window to provide advanced information about the Pipeline.

The diagnostics panel is for advanced users to aid in trouble shooting and technical support. When connected to a Pipeline the panel displays the current state of the RAM and Disk Frame buffers.

The RAM meter displays the percentage of the frame buffer that is currently full, as well as a high-water mark that displays the largest size the buffer has been in the last five seconds. If the meter displays red, it means that Pipeline Control is close to overflowing this buffer, which will cause the current operation to abort. If the disk buffering feature is enabled, the DISK meter displays how much data is remaining to be transferred to its final destination (see Disk Buffering, below).

In addition the panel can display the Telnet 911 output being generated by the Pipeline. This information can be used to diagnose issues if required.
Use this chapter to learn how to use Pipeline Control on Mac OS X and Windows to create schedules for capturing media from Pipeline and for playing media out on Pipeline.

You can only play out schedules in Pipeline Control on Mac OS X.

Topics

- About Schedules (page 126)
- Creating Capture Schedules (page 127)
- Creating Playout Schedules (page 128)
- Using Schedule Windows (page 129)
- The Schedule Panel (page 129)

Note

Pipeline Control can only be used with Pipelines whose firmware is compatible.

When you install or upgrade Pipeline software, you may need to upgrade your Pipeline firmware as well. If you select a Pipeline with older firmware, you will be warned that this may cause problems.
ABOUT SCHEDULES

A schedule is a list of one or more clip events to be processed in a recurring 24-hour period. Each schedule also has information about Pipeline selection and settings, and optional publisher specifications. Each schedule is displayed in a different window in Pipeline Control (Mac OS X) or a different tab (Windows). Because Pipeline Control is a multi-document application, you can open, edit, and execute (in Playout or Capture mode) several schedules at the same time. The number of media files you can capture or play out simultaneously is based on the power of the CPU and disk write speed in your computer and your network bandwidth (Network and Hard Disk Performance Requirements on page 29).

Creating Schedules. To create a schedule, select File > New Schedule. To save a schedule, select File > Save or Save as, name the document and select a folder to save it in. When you save a schedule, it is saved as a document. You can copy schedule documents in the Finder, move them to other folders, or other computers. You can treat Pipeline Control's schedule documents just like you do any other document.

When you close a schedule window, if it isn't named you'll be asked to name it. If you've changed it, you'll be asked if you want to save changes.

Note

Active schedules (schedules in Preview, Capture, or Playout mode) must first be placed in Idle mode to close them. You may be interrupting a clip event, so check first.

Each schedule contains several important groups of information: a selected Pipeline and its settings, plus a list of one or more clip events arranged in a 24-hour timeline, along with their file names and optional metadata, and optional publishers. Pipeline Control uses the schedule information you've configured, to execute each clip event at the correct time, to either capture the clip, or play out the clip.

Schedules are Symmetrical. That is, if you capture a given schedule, Pipeline Control runs the schedule and ingests encoded media from a specific Pipeline's SDI port based on the clip events you've created in the schedule, and saves it as a specific type of file, based on your settings. You can also play out the same schedule, and the reverse events occur: each file you specify with a clip event is opened at the correct time and the media is played out to the specified Pipeline for decoding and playout as SDI.

You can make as many schedules as you need to organize your workflows or tasks efficiently. You might create schedules for each Pipeline you're using, or you might create schedules for a specific set of clips you need to capture or play out each day (or shift). Or, create schedules based on how you want the media encoded, for use in an edit system, for example.
CREATING CAPTURE SCHEDULES

A capture schedule is a schedule with one or more clip events, which you use to capture SDI video in real time. The SDI video is converted to a specific essence, depending on the codec you use, in the Pipeline, and saved as a digital media QuickTime or TIFO file by Pipeline Control.

Here are the steps you’ll take to create and use a capture schedule:

1. If Pipeline Control isn’t running, start it now (Opening Pipeline Control on page 96).
2. If necessary, create a new, untitled schedule (Select File > New Schedule).
3. Select the Pipeline device which is supplying the video feed you want to capture (Selecting a Pipeline (page 102)).
4. Select the video codec and configure it to meet your video encoding requirements (Selecting and Configuring a Video Codec (page 103)).
5. Likewise, configure the audio codec to meet your audio encoding requirements (Selecting and Configuring the Audio Codec (page 104)).
6. Specify the storage location where you want your media clips saved (Storage Location for Captured Media (page 104)).
7. Specify your clock source (Selecting a Clock Source (page 104)).
8. Select QuickTime or TIFO as your wrapper (file) format (Selecting a File Format (page 106)).
9. Set up handles as necessary (Setting up Handles (page 106)).
10. Optionally, select and configure a publisher to perform additional actions as part of a workflow (Selecting a Publisher (page 106)).
11. Save your schedule and name it, then continue.
12. Add one or more clip events to the schedule (Creating Clip Events (page 130)). Each clip has a start time and a duration.
13. For each clip, enter a file name if you want it to be different than the default, and optionally, select a metadata label and enter metadata (Editing a Clip Event’s Property Sheet (page 131)).
14. Save the schedule.
15. Click Capture to place the schedule into capture mode.

Pipeline Control displays the incoming video stream – verify the stream is what you expect. Pipeline Control waits for each clip event, and saves each clip as a file in the essence and format you specify.
CREATING PLAYOUT SCHEDULES

A playout schedule is a schedule created with the intent of decoding the media in QuickTime files on Pipeline, and converting to SDI for playout in real time.

You can only create play out schedules in Pipeline Control on Mac OS X. Pipeline Control for Windows does not support scheduled play out.

Only QuickTime-compatible media files containing video and audio formats are capable of playout by Pipeline Control. Supported video formats are DV, DVCPro, IMX, Pro Res 422, Motion JPEG. Audio must be uncompressed, in discrete mono tracks.

Here are the steps you'll take to create and use a playout schedule:

1. If Pipeline Control isn't running, start it now (Opening Pipeline Control on page 96).
3. Select the Pipeline device which you want to use to playout your video clips as SDI (Selecting a Pipeline. (page 102)).
4. Select the video codec and configure it to meet your video decoding requirements (Selecting and Configuring a Video Codec. (page 103)).
5. Likewise, configure the audio codec to meet your audio decoding requirements (Selecting and Configuring the Audio Codec (page 104)).
6. Specify your clock source (Selecting a Clock Source. (page 104)).
7. Select QuickTime as your wrapper (file) format (Selecting a File Format. (page 106)). You can't play out media saved in TIFO files.
8. Set up handles as necessary (Setting up Handles (page 106)).
9. Optionally, select and configure a publisher to perform additional actions as part of a workflow (Selecting a Publisher. (page 106)).
10. Save your schedule and name it, then continue.
11. Add one or more clips to the schedule (Creating Clip Events (page 130)). Each clip has a start time and a duration.
12. Save the schedule.
13. Click the Play button to place the playout schedule into play mode.

Now, Pipeline Control displays the outgoing video stream. Pipeline Control waits for each clip event, and delivers each clip in real-time to the Pipeline, which decodes it and plays it out as SDI.
USING SCHEDULE WINDOWS

The Schedule window is the main interface of the Pipeline Control application. When Pipeline Control opens, it displays the schedule you opened it with or it displays a new, untitled schedule, so you can begin work immediately.

The Schedule Panel

The schedule panel is a vertically-oriented view of a 24-hour period. It is marked by a vertical event timer display down the left side, with space on the right to add clip events. The time displayed in the Event Timer area is controlled by the clock source you specify.

Figure 8–1. The schedule panel allows you to create and manage your clip events.

You add clip events by clicking and dragging in the schedule (for capture) or by dragging and dropping a file onto the schedule (for playout) from the Finder. Each file you add is checked to make sure that the file contains supported audio and video tracks, or it is rejected.

When you add a new clip event, it snaps to a preset block of time, based on how far you are zoomed in on the schedule.

Figure 8–2. Clip events in your schedule provide details about the clip.

When you add a clip event to a schedule for capture, the event only displays the time and name of the clip, in the title. Once the event has been captured, a file is associated with the clip event, so it displays a Play icon in the body when you hover over it. When you add a local file to a schedule (by dragging it onto the schedule), it also creates a clip event. When you hover over it, it immediately displays a Play icon in the body. Click the Play icon to preview the clip.
You can resize a clip (up to 4 hours long) by dragging either the top or bottom and resizing it. When you resize a clip, it snaps to preset time lengths (half hour, quarter hour, five minutes, one minute (for one minute or less in Mac OS X), thirty seconds or ten seconds (Windows only)) depending on the magnification of the schedule. You can zoom in to increase your view of the schedule with greater detail, and smaller clip lengths. You can also edit down to the second by double-clicking on the clip event title to display its property sheet.

If you adjust the time of a clip event which is currently associated with a file and execute the event in playout mode, the file will play when the clip event is scheduled to start. It will end at the actual end of file or at the end of the clip event, whichever is shorter.

Schedule Panel Keyboard Shortcuts

You can work with clips in your schedule using the following keyboard shortcuts:

Delete | Backspace. Deletes the selected clip event
Left Arrow | Page Up. Select the previous clip event
Shift+Left Arrow | Shift+Page Up. Select the first clip event
Right Arrow | Page Down. Select the next clip event
Shift+Right Arrow | Shift+Page Down. Select the last clip event
Up Arrow. Move the selected clip up the schedule by the current block size (half hour, quarter hour, minute, thirty seconds, etc.), based on your current zoom increment.
Down Arrow. Moves the selected clip event down by the current block size.
Home. Scroll to the top of schedule.
End. Scroll to the bottom of schedule.

Creating Clip Events

To add a clip event to a schedule, choose one of several actions:

- Move your cursor into the schedule panel and position it at the approximate start time. Now, click and drag downward for a maximum of 4 hours or until the end of the clip event (you can adjust the time accurately later) and release the button. (If you drag downward beyond 4 hours, Pipeline Control breaks the clip into 4 hour segments.)
- Open a folder on your computer or LAN server and drag and drop media files (those that can be opened with QuickTime) onto the schedule panel, at any time position that doesn’t overlay other clips already on the schedule. Clip events that are attached to a file are titled with the file name.
- Drag a clip from one schedule to another (if it has already been captured).
- Click the Add Clip icon (the plus sign icon) at the top of the schedule toolbar.

You can also select Edit > Add New Scheduled Item.

Once a clip has been placed on the schedule, you can drag it up and down the timeline (by clicking in the body of the event – not the title) to change the start time. Or, you can open the property sheet (double-click the title) and adjust the start and stop time. You can’t create a single clip event lasting longer than 4 hours.

You typically create new clip events directly in the event panel, when you’re creating a Capture schedule. You typically create new events by dragging and dropping, when you’re creating a playout schedule. When
clips are captured, they are saved in the folder specified by the storage location (located at the top of the window) – click to select a new folder or share for storing clips you capture.

You can move a clip by clicking in the body of the clip event and dragging it up or down. This avoids the necessity of moving a clip by adjusting both the start and stop times correctly. You can’t overlap clip events on a schedule.

To play a local clip (directly on your computer, SAN, or connected server), hover the mouse over the clip event and click the Play button that displays. If the file exists and is accessible, it plays in the preview area.

Deleting Clip Events
To delete a clip you’ve selected, choose one of several actions:

- Press the Delete key on the keyboard
- Click the X icon to the left of the schedule.

Once a clip has been placed on the schedule, you can drag it around to change their times. Or, you can open the property sheet and adjust their start and stop time. You can’t create a single clip event lasting longer than 4 hours.

Showing Media on Your Desktop
When an event in the schedule points to local media, you can open the folder that contains the clip directly. Pipeline Control sends a command to the operating system to display the clip in the enclosing folder:

Figure 8–3. Pipeline Control displays the video clip’s folder.

Editing a Clip Event’s Property Sheet
Each clip event has its own property sheet. To display a clip event’s property sheet, double-click in its title bar on the schedule panel. Or, select the clip and click the i icon in the toolbar to the left of the timeline. Properties are displayed on two different tabs: General, and Labels (Mac OS X). In Windows, the tabs are General, Standard, QuickTime, and Final Cut Pro.
Viewing and Updating General Properties

To view or update the general properties of a clip event, double-click in the clip event’s title, then click the General tab to display this sheet:

**Figure 8–4. Clip event general properties – file name, start and stop time, and event color.**

Start and End Time. Edit the digital clock (or the analog clock, by clicking and dragging the hour, minute and second hands) to adjust the start and end times of the clip event.

**Link (Mac OS X) | Maintain Duration (Windows).** Click Link (Mac OS X) or check Maintain Duration (Windows) to adjust the start or end time while maintaining the duration.

Name. Select the name of the clip from the menu, or enter it in the text field.

Color. Select a color to display in the schedule panel for this clip event.

Click OK to save your changes or click Cancel to leave them unchanged.

Viewing and Updating Metadata Labels

To view or update the label values of a clip event, double-click in the clip title on the schedule; then click the Labels tab to display this sheet.

There may be more than one metadata label. Next, select the label set you want to use, from the menu on the right. The Standard label is always available; others (including Final Cut Pro, and QuickTime) are dynamically generated as appropriate.
Values in the Standard label are embedded in the file that is created.

**Figure 8–5. Clip event label values.**

![Diagram of label sets and labels]

**Label Sets.** Select the type of label set you want to use for this clip.

**Labels.** The labels for the selected set display in this table. Enter or update the label values in the right column.

**Label Set.** Select the set you want to use from the menu on the right.

**Values.** Edit each value as appropriate for this clip.

Click OK to save these values or click Cancel to leave them unchanged.
The Schedule Mode Toolbar

Use the schedule mode toolbar to place the schedule in a specific mode. Schedules have four modes.

**Figure 8–6. Use the Schedules Mode toolbar to place the schedule in various states.**

- **Preview Mode.** Click to connect to a Pipeline or preview video. Editing is also enabled in Preview.
- **Capture Mode.** Click to start the schedule in Capture mode. Clip events are executed by creating the file if necessary and saving the media in it.
- **Idle Mode.** Click to stop the schedule and disconnect from the Pipeline, and change settings.
- **Playout Mode (Mac OS X only).** Click to start the schedule in Playout mode. Clip events are executed by opening pre-existing files and playing out their contents.

**Preview Mode.** Click to place the schedule in Preview mode and connect to a Pipeline. If the button isn't active, click the Idle button first. In Preview mode, you can also edit the schedule. Be sure to save your changes before activating the schedule in Capture or playout mode, if you want them to be permanent.

**Idle Mode.** In Idle mode, Pipeline Control is disconnected from the selected Pipeline and the schedule is de-activated. When the schedule is in Capture, Playout, or Preview mode, you must click Idle before setting another mode. In Idle mode, you can edit the schedule and change your settings.

*You can also select Control > Stop Capture | Preview to enter Idle mode.*

**Capture Mode.** Click to place the schedule in Capture mode, when connected to a Pipeline. Clip events are captured as files as they occur in the schedule. In this mode, locks display on clips and you can’t edit the schedule (add, edit, delete or play clips) or change your settings. When a clip event is executed in Capture mode, the current settings in the Pipeline Selector and Settings panel are used, even if they are not saved. Pipeline Control does not automatically save settings. To save settings, select File > Save.

When you press Capture, Pipeline Control checks to make sure you have enough space for the clip events on your schedule.

**Playout Mode (Mac OS X only).** Click to place the schedule in Playout mode, when Pipeline Control is connected to a Pipeline device. Clip events are played out to the Pipeline device as they occur in the schedule. During the time that clips are not playing out (empty spaces in the schedule), Pipeline Control streams video based on settings in Preferences (Preferences – Mac OS X (page 119) or Preferences – Windows (page 122)): black, a test pattern, or a user-supplied QuickTime movie you’ve selected.

In Playout mode, locks display on clips and you can’t edit the schedule (add, edit, delete or play clips) or change your Pipeline settings. When a clip event is executed in playout mode, the current settings in the Pipeline Selector and Settings panel are used, even if they are not saved. Pipeline Control does not automatically save settings. To save settings, select File > Save.

For a schedule to remain active (Capture or playout mode), the Pipeline Control application must be open, and the schedule document must also be open. Additionally, your Macintosh drive must not be in sleep mode. Pipeline Control prevents the computer from automatically putting the hard drive to sleep, but it can not prevent you from selecting Sleep from the Apple menu, or pressing the power button. If the Pipeline Control application or the schedule document is closed, or if your hard drive is in sleep mode, clip events aren’t executed.
The Schedule Panel Toolbar

The schedule toolbar displays vertically, just to the left of the schedule panel. It provides easy access to various schedule commands you use to create and manage clip events.

Figure 8–7. Schedule Toolbar.

Add Clip. Use to add a new clip event. Each time you add an event, it is added as early in the schedule as possible, where space is available. The newly-created clip is automatically selected so that you can immediately display its properties and add metadata, or adjust start and stop times.

Information. Click to display the property sheet for the selected clip.

Review. Review the local clip.

Delete. Click to remove the selected clip event from the schedule. When you remove a clip event, the actual file that it references (if present) is left intact – it is not deleted.

Zoom In/Zoom Out. Use the top magnification glass icon to zoom in on your schedule, and use the bottom magnification icon to zoom out. You can also use the slider to dynamically zoom your schedule. When you zoom out all the way, on most monitors you can view the entire schedule from an hourly perspective. As you zoom in closer and closer, you can view half and quarter hours, 5 minutes, one minute. Zoom to the magnification that is best for the size of clips you’re working with.

Select and show the first clip. Click to select and zoom in on the first clip in the schedule.

Select and show the previous clip. Click to select and zoom in on the clip immediately prior to the currently-selected clip.

Go to Current Time. With the time source (Auto, RS422, etc.) and Pipeline selected, click to scroll the schedule so that the current time is as close to the center of the schedule as possible, so that it is visible. If you are not connected to a Pipeline device, Pipeline Control displays the schedule beginning at midnight.

Select and show the next clip. Click to select and zoom in on the next clip after the selected clip.

Select and show the last clip. Click to select and zoom in on the last clip in the schedule.
Real-time log and capture is provided in Pipeline Control on Mac OS X only. Pipeline Control's log and capture document enables you to create and save clip lists, and capture media in various formats via Pipeline, independently of your video editing/encoding software.

Topics

- About Logging and Capturing Media (page 138)
- Using the Clip List Panel (page 141)
- Loading and Saving Clip List Files (page 142)

Note

*If you haven’t installed and configured the Pipeline on your network or directly connected it to your computer, proceed to Chapter 2, Pipeline Hardware, Installation & Setup on page 5 before continuing.*
ABOUT LOGGING AND CAPTURING MEDIA

You can use the Log and Capture window in Pipeline Control to create clip lists, then capture and encode each clip in any supported SD or HD format as a QuickTime movie or TIFO file directly from a Pipeline that is attached via Ethernet (directly or via LAN).

Note

When capturing media from Pipeline Quad, you can perform confidence monitoring to qualify your video. See Confidence Monitoring (page 45).

CREATING CLIP LISTS FOR LOG AND CAPTURE

To encode and capture media clips from Pipeline, follow these steps:


The Clip List panel, on the right, includes the General Tab for mark-in and mark-out points, several metadata tabs, plus the clip list at the bottom. For details, see Using the Clip List Panel (page 141).

2. Select and Configure your Pipeline. If you haven’t already selected and configured Pipeline for this task, do so now. After configuring Pipeline for your workflow requirements, save the file. For details, see (The Pipeline Settings Toolbar (page 102)).

Note

The MPEG2 50mb/sec i-frame codec is not available for use in Pipeline Control.

If your Pipeline is in NTSC mode, DVCPro is selectable because from the NTSC video compression perspective, there is no difference between DV and DVCPro: both are 720x480, 25mbps using 4:1:1 chroma sampling.

In PAL mode, DV compression is 720x576, 25mbps with 4:2:0. DVCPro compression is 720x576, 25mbps with 4:1:1. Therefore, both DV and DVCPro display in the list.

3. Connect to the Pipeline. When you connect, streaming media (if present) displays in the video panel. If you’re connected to a VTR and it is in Remote mode, you can control your video using the VTR controls and produce clips to be encoded and imported.

4. Create a Clip List. Insert tapes in your VTR, then use the VTR controls to scrub media, create mark in and mark out points (General Tab), add metadata as necessary, and click Log to create the clip and add it to the list.

If you want to capture clips from multiple tapes, enter the name of the tape (or category) in the General > Tape field for the clip you’re creating. Before capturing clips, select the tape (or category) from the clip list on the left, to display the clips you want to capture. You can use the tape name to filter your list.

5. Capture the Clips. Click the Capture button below the clip list to capture the clips displayed in the clip list and save each one as a file. To capture clips from multiple tapes in one session, select All Tapes before clicking Capture. You will be prompted to insert the correct tape when necessary and (if selected in preferences) the previous tape will be ejected.
Using the Log and Capture Window

The log and capture window is similar to the schedule window: at the top is the Pipeline Settings toolbar, and to the left side is the Preview panel with connection, status, and timecode. VTR controls have added Mark In and Out buttons on either side, and Shuttle and Jog controls are directly below.

The right side has tabs for general values, and metadata values. Below the tabs is the clip list, including tape names when logging clips from multiple tapes.

Figure 9–1. Use the Log and Capture window to create clip lists and capture media from Pipeline.

At the bottom center is the red Capture button. For details, see (The Preview Panel (page 116)).
**USING THE PREVIEW PANEL**

In addition to the panels and controls described in (The Preview Panel on page 116), the Preview panel in Log and Capture window has additional controls to support log and capture activities.

**Figure 9–2. Timecode, VTR, Jog and Shuttle in the Log and Capture window.**

- **VTR Tape Status Indicator**
  - Tape In: Displays when tape is in the attached VTR.
  - Tape Out: Displays when tape is not in the attached VTR.

- **Deck RS-422 Control Status**
  - NO RS422: Displays when Pipeline does not have control over the attached VTR.
  - RS422: Displays when Pipeline has control over the attached VTR.

- **Mark In/Out Buttons**
  - Mark In: Click to update the Mark In point to the tape’s current timecode for the selected clip.
  - Mark Out: Click to update the Mark Out point to the tape’s current timecode for the selected clip.

- **Jog and Shuttle Wheels**
  - Jog: Click and drag to roll the tape forward or reverse, frame by frame.
  - Shuttle: Click and drag to roll left and right, moving the tape reverse and forward, increasing in speed the farther from center you go. When you release the wheel, it returns to center and stops the tape. You can also click on the shuttle wheel to left or right of center to shuttle in small increments and then return to center. The further from center you click, the more frames you’ll play, in either direction.

- **VTR Remote Status Indicator**
  - LOCAL: Displays when VTR is in Local mode.
  - REMOTE: Displays when VTR is in Remote mode.
USING THE CLIP LIST PANEL

The Clip List panel displays on the right of the Log and Capture window – it includes the General Tab for mark-in and mark-out points, several metadata tabs, plus the clip list, and a Capture button below the list. Each of the tabs holds data for the selected clip.

Figure 9–3. The Clip List panel allows you to work with and capture clips.

Creating a Clip

To create a clip, insert your tape, make sure the Pipeline is connected, and follow these steps:

1. Click the General tab to display mark-in and mark-out controls.
2. Play/scrub the video using the VTR controls, then click the Mark In button to mark the start timecode (at right of Mark In code value field in the General tab of the Clip List panel).
3. Click the Mark Out button to mark the end timecode (at right of end timecode value field). When you have a start and end timecode value (and the start timecode is previous to the end time code).
4. Optionally, enter a start timecode and a duration – the end timecode will be calculated for you.
5. Optionally, enter metadata on the Embedded, Final Cut Pro, and FlipFactory tabs.
6. Click Log to create the clip and add it to the list.

When not in edit mode, any data entry or edits you perform in any tab is for the next clip you may create.

Deleting a Clip

To delete a clip, select it from the clip list and press the Delete key or select Clip > Delete.
Editing a Clip’s Metadata

To edit the metadata of an existing clip, you must double-click the clip (or click a clip and select Clip > Edit).

**Note**

*When not in edit mode, any data entry or edits you perform in any tab is for the next clip you may create.*

Pipeline Control displays caution tape at the top and bottom, to indicate that you’re in edit mode:

**Figure 9–4.** The Clip List panel allows you to work with and capture clips.

Click on the target tab, and edit the values for each metadata tag.
Click Save to save the metadata with the clip and return to view mode.

**LOADING AND SAVING CLIP LIST FILES**

Pipeline Control enables you to load the clip list from an EDL or an XML file. You can also save a clip list you’ve made, in XML format. Loading and saving clip lists via files promotes interchange between applications and systems, without manually re-creating them. These interchange files can be used for time-shifting your work, to avoid performing the same actions multiple times, or to participate in workflow tasks with others.

For example, one person can define a list of clips, save the list as an XML file, and then pass the file on to someone else on the network who performs the actual capture.

You can load the Clip List with entries from an EDL file, or from a Final Cut Pro XML Interchange Format file. To load a clip list, use the following menu items:

**File > Import Pipeline EDL.** Select to populate the clip list with entries from a Pipeline EDL file.

**File > Import Final Cut Pro XML.** Select to populate the clip list with entries from an EDL file in Final Cut Pro XML Interchange Format.

Pipeline Control displays an open dialog. Navigate to the location where the file you want to open is stored, select it, and click Open to load the clip list.

You can also save clip list entries as a file in Final Cut Pro XML Interchange Format.

**File > Export Final Cut Pro XML.** Select to save the clip list in Final Cut Pro XML Interchange Format.

Pipeline Control displays a Save dialog. Enter the name of the file to save, and select the location where you want to save the file. Click Save to save the clip list in XML Interchange Format.
XML Interchange Format can be generated from Final Cut Pro, or any other application that supports this format. XML Interchange Format is the file format that Pipeline import/export or capture/playout programs load from and save in, in order to promote interoperability with other applications. Clip list files can also be generated and/or edited manually.

For further details, refer to Apple’s documentation on XML Interchange Format:
http://developer.apple.com/documentation/AppleApplications/Reference/FinalCutPro_XML/AboutThisDoc/chapter_1_section_1.html

**Keyboard Shortcuts**

You can control the VTR of the connected device using the following keyboard shortcuts:

- **Play** – Space. Plays the video forward at normal speed until end of tape.
- **Stop** – Shift-K. Stops the deck at the current play point.
- **Rewind** – Shift-J. Plays tape at 2x speed backward until begin of tape.
- **Fast Forward** – . Plays forward at 2x speed.
- **Step Backward** – [ (Left Brace). For each key press (or menu selection), moves one frame back.
- **Step Forward** – ] (Right Brace). For each key press (or menu selection), moves one frame forward.
- **Go To Start** – Command-[ (Left Brace). Moves to start of tape at highest speed.
- **Go To End** – Command-] (Right Brace). Moves to end of tape at highest speed.
- **Mark In** – I. Set the Mark In value to the current point on the tape.
- **Mark Out** – O. Set the Mark Out value to the current point on the tape.
- **Log** – P. Add the current clip to the clip list, including saving all metadata values with it.
- **Quick Mark** – M. Single-stroke feature for logging a clip and setting a new mark in point. Sets the current point on the tape as the mark out point and logs the clip. The last clip’s mark out point becomes the new mark in point, so that you only have to execute Quick Mark again to set the out point and log the clip.

**Clip List Buttons**

- **Mark In**. Click to update the Mark In point to the tape’s current timecode for the selected clip.
- **Duration**. Click to disengage the lock (black). The duration is calculated as the end time minus the start time. While the lock button is disengaged (black), changes to the start time code will cause the end time code to remain the same, and the duration time code to change. Any changes to the end time code will similarly cause the start time code to remain the same and the duration time code to change.

  Click again to engage the lock (blue). Duration always stays the same. When the lock button is engaged (blue), changes to the start or end time code leave the duration time code locked – as is. If you change the start time code, the end time code will adjust to match the new start time and the locked duration. If you change the end time code, the start time code will adjust to match the new end time code and the locked duration.
For example, if the duration is set to 00:00:30:00 with the In point at 01:00:00:00, the Out point would be 01:00:29:29. If the In point is changed to 01:00:10:00 the Out point will change to 01:00:39:29. Likewise, if the Out point changed from 01:00:39:29 to 01:00:49:29 the In point would change to 01:00:20:00.

A blue lock does not mean that the duration fields are locked (not editable). When the lock is blue, the duration value can be changed manually by entering a new duration in the duration fields.

**Mark Out.** Click to update the Mark Out point to the tape’s current timecode for the selected clip.

**Replace Thumbnail.** Click to replace the current preview thumbnail with the frame currently displayed.

**Remove Thumbnail.** Click to remove the current thumbnail.

**Clear All.** Click to remove all data (name, timecode, and metadata, for example) from fields for the selected clip.

**Save.** In edit mode, click to permanently save the changed metadata values in the selected clip.

**Log.** In log mode, click to add the new clip to the clip list along with clip values and metadata. Make sure to use the correct tape name, if you’re using multiple tapes.

**Capture.** (Red button at bottom or Control > Capture) Click to capture (play and encode) each clip for the currently tape name (or All Tapes) and save it as a file.

Pipeline Control captures clips by controlling the VTR via the Pipeline to encode the clip and stream each clip’s media to Pipeline Control, which writes the IMX or DV media out as a QuickTime movie (.mov) file, and saves each file in the destination folder.

When the capture process completes, Pipeline Control disconnects from the Pipeline.
This appendix provides instructions for gathering information to assist in troubleshooting. For a complete and current list of potential issues and recommendations, go to http://www.telestream.net/pdfs/user-guides/Pipeline_FAQ.pdf.

**GATHERING INFORMATION FOR TROUBLESHOOTING**

There are three topics that you should read and utilize to gather details that aid in troubleshooting, depending on your environment:

- **Workflow Information** (immediately following)
- **Pipeline Information** (page 146)
- **Counters Panel Details** (page 146)

**Workflow Information**

First, identify the workflow and get system information about your client application: FlipFactory (immediately following) or Final Cut Pro (Final Cut Pro (page 146)).

**FlipFactory**

Obtain FlipFactory information using FlipFactory’s automatic support email, or get it manually. To obtain the information automatically, send email to Telestream by using the Email Tech Support button on the FlipFactory System Settings window (see the FlipFactory User’s Guide, Chapter 5, Using FlipFactory, in the Sending Email to Tech Support section).

To obtain this information manually:

- Get FlipFactory version and all update packs which are installed
- Get a copy of the FlipFactory license file
- Get account and factory details – obtain an XML output of the account when possible
- Obtain the FlipFactory server and/or Pipeline client system information:
  1. Click Start > Help and Support.
  2. On the Help and Support panel, click Support from the top menu.
  3. Click Advanced System Information.
  4. Click View detailed system information.
  5. On the System Information dialog, select File > Save to save an nfo file containing your system information to the desktop of the computer.
Final Cut Pro
Obtain the Final Cut Pro version and Pipeline plug-in revision.
Obtain the Mac OS X system profile:
1. Launch the System Profiler, which is located at: /Applications/Utilities/System Profiler
2. Select Save As… from the File menu.
4. Save the file to the desktop.

Pipeline Information
Obtain the Pipeline firmware revision. Locate the Main and App Loader revision numbers on the Configure panel of Pipeline Direct (Using the Configure Panel (page 40)).
Obtain the encoding specifications. Determine which Pipeline codec is being used (DV, DVCPro, IMX30/40/50, MPEG-2). You can obtain this information in the Live panel (Using the Live Panel (page 49)).

Obtain Network Details
Pipeline IP address – default, static or DHCP.
Document whether the connection is direct or through a switch.
If the connection is through a switch, is the route through more than one?
Are there any managed switches between the Pipeline and the target system?
What is the speed of each leg of the connection: 100Mb or 1000Mb (Gigabit).
Document whether the LAN is used for general data traffic and video traffic or only video traffic.
To display the Counters panel, click counters in the menu:

Counters Panel Details
If a video or audio issue is being reported:
Repeat the encode or playout process while viewing the counters on the Counters panel (see Using the Counters Panel (page 47) for a description of these parameters).
Capture this panel and save the image for later review.
APPENDIX B

Pipeline EDL Syntax

Pipeline EDL Syntax Requirements

Pipeline EDL files contain an entry for each clip to be captured. Each entry consists of a single-line event, a clip name field, and optional Telestream specific metadata fields. Columns are significant.

Note

Line endings for a Pipeline EDL file must be CRLF (Carriage Return followed by Line Feed), which is the DOS/Windows standard. Therefore, if you create an EDL file from scratch on a Macintosh, you may have to convert the line endings.

Event Line Fields

Pipeline EDL files contain an entry for each clip to be captured. Each entry consisting of a single-line event, a clip name field and optional Telestream specific metadata fields.

Event Line Form

1111 222222 333333 4444 555 66666666666 77777777777 88888888888 99999999999

Event Parameters

1111 = Column 1, 4-digit event number 0001 to 9999
222222 = Column 6, six character alphanumeric tape name (can be overridden by optional TAPENAME)
333333 = Column 13, six characters, leading with an A (audio) or V (video)
4444 = Column 20, must always be "C   " (C followed by three spaces)
555 = Column 25, Must always be "   ", three spaces
66666666666 = Column 29, SMPTE time code of source Mark-In (hh:mm:ss:ff)
77777777777 = Column 41, SMPTE time code of source Mark-Out
88888888888 = Column 53, not used
99999999999 = Column 65, not used

Note: Each parameter (1 through 9) must be separated by a single space.

Example: 0001 Reel01 A12V C 00:00:38;22 00:00:41;14 00:00:38;22 00:00:41;14
Clip Name Field (optional)
*CLIP: <Name_of_the_clip>
This name will be used by FlipFactory as the file name.

Begin Additional Fields Parameter
Telestream metadata fields (optional):
*TELESTREAM_METADATA: BEGIN
If optional TELESTREAM fields are included, the BEGIN parameter is required to be first.

Pipeline
This parameter determines which Pipeline to connect to for this clip entry. The name used for this field is the Bonjour friendly name assigned to the Pipeline device. This name defaults to Pipeline_XXXX where XXXX is the Pipeline's serial number.
The friendly name can be obtained by issuing the config CGI GET command to the Pipeline. The friendly name is contained within the Identity element of the returned XML descriptor. Config command example: http://<Pipeline IP Address>/command.cgi?config.
*TELESTREAM_METADATA: PIPELINE <Pipeline service name>
Example: *TELESTREAM_METADATA: PIPELINE Pipeline_3005

Pre-roll Value to VTR
*TELESTREAM_METADATA: PREROLL <Numeric value in seconds>
Example: *TELESTREAM_METADATA: PREROLL 2

Offset for Frame Accuracy
*TELESTREAM_METADATA: OFFSET <Numeric value in frames>
Example: *TELESTREAM_METADATA: OFFSET 0

Anamorphic Flag
Produced when video is specified as 16 x 9 format because the 16 x 9 check box has been selected on the live page for proper video display. Any EDL produced with this option checked will also set the ANAMORPHIC flag to TRUE:
*TELESTREAM_METADATA: ANAMORPHIC TRUE
This flag insures that anamorphic flags are set in appropriate output files in FlipFactory.

Abort Switch for Dropped Frames
A true value will abort the process if a frame is dropped, false will continue even if a frame is dropped
*TELESTREAM_METADATA: ABORT <true/false>
Example: *TELESTREAM_METADATA: ABORT false
Name of Tape
*TELESTREAM_METADATA: TAPENAME <Alphanumeric>
Example: *TELESTREAM_METADATA: TAPENAME TAPE1234

Description of Clip
*TELESTREAM_METADATA: DESCRIPTION <Alphanumeric>
Example: *TELESTREAM_METADATA: DESCRIPTION This is a test

Scene Number or Name
*TELESTREAM_METADATA: SCENE <Alphanumeric>
Example: *TELESTREAM_METADATA: SCENE Good cop bad cop

Take Number
*TELESTREAM_METADATA: TAKE <Numeric>
Example: *TELESTREAM_METADATA: TAKE 2

Additional Notes
*TELESTREAM_METADATA: NOTES <Alphanumeric>
Example: *TELESTREAM_METADATA: NOTES Additional information goes here.

End of Additional Fields Parameter
*TELESTREAM_METADATA: END
If optional TELESTREAM fields are included this parameter is require to be last.
This appendix describes each Pipeline codec’s preset profiles. SD profiles are available in Pipeline SC and Pipeline Quad. Both SD and HD codec profiles are available in Pipeline HD Dual.

SD Video Profiles
- DNxHD Profiles (page 152)
- DV Profiles (page 153)
- DVCPro Profiles (page 153)
- DVCPro HD Profiles (page 154)
- IMX Profiles (page 154)
- ProRes 422 Profiles (page 155)
- Motion JPEG Profiles (page 156)
- Uncompressed Profiles (page 156)

Audio Profiles
- Uncompressed Profiles (page 156)
### DNxHD Profiles

**Table C–1. DNxHD Codec**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>720p (1280 x 720)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>720p: 23.98</td>
</tr>
<tr>
<td></td>
<td>1080i: 25</td>
</tr>
<tr>
<td></td>
<td>1080p: 23.98</td>
</tr>
<tr>
<td>Quality (mbit/sec)</td>
<td>720p: 60 8-bit</td>
</tr>
<tr>
<td></td>
<td>1080p: 120 8-bit</td>
</tr>
<tr>
<td></td>
<td>1080i: 36 8-bit</td>
</tr>
<tr>
<td>Scanning</td>
<td>Interlaced</td>
</tr>
<tr>
<td>Field Order (Int.)</td>
<td>1080i: Upper Field First</td>
</tr>
<tr>
<td>Frame Aspect Ratio</td>
<td>16:9</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>NTSC/PAL CCIR 601</td>
</tr>
<tr>
<td>Audio</td>
<td>Uncompressed PCM, 16 Bit Integer, Big Endian</td>
</tr>
</tbody>
</table>
# DV Profiles

## Table C–2. DV Codec

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>480i (720 x 480 NTSC)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>29.97 fps (NTSC)</td>
</tr>
<tr>
<td>Quality (mb/sec)</td>
<td>25</td>
</tr>
<tr>
<td>Scanning</td>
<td>Interlaced</td>
</tr>
<tr>
<td>Field Order (Int.)</td>
<td>Lower Field First (NTSC), Upper Field First (PAL)</td>
</tr>
<tr>
<td>Frame Aspect Ratio</td>
<td>4:3</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>NTSC/PAL CCIR 601</td>
</tr>
</tbody>
</table>

## DVCPRO Profiles

## Table C–3. DVCPro Codec

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>480i (720 x 480 NTSC)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>29.97 fps (NTSC)</td>
</tr>
<tr>
<td>Quality (mb/sec)</td>
<td>25</td>
</tr>
<tr>
<td>Scanning</td>
<td>Interlaced</td>
</tr>
<tr>
<td>Field Order (Int.)</td>
<td>Lower Field First (NTSC), Upper Field First (PAL)</td>
</tr>
<tr>
<td>Frame Aspect Ratio</td>
<td>4:3</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>NTSC/PAL CCIR 601</td>
</tr>
</tbody>
</table>
DVCPRO HD PROFILES

Table C–4. DVCPRO HD Codec

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>720p (1280 x 720)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>23.98</td>
</tr>
<tr>
<td>Quality (mbit/sec)</td>
<td>100 mb/sec</td>
</tr>
<tr>
<td>Scanning</td>
<td>Interlaced</td>
</tr>
<tr>
<td>Field Order (Int.)</td>
<td>1080i: Upper Field First</td>
</tr>
<tr>
<td>Frame Aspect Ratio</td>
<td>16:9</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>NTSC/PAL CCIR 601</td>
</tr>
<tr>
<td>Audio</td>
<td>Uncompressed PCM, 16 Bit Integer, Big Endian</td>
</tr>
</tbody>
</table>

IMX PROFILES

Table C–5. IMX Codec

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>486i (720 x 486 NTSC)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>29.97 fps (NTSC), 25 fps (PAL)</td>
</tr>
<tr>
<td>Quality (mbit/sec)</td>
<td>30</td>
</tr>
<tr>
<td>Scanning</td>
<td>Interlaced</td>
</tr>
<tr>
<td>Field Order (Int.)</td>
<td>Lower Field First (NTSC), Upper Field First (PAL)</td>
</tr>
<tr>
<td>Frame Aspect Ratio</td>
<td>4:3</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>NTSC/PAL CCIR 601</td>
</tr>
<tr>
<td>Audio</td>
<td>Uncompressed PCM, 16 Bit Integer, Big Endian</td>
</tr>
</tbody>
</table>
# ProRes 422 Profiles

ProRes Standard is supported in SD profiles; Standard and HQ are supported in HD profiles.

## Table C–6. ProRes 422 Codec

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>486i (720 x 486 NTSC)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>486i: 29.97 fps</td>
</tr>
<tr>
<td></td>
<td>576i: 25 fps</td>
</tr>
<tr>
<td></td>
<td>720p: 23.98</td>
</tr>
<tr>
<td></td>
<td>1080i: 25</td>
</tr>
<tr>
<td></td>
<td>1080p: 23.98</td>
</tr>
<tr>
<td>Quality (mbit/sec)</td>
<td>486i: SQ</td>
</tr>
<tr>
<td></td>
<td>576i: SQ</td>
</tr>
<tr>
<td></td>
<td>720p: SQ 960</td>
</tr>
<tr>
<td></td>
<td>1080p: SQ 1440</td>
</tr>
<tr>
<td></td>
<td>1080i: SQ 1440</td>
</tr>
<tr>
<td>Scanning</td>
<td>Interlaced</td>
</tr>
<tr>
<td>Field Order (Int.)</td>
<td>Lower Field First (NTSC), Upper Field First (PAL)</td>
</tr>
<tr>
<td></td>
<td>1080i: Upper Field First</td>
</tr>
<tr>
<td>Frame Aspect Ratio</td>
<td>486i &amp; 576i: 4:3</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>NTSC/PAL CCIR 601</td>
</tr>
<tr>
<td>Audio</td>
<td>Uncompressed PCM, 16 Bit Integer, Big Endian</td>
</tr>
</tbody>
</table>
**MOTION JPEG PROFILES**

Motion JPEG A is supported in SD profiles; Standard and HQ are supported in HD profiles.

**Table C–7. Motion JPEG Codec**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>240p (720 x 480 NTSC)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>25</td>
</tr>
<tr>
<td>Quality (mbit/sec)</td>
<td>Q80</td>
</tr>
</tbody>
</table>

**UNCOMPRESSED PROFILES**

**Table C–8. Uncompressed Codec**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>480i (720 x 480 NTSC)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>29.97 fps</td>
</tr>
<tr>
<td>Quality (bits)</td>
<td>8</td>
</tr>
<tr>
<td>Scanning</td>
<td>Interlaced</td>
</tr>
<tr>
<td>Field Order (Int.)</td>
<td>Lower Field First (NTSC), Upper Field First (PAL)</td>
</tr>
<tr>
<td>Frame Aspect Ratio</td>
<td>4:3</td>
</tr>
<tr>
<td>Pixel Aspect Ratio</td>
<td>NTSC/PAL CCIR 601</td>
</tr>
</tbody>
</table>

**LINEAR PCM AUDIO PROFILE**

**Table C–9. Linear PCM Codec**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels</td>
<td>2</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>48 kHz</td>
</tr>
<tr>
<td>Quality</td>
<td>16</td>
</tr>
</tbody>
</table>
Symbols
.Net Framework 3.5, required 3-32

Numerics
16 x 9 check box, preview 4-50
525/625, automatic detection of 2-8, 2-9

A
About panel, generally 4-39
Active-X 4-36, 4-50
Adobe 5-72
auto clock source 7-105
Avid 5-72
Avid DnxHD Codec, required 3-32

B
batch ingest, generally 1-4
black frame 4-42
BNC, SMPTE-259M 270MBPS 2-9, 2-12
Bonjour 2-8
Bonjour for Windows
required for Pipeline 2-18
Bonjour for Windows, installing 2-18
Bonjour for Windows, required 3-32
Bonjour panel 3-23–3-25, 4-37
Bonjour service 2-18
Bonjour, using to connect 2-19

C
Canadian EMC Notice of Compliance i-iii
Capture Editor 5-65
capturing media to file, in Pipeline Direct 4-53
cat 5 cable, must be used with Pipeline i-ii
Channel One (Quad), clock source 7-106
clock list files, loading and saving 9-142
clock list panel, using generally 9-141
clock list, creating for log and capture 9-138
clock, creating 9-141
clock, deleting 9-141
clock, metadata 9-142
clock source, Auto 7-105
clock source, Channel One (Quad) 7-106
clock source, computer clock 7-106
clock source, Pipeline clock 7-106
clock source, priority in Pipeline Quad 7-105
clock source, priority in Pipeline SC 7-105
clock source, RS422 7-105
clock source, video in 7-106
clock sources, options 7-104
closed caption 1-2, 2-8, 5-58
closed caption data extraction 2-8
closed caption, processing 2-13
codecs, generally 1-2
collection of features 3-22
computer clock, clock source 7-106
certainty monitoring 1-3, 2-11, 4-44, 4-46, 4-49, 5-57, 6-80, 6-86, 9-138
certainty monitoring, disabling 4-45
certainty monitoring, enabling 4-45
Configure panel, generally 4-40
Connect dialog, authenticating with 4-37
Copy File, configuring publisher for 7-114
copyright notice i-i
Counters panel 4-47
CPLD chip version 4-41

D
DAM 1-2, 1-4, 5-72–5-74
Deck Status 4-50
default IP address 2-19
DHCP address 2-5, 2-17–2-18, 4-41, 4-43, A-146
dimensions, of Pipeline Quad 2-9, 2-12
dimensions, of Pipeline SC 2-8
disconnecting, automatically 4-42
disk, performance requirements 3-29
DNxHD 1-2
DNxHD 145, throughput and write speed reqs. for 3-29
DNxHD 220, throughput and write speed reqs. for 3-29
DNxHD Profiles C-152
DNxHD, Avid DNxHD 1-3
drive requirements 3-30
drop-frame timecode, indicating with semi-colon 4-50–4-51
DV 1-2, 2-8, 2-10, 4-46, 5-71–5-73, 9-144, A-146
DV Profiles C-153
DV/DVCPro, throughput and write speed reqs. for 3-29
DVCPro 2-8, 2-10, 4-46, 5-72–5-73, A-146
DVCPro HD Profiles C-154
DVCPro Profiles C-153
DVCProHD 1-2–1-3
DVCProHD, throughput and write speed reqs. for 3-29

E
edit decision list 4-52
EDL 1-4, 4-35–4-36, 4-38, 4-49–4-53, 5-60–5-61, 5-71
EDL files B-147
EDL for Pipeline syntax B-147
EDL monitor 4-36, 4-42, 4-52, 5-60–5-61, 5-71
EDL Monitor, submitting jobs via 5-61
EDL Monitor, using with FlipFactory 5-71
EDL, loading and saving 9-142
EDLs 1-4
electrical safety, standards complied with i-iii
emission information i-ii
emission standards complied with i-iii
EN55022 Class A Warning i-iii
environmental operating requirements 2-6
Episode 1-1, 2-8, 4-35, 4-45, 4-53, 5-58
Episode | Episode Pro, Pipeline Plugin for 3-22
Episode configuring publisher for 7-110
Episode Engine, restarting after installing Pipeline software 3-31
Episode, installing Pipeline plugin for 3-31
Episode, not required for Pipeline Porter 3-22
Episode, version requirements for use with Pipeline 3-22
Ethernet 2-6, 2-8–2-9, 2-11
Ethernet port, LED indicators for 2-9, 2-12, 2-15
Ethernet, gigabit 1-3, 2-9, 2-12, 2-15
Ethernet, gigabit in Quad 1-2

F
FCC Emission Information i-ii
features, comparison of Pipeline applications 3-22
Final Cut Pro 1-1–1-2, 2-16–2-17, 3-31, 4-45, 4-49, 5-72, 6-75, 6-90, A-145–A-146
Final Cut Pro bin 6-85
Final Cut Pro configuring publisher for 7-113
Final Cut Pro scratch folder 6-77
Final Cut Pro version 5.0.1 3-29
Final Cut Pro version 5.0.1, requirement for using with Pipeline 3-22
Final Cut Pro, importing media with 6-80
Final Cut Pro, installing Pipeline plugin for 3-31
Final Cut Pro, Pipeline Plugin for 3-22
Firefox 2-19, 4-36, 4-50
Firefox Version 2 4-36
firmware update 2-8, 2-11, 4-56
Flash 5-72
FlipFactory 1-1–1-4, 2-8, 2-16–2-18, 4-35–4-36, 4-38, 4-42, 4-45, 4-49, 4-52–4-53, 5-57, 5-60–5-62, 5-64, 5-70–5-71, 5-74, A-145
FlipFactory / Pipeline workflow, system requirements for 3-29
FlipFactory console 4-46, 5-69
FlipFactory version 6.0, using with Pipeline, generally 5-57
FlipFactory, configuring publisher for 7-107
FlipFactory, license required for Pipeline 5-58
FlipFactory, MPEG2 I-Frame 50Mb video 2-8
FlipFactory, requirements for 5-58
FlipFactory, requirements for using with Pipeline 3-22
FlipFactory, sample workflows 5-60
FlipFactory, version requirements 3-22
FPGA chip version 4-41
front panel indicators 2-10, 2-13
front panel indicators for SC 2-8
G

gigabit Ethernet 1-3, 2-9, 2-12, 2-15, 2-16
GigE, ethernet, required 3-29
Grass Valley 5-72
GXF 5-72

H

hard disc requirements 3-30
hard drive requirements 3-30
hardware for Quad 2-9, 2-12
hardware for SC 2-8
hardware requirements 3-30
hardware requirements, for HD processing 3-30
HD processing system requirements 3-30
HH:MM:SS:FF format, for mark-in, mark-out 5-68
high-res archive workflow 5-72
History window, in FlipFactory 5-69
HTTP password rules 4-41
HTTP, Pipeline uses to communicate 4-36

I

IM, configuring publisher for 7-112
IMX 2-8, 2-10, 4-46, 5-58, 5-74, 6-80, 9-144
IMX 30|40|50 1-2
IMX Profiles C-154
IMX30, throughput and write speed reqs. for 3-29
IMX40, throughput and write speed reqs. for 3-29
IMX50/MPEG2, throughput and write speed reqs. for 3-29
installing Pipeline software on Windows/Vista 3-32
installing Pipeline software, generally 3-21
Internet Explorer 2-19, 4-36, 4-41, 4-50
Internet Explorer 6 4-36
iTunes 5-72–5-73

J

Java 4-36
job
viewing history/status 5-70
viewing status 5-69
job status, checking 5-69

K

keyboard shortcuts, log and capture 9-143

L

LED SDI, front, on Quad, lights orange 2-11
LED, Ethernet on Quad 2-12, 2-15
LED, Ethernet on SC, lights orange 2-9
LED, Ethernet, on SC, unlit 2-9
LED, front, on Quad, lights yellow 2-11
LED, on Quad front panel 2-10, 2-13
LED, on SC, lights orange 2-8
LED, on SC, lights yellow 2-8
LED, SDI on front, Quad, blinks orange 2-11
LEDS 2-10, 2-13
LEDS, for SC 2-8
Leitch 5-72
license requirements, for MPEG-2 i-i
Linear PCM Audio Profile C-156
link-local 2-5, 2-17–2-19, 4-41
link-local IP address, default 2-17
Live pane, VTR control 4-38
Live panel 4-38, 4-49–4-50, 4-53
Live panel, defaulting to on startup 4-42
Live panel, disconnecting automatically 4-42
log and capture window, using generally 9-139
log and capture, generally 9-138
loopback, disabling 4-42

M

MAC address 2-18
Mac OS X 2-16, 2-19, 4-36–4-37
Mac OS X Version 10.5, required 3-29
Mac OS X, installing Pipeline software on 3-31
Mac OS X, Pipeline Control, supported 3-22
Mac OS X, uninstalling Pipeline software from 3-31
Mac OS X, upgrading Pipeline software on 3-31
Macintosh hardware requirements 3-30
manually submitting jobs 5-62
media, exporting to Pipeline from Final Cut
Pro 6-90
media, submitting to FlipFactory, generally 5-60
metadata, for clip 9-142
MJPEG A 1-2
Motion JPEG Profiles C-156
MPEG-2 5-74, A-146
MPEG2 I-Frame 50Mb video (FlipFactory workflows) 2-8
MPEG-2, license requirements i-i
MPEG4 5-72–5-74
MXF 5-72, 5-74
Pipeline Direct 4-47
  About panel 4-39
  Configure panel 4-40
  Live panel 4-49
  Live panel, VTR control 4-38
  Quad panel 4-44
  status bar for 4-50
  Upgrade panel 4-55
  using to capture media to file 4-53
Pipeline Direct, generally 4-35
Pipeline Direct, launching 4-36
Pipeline HD Dual
  contents of shipping container 2-7
  features 1-3
  locating for operation 2-7
Pipeline Plugin, feature comparison 3-22
Pipeline Quad
  contents of shipping container 2-7
  features 1-2
  front panel indicators 2-10, 2-13
  hardware, specifications 2-9, 2-12
  locating for operation 2-7
  rear panel 2-11, 2-14
Pipeline SC
  contents of shipping container 2-7
  features 1-2
  front panel indicators 2-8
  hardware, specifications 2-8
  locating for operation 2-7
  rear panel 2-9
Pipeline software, general hardware and OS requirements for 3-29
Pipeline software, installing 3-21
Pipeline software, installing on Windows/Vista 3-32
Pipeline software, installing, on Mac OS X 3-31
Pipeline software, uninstalling from Mac OS X 3-31
Pipeline software, uninstalling from Windows/Vista 3-33
Pipeline software, upgrading on Mac OS X 3-31
Pipeline software, upgrading on Windows/Vista 3-32
ports, that must be open 2-17
power requirements for Pipeline 2-6
Preview Panel, using generally 7-116
preview panel, using in log and capture 9-140
Preview, implications during capture 3-23
ProRes 422 1-2
ProRes 422 HD, Apple ProRes 422 HD 1-3
ProRes 422 Profiles C-155
ProRes 422 SQ (SD), throughput and write speed reqs. for 3-29
ProRes422 HQ (HD), throughput and write speed reqs. for 3-29
ProRes422 SQ (HD), throughput and write speed reqs. for 3-29
publisher, configuring Copy File as 7-114
publisher, configuring Final Cut Pro as 7-113
publisher, configuring for Episode 7-110
publisher, configuring for FlipFactory 7-107
publisher, configuring IM as 7-112
publisher, configuring, generally 7-107
publisher, selecting 7-106
PWR LEDs, on Quad 2-11, 2-13

Q
Quad panel, generally 4-44
Quantel 5-72
QuickTime 3-29, 4-35–4-36, 5-71, 5-73, 6-77, 6-80–6-81, 6-85, 9-138, 9-144
QuickTime, required for Windows/Vista 3-32

R
Radiation Emission Susceptibility Regulatory Approved Standards complied with i-iii
rear panel, Quad, ports and connectors 2-11, 2-14
rear panel, SC, ports and connectors 2-9
rebooting, Pipeline 4-43
Reference Input, clock source for Quad only 7-106
Register, using button on About panel 4-39
registering your Pipeline 2-20
registering, URL for 4-39
RS-422 2-9, 2-11–2-12, 2-14, 2-17
RS-422 deck control 1-4, 2-8
RS422, clock source 7-105

S
Safari 2-19, 4-36–4-37, 4-41, 4-50
Safari version 2 or 3, supported 4-36
Safari, using to download installer 3-31
safety instructions when using Pipeline i-iii
SD processing system requirements 3-30
SDI 1-2
SDI In (SC), indicators for 2-8–2-9, 2-11, 2-13–2-14
SDI In, indicators for 2-9, 2-12, 2-15
SDI Out (SC), indicators for 2-9, 2-11, 2-13
SDI Out, indicators for 2-12, 2-15
SDI Status 4-50
SDI time code 7-105
SDK, Pipeline 1-1
Seachange 5-72
Serial Digital Interface 2-8–2-9, 2-12
settings, returning to default 4-43
SMPTE-259M 270MBps 2-8
SNTP server IP address, providing 4-43
soft rebooting, Pipeline 4-43
Sony Protocol 2-8
Sony protocol 2-9
stack limit two, overheating 2-6
Static IP address 4-41
static IP address 2-5, 2-17–2-18, 4-43, A-146
status bar 4-50
Status/History window, 5-70
Subsystems, required for Pipeline software on Windows/Vista 3-32
surge protector, recommended 2-6
sync reference 1-3, 2-11, 2-13
sync reference, using 2-10, 2-12

T
Telestream
contacting i-iv
International i-ii
sales and marketing i-i–i-ii
technical support i-i–i-ii
Web site i-i–i-ii
Telestream Intermediary Format 5-58
Telestream, contacting i-ii
temperature, operating requirements for 2-6
test pattern, setting on startup 4-42
TIFO 1-4, 4-35–4-36, 4-47, 4-52–4-54, 5-58–5-60, 5-69, 5-71, 5-73–5-74
TIFO file jobs, submitting 5-69
TIFO, generally 5-58
time code 1-2, 2-13, 5-73–5-74, 6-83, B-147
time code, processing 2-8, 2-13
timecode 4-50
timecode, zero-based 7-105
trademark notice i-i

U
Uncompressed (HD only) 1-2
Uncompressed Profiles C-156
Uncompressed SD 8- and 10-bit 1-3
uninstalling Pipeline software from Mac OS X 3-31
uninstalling Pipeline software from Windows/Vista 3-33
Upgrade panel 4-55
upgrading software on Mac OS X 3-31
upgrading software on Windows/Vista 3-32

V
VANC Closed Caption and Time Code, processing with Pipeline 2-13
VBI Closed Caption and Time Code, processing with Pipeline 2-8
version 4-41
Vertical Blanking Interval, processing 2-8
Video Input, clock source 7-106
Vista Ultimate, Pipeline Control, supported 3-22
Vista Ultimate, required 3-29
Vista, installing Pipeline software on 3-32
Vista, subsystems required for Pipeline software 3-32
VITC time code 1-2
VTR control, in Pipeline Direct Live Panel 4-38
VTR Controls
  in Pipeline Plugin for Final Cut Pro 6-84
VTR deck control 1-4
VTR Mode 4-50
VTR RS-422 2-16
VTR, required for EDLs 4-35
VTR/Pipeline status bar 4-50

W
warranty i-iv
Warranty and Disclaimers i-iv
Web browsers
  settings requirements 4-36
  supported 4-36
Windows 2-16, 2-18–2-19, 4-36, 5-59, 5-72–5-73
Windows Media 9 5-73
Windows XP Pro, required 3-29
Windows XP, Pipeline Control, supported 3-22
Windows, installing Pipeline software on 3-32
Windows, required subsystems for Windows/Vista 3-32

Z
zero-based timecode 7-105